jorecisely

Spectrum Technology Platform

Installation Guide

Version 2019.1.0



Table of Contents

1 - Upgrading your installation

Path structure and log name changes................... 5
Moving transactional data - upgrades only............ 6
Migrating your search indexes..........ccccceeeeeeeeeennnn. 7

2 - Planning Your Installation

Using Enterprise Designer with a Cluster............ 67
Disabling Host Checks in Token Authentication...68

5 - Cluster with Separated
Configuration Database

Installation Scenarios..........cccccoecveveieiiiiee e, 11
Before You Begin........ccccoeiiiiiiiiiiiiiiiiiieeee s 14
System Requirements.............cccceeeeieeeiiiiiiiinnnnn, 16

3 - Standard Installation

Installing a Cluster with a Separated Configuration

Database.........cooociiiiii e 71
Upgrading a Cluster with a Separated Database.76
Upgrading a Cluster with a Separated Database and

Data Hub Module.........ccccoooiiiiiiiiiieieeee 80
Converting to a Separated Configuration

Database.......ccccooiieiiiiie 84
Converting from a Separated Configuration

Database to a Standard Installation............... 86
Adding Nodes to a Cluster..........cccccoevvcviereennnee 88

6 - Spectrum Databases

Installing a New Server.........ccccooeceveeiiciieeeeene 32
Upgrading @ Server........ccccooeeeeeiiiiieeeniiiieee e 33
Installing a License Key.......ccccccovviiiiiiiiiieeenennn. 38
Installing the Server with a Silent Installer........... 39
Adding Modules............cccciiiiiiiiiei 39
Removing the Server.........ocoociiiiiiiiieed 40
4 - Cluster

Clustered Architecture............cccccevviiiiiiiiiiennn 43
Requirements............c.cooiiiiie 47
Installing @ Cluster...........occoeiiiiiiiii e, 48
Installing a Cluster for the Spatial Module........... 53
Upgrading a Cluster.........cocoeeiiiiiieeeniiieeeee 58

Upgrading a Cluster with the Data Hub Module...59
Upgrading a Cluster with the Spatial Module......63

Removing a Node from a Cluster........................ 65
Adding Nodes to a Cluster.............cccccvvvveeereennnn. 65
Starting @ Cluster.........oocovviiiiiiee e 66

Stopping @ CIUSter.....ccoceeiieieee e 67

Installing a Spectrum Database............cccccc....... 91
Installing Advanced Matching Module Database.98
Installing Data Normalization Module
Databases.........cccooeieeiiiiii 99
Installing Geocoding Databases (SPD format)...100
Installing Enterprise Tax Module Databases.....103
Installing GeoEnrichment Module Databases....107
Installing Global Addressing Module Databases.108
Installing Global Sentry Module Database........ 117

Installing Routing Databases.............cccccceeeeennn. 119
Installing Universal Addressing Module
Databases.........cccccoeveiiiiiiiiii, 123
Installing Universal Name Module Databases...135
Using the Database Silent Installer................... 136



7 - Client Tools

Installing the Client Tools..............ccccovvvveeeeeeennn. 139
Installing Enterprise Designer with a Silent
Installer........ccoueii e 140
Upgrading Enterprise Designer............cccccee... 141
Removing Enterprise Designer.............ccccuuue... 142

8 - Client API

Installing the Client APL............cccocveiiiiiineeeee 144
Removing the Client APL.........c.cocoiiiiiiinns 144

9 - SAP, SugarCRM, and
Microsoft Dynamics

Configuring SAP.......coooii 146
Configuring SugarCRM............cccceveveieeeieiiin, 164
Configuring Microsoft Dynamics CRM.............. 168

10 - Support

Spectrum Technology Platform 2019.1.0 Installation Guide



1 - Upgrading your
installation

In this section

Path structure and log name changes..........cccccoviiiiiiiiiie i 5
Moving transactional data - upgrades only............ccccuveieiiiiiiiniiiiiiieeeee e 6
Migrating your Search iINAEXES.........ccuuuiiiiiiiiiiie e 7




Upgrading your installation

Path structure and log name changes

As of release 2019.1, we have flattened the folder structure at the platform level. We have also
changed the path to and names of some log files.

Path structure

We have removed the server/app and server/app/repository folders. Ensure that you make

the necessary changes to configure the Spectrum Technology Platform server. The new folder

hierarchy is shown here:

.. |index
|-— logs
.. |repository
|-- logs
..|server
| -— archive

audit
bundles
dataflows
reports

bin
conft
deploy
doc
drivers
exports
import

| --— error
| -—— dataflows
| -—— license-keys
1lib
logs
modules
ref-data
tmp
types

Log file location

* %
* *
* %
* %
* %
* %

* %
* *
* %
* %

* %
* *
* %
* %
* *
* %
* *

* *
* %
* %
* %
* %
* *
* %
* %
* %

index location

log files for technical support
repository location

log files for technical support
primary server folder

archive files: resource bundles, reports
archive
storage:
archive:
default

files: audit log data

resource bundles

imported dataflows

location for reports on disk/by

startup scripts, wrapper
configuration files
car and war files;
read me file(s)
jdbc drivers
exported: Enterprise Designer,
imported: license keys, flows,

consoles

others
reports,

import item error storage
dataflow import errors

backup of imported license keys
platform jar files

log files

product modules

reference data file archive
temporary folder

types jar files

Spectrum Technology Platform now directs all log files to SpectrumbDirectory/server/logs.
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wrapper.log file name change

The wrapper.log file is now the spectrum-server.log file.

Moving transactional data - upgrades only

As of release 2019.1, we are moving transactional audit log and flow history data from Neo4j to
Elasticsearch to improve the maintenance of and access to this data.

Note: New installations are not affected by this change.

If you are performing an upgrade from a previous version of Spectrum, the upgrade process will
export all of this data into two *.zip files:

» Archive_Upgrade_18.2_history.zip
» Archive_Upgrade 18.2_audit.zip

The more data you have, the larger the *.zip files.

Important: To avoid building large export files, we suggest that you purge or archive the data before
you begin the upgrade process.

If you have a standard installation (server and database installed together on a machine), the
upgrade process exports files into a directory (SpectrumDirectory/server/import). From this
directory, Spectrum imports the files automatically on the first startup of Spectrum. Standard
installations require no manual steps to accomplish this task.

If you have a separate installation, where the database was installed separately from the server,
following the upgrade process, you must manually move the files from the database machine
((SpectrumbDirectory/server/import) to the server machine
(SpectrumbDirectory/server/import). Once you move the files to the server machine, Spectrum
imports those files automatically on the first startup of the server.

Depending on how much data you are moving, you can expect the first startup to be considerably
slower than usual while this data is imported back into the system and into the Elasticsearch repository.
Once Spectrum imports all the data successfully, it deletes the *.zip files from the server machine
automatically.
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Migrating your search indexes

If you are upgrading to release 2019.1 from release 2018.2, your Elasticsearch search indexes will
migrate to release 2019.1 during the upgrade process.

Important: Your server must be up and running to migrate your search indexes.

If you are upgrading to release 2019.1 from version 12.2.1 or earlier, you have to perform a separate,
manual process as part of the upgrade to migrate your Elasticsearch indexes to release 2019.1. This
process will maintain your compatibility with the latest version of Elasticsearch. We provide scripts
to do this:

* export
* delete-all-indexes
* import

Note: You do not need to perform these steps if you are from upgrading from release 2018.2
to 2019.1. Indexes from 2018.2 will convey to 2019.1 as part of the upgrade.

Using the command parameters outlined below, perform these steps.

Table 1: Index command parameters

Command parameter  Description Default value

-b value Optional - Number of records in one batch import=1_000

export =25 000

-e path Full path to where the Spectrum indexes will be exported to or
imported from

-f value Optional - Number of records in each file 100_000
-h value Optional - Number of concurrent threads 4

-0 operation Operation: exp, imp, or del

-p filename Optional — Override properties file containing default override index

connection properties

-r value Optional — Batch size for profiling index report 500
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Command parameter  Description Default value

-s path Full path to the Spectrum installation location: Directory that includes
the /server, /index, and /repository directories

-t value Optional — Timeout for export connection, in minutes 5

You can perform the import/export from a script (*.bat or *.sh) or by using the upgrade-index. jar
file.

* If you use the script method to import/export, the —o parameter is implied and does not have to be
specified.
* If you are not importing/exporting from the script, specify: javaLocation -jar
upgrade-index.jar
1. Export your indexes before upgrading to 2019.1.
export.bat —-e backuplocation -s spectruminstalllocation
2. Delete your indexes.
delete-all-indexes.bat -e backuplocation —-s spectruminstalllocation
3. Upgrade to release 2019.1 of Spectrum Technology Platform.
4. Import your indexes to 2019.1 after the upgrade.

import.bat -e backuplocation -s spectruminstalllocation

If you have changed default Elasticsearch certificate connection
properties

Most Spectrum users will run with the default set of connection properties. However, if you did change
any connection properties, you will have to pass into Spectrum the properties file with your unique
settings using the —-p command, described in the previous section.

Note: This section applies only to sites that have changed the default
configuration for Elasticsearch.

Review the valid properties, below. You can ignore/omit properties that do not apply.

Index properties for 2019.1

spectrum.index.connect.timeout=
spectrum.index.encryption.keystore=
spectrum.index.encryption.keystoreAlias=
spectrum.index.encryption.keystorePassword=
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spectrum.
Spectrum.
spectrum.
Spectrum.
Spectrum.
Spectrum.

Spectrum.
Spectrum.
Spectrum.
Spectrum.
spectrum.

index.
index.
index.
index.
index.
index.

encryption.keystoreType=
encryption.selfSignedCerts=
encryption.trustAllHosts=
encryption.truststore=
encryption.truststorePassword=
encryption.truststoreType=

Index properties for versions before 2019.1

index.
index.
index.
index.
index.

upgrade.
upgrade.
upgrade.
upgrade.
upgrade.

certType=
keystore.password=
keystore.path=
truststore.password=
truststore.path=

Upgrading your installation
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Planning Your Installation

Installation Scenarios

Spectrum Technology Platform supports a variety of installation scenarios that scale to fit the needs
of your organization.

Standard

The standard scenario is the simplest installation scenario. You install Spectrum Technology Platform
on a single server. All activity is handled by this one server, including designing dataflows, storage
of configuration information, running jobs, and handling service requests.

Requests
(Such as API calls, web service requests, clients)

Spectrum Server | ey, 8 @

External Resources
{Database resource,
file servers, etc.)

Cluster

In a clustered environment, processing is shared among two or more instances of the server. All
communication with Spectrum Technology Platform goes through a load balancer. Instead of using
the URL and port of the Spectrum Technology Platform server, you use the URL and port of the load
balancer. Consider using this approach if you require failover redundancy and high-volume,
high-performance processing.

Important: As part of your cluster setup and machine preparation, ensure that all system times are
synchronized across all nodes in the cluster.

This diagram illustrates the cluster architecture:
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Requests
(Such as API calls, web service requests, clients)

Cluster
Load Balancer

v \ 4 v *a
Spectrum Node 1 Spectrum Node 2 Spectrum Node 3 @ @
=

External Resources
(Database resource,
file servers, etc.)

0=
|

0=
|

O

Configuration Database Configuration Database Configuration Database

This approach has the following advantages:

* Processing is automatically distributed among the nodes in the cluster for optimal performance.

+ Configuration settings are automatically synchronized across nodes.

» Uptime can be improved since if a node goes down the other nodes remain available to handle
processing requests.

* Adding a new node is easy.

Cluster with Separated Configuration Database

When you install the Spectrum Technology Platform server you are installing two things: server
software and a configuration database. The server handles the execution of jobs and service requests,
reporting, and logging. The configuration database stores data such as users and roles, data
connections, dataflows, and the audit log.

For clusters consisting of only a few nodes, installing the server and configuration database together
on the same server provides acceptable performance. However, a cluster that consists of a large
number of nodes may have its performance negatively affected by having a copy of the configuration
database on each node. This is because an increasing number of nodes results in increased data
replication between nodes during synchronization. Performance may also suffer if users are accessing
the configuration database frequently through activities such as editing dataflows or job schedules.
These activities require processing power, resulting in less CPU capacity available for running jobs
and responding to service requests.

If you have an implementation with four or more nodes, you should consider installing the configuration
database to separate servers. This is the most scalable installation scenario because you can add
nodes without necessarily adding another instance of the configuration database. For example, say
you have five nodes and three configuration database servers. You could add another five nodes,
bringing the total number of nodes to 10, while still using just the three configuration databases to
support all 10 nodes.

Installing the configuration database to a separate server has the following advantages:
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» More CPU is available to the server for running jobs, process flows, and service requests because
reading and writing to the configuration database is handled by a separate server.

» Reduced network traffic due to reduced configuration data replicated between nodes. For example,
you could have five Spectrum Technology Platform servers for handling execution while having
only three repositories. With just three repositories instead of five, data only needs to replicate
between three servers rather than five.

* Most scalable installation scenario.

Requests

{Such as API calls, web service requests, clients)

Server Cluster &

Load Balancer

v A 4 J’

v

b e =

'Spectrum Node 1 Spectrum Node 2 'Spectrum Node 3 'Spectrum Node 4

“

Node 5

Configuration Database Cluster

v ‘L

A

y

Configuration Server 1 Configuration Server 2

O — ©

Configuration Database Configuration Database

F 3
Y

Configuration Server 3

S

Configuration Database

External Resources
{Database resource,
file servers, etc.)
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Before You Begin

Before Installing on Windows

Java JDK Version

Planning Your Installation

You must have the Java 8 JDK (64-bit) installed to run Spectrum Technology Platform. If you do not
have the Java 8 JDK version installed, you can download it from the vendor sites based on the

platform. Follow the links to download and install the Java 8 JDK (64-bit).

Install the ]DK and Set the JAVA_Home Environment Variable

Regardless of the operating system, you must have the Java 8 JDK (64-bit) installed to run Spectrum

Technology Platform.

The following table lists Java distributions that have been tested with the Spectrum Technology

Platform.

Operating System Vendor-supplied Azul Oracle
AIX Yes

CentOS Yes Yes
HP-UX Yes

Oracle Linux Yes Yes

Red Hat Enterprise Linux Yes Yes
Solaris Yes Yes
SUSE Enterprise Linux Server Yes Yes

Spectrum Technology Platform 2019.1.0
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Operating System Vendor-supplied Azul Oracle
Ubuntu Yes Yes
Windows Server Yes Yes

Set the JAVA_HOME environment variable.
Setting the JAVA_Home Environment Variable on Windows on page 15

Note: To change the Java installation on a system that is currently running the Spectrum
Technology Platform, you must stop Spectrum before performing changes to the Java
installation. Restart Spectrum only after you complete the changes.

Setting the JAVA_Home Environment Variable on Windows

Before you begin the installation process, you must configure environment variables that specify the
location for your installation of 64-bit Java.

Set the JAVA HOME variable to point to the Java application folder on your system, and add the path
to the Java bin folder to the system Path variable.

Note: The environment variable settings described here may already be configured if you
ran a setup application to install Java.

1. Open the Windows Environment Variables settings dialog box.

a) In Windows Control Panel, click System.

b) In Computer name, domain, and workgroup settings, click Change settings.

c) Inthe System Properties dialog box, click the Advanced tab, and then click Environment
Variables.

Note: Variable settings defined in the User variables box apply only for the current
user login or profile. Variable settings defined in the System variables box apply for
any user account that logs into Windows. The user variable setting is used when it
has the same name as a system variable. On the other hand, the effective Path is
the user Path variable appended to the system Path variable, so the order of entries
are system entries followed by user entries.

2. Add Java HOME as a new Windows environment variable to specify the Java application folder.
a) For System variables, click New if the JAVA HOME variable does not already exist.
b) For Variable name enter JAVA HOME.

c) For Variable value enter the full path to the Java application folder.
For example, C:\Program Files\Java\zulu-8.

Spectrum Technology Platform 2019.1.0 Installation Guide 15
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d) Click OK.

3. Add $JAVA HOMES$\bin to the Path variable.

a) In System variables, click the Path variable.
b) Click Edit.

c) Double-click the first blank entry in the box.
d) Enter $JAVA HOMES$\bin.

e) Click OK

System Requirements

Server

Operating Systems

Supported Operating System Notes

AIX7.1

AIX 7.2

CentOS 6.x

CentOS 7.x Requires the following:
libstdc++.s0.5
installed as follows:
yum install compat-libstdc++-33
MrSID raster images require 1ibpngl2 . so on this operating system.

HP-UX 11.31 (Itanium)

Oracle Linux 6.x

Oracle Linux 7.x

Spectrum Technology Platform 2019.1.0 Installation Guide 16
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Supported Operating System Notes

Red Hat Enterprise Linux 6.x

Red Hat Enterprise Linux 7.x

Solaris 11 (SPARC only)

SUSE Enterprise Linux Server 11.x . .
Requires the following:

glibc-2.9 or glibc-2.11
installed as follows:
zypper install libstdc++33-32bit zlib-32bit

SUSE Enterprise Linux Server 12.x . .
Requires the following:

glibc-2.9 or glibc-2.11
installed as follows:

zypper install libstdc++33-32bit zlib-32bit

Ubuntu 16.04 LTS ) ) ) o
Requires these runtime libraries installed as follows:

apt-get install libstdc++5:1386 z1liblg:i386
MrSID raster images require 1ibpngl2.deb and 1ibjpeg62 on
this operating system.

Ubuntu 18.04 LTS ) ) ) o
Requires these runtime libraries installed as follows:

apt-get install libstdc++5:1386 zliblg:1386
MrSID raster images require 1ibpngl2.deb and 1ibjpeg62 on
this operating system.

Windows Server 2012

Windows Server 2012 R2

Windows Server 2016

Windows Server 2019
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Unsupported Operating Systems by Module
All modules support the Windows operating systems listed in the previous section.

The following table shows the UNIX/Linux operating systems that are not supported for specific
modules.

Module Not Supported

Analytics Scoring Module AIX 71,72

HP-UX 11.31 (ltanium)
Solaris 11 (SPARC only)

Data Hub Module Data Hub is not supported on HP.

Enterprise Geocoding Module (U.S.) SUSE Enterprise Linux Server 12.x

Ubuntu 14.04 LTS

Enterprise Tax Module Solaris 11 (SPARC only)

SUSE Enterprise Linux Server 12.x
Ubuntu 14.04 LTS

GeoConfidence Module HP-UX 11.31 (Itanium)

GeoEnrichment Module SUSE Enterprise Linux Server 12.x

Ubuntu 14.04 LTS

Global Geocoding Module SUSE Enterprise Linux Server 12.x (not supported for U.S. geocoder)

Ubuntu 14.04 LTS

Machine Learning Module AIX71,72

HP-UX 11.31 (Itanium)
Solaris 11 (SPARC only)

Microsoft Dynamics CRM Module Ubuntu 14.04 LTS, 16.04 LTS
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Module Not Supported

SAP Module Ubuntu 14.04 LTS, 16.04 LTS

SugarCRM Module Ubuntu 14.04 LTS, 16.04 LTS

Universal Addressing Module Ubuntu 14.04 LTS

Universal Addressing Module - Validate
Address Global

Ubuntu 16.04 LTS
HP-UX 11.31 (ltanium)

Disk Space

New Installation Upgrade

» The disk where you are installing Spectrum Technology
Platform must have 4 GB of free space to install all
modules, less if installing fewer modules.

Upgrade memory requirement - You must have a
minimum of 8GB of RAM to run the upgrade to release
2019.1.

» The disk where the temp folder is located must have at

least 10 GB of free space for the installation to extract the
files it needs. You may need more depending on the
options you are installing. If necessary, modify your TEMP
environment variable (Windows) or IATEMPDIR
environment variable (Unix and Linux) to point to a location
with enough space.

The disk where you are installing Spectrum Technology
Platform must have free disk space equal to three times
the size of your current installation. To determine the size
of your current installation, look at the size of the folder
where you installed Spectrum Technology Platform.

If you are adding modules as part of your upgrade, you
will need 3 GB to install all modules, less if installing fewer
modules.

The disk where the temp folder is located must have 10
GB of free space plus four times the size of your current
installation. For example, if your current installation is 5
GB, you would need 30 GB of temp space: (4 x 5 GB) +
10 GB = 30 GB. If necessary, modify your TEMP
environment variable (Windows) or IATEMPDIR
environment variable (Unix and Linux) to point to a location
with enough space.

Note: If you are installing a module that uses a reference database, such as a postal database,
geocoding database, or data normalization tables, you will need space for this data. The total
disk space varies, depending on which modules and databases you are installing.

Spectrum Technology Platform 2019.1.0
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Memory

» Upgrade memory requirement - You must have a minimum of 8 GB of RAM to run the upgrade
to release 2019.1.

» Basic memory requirement: 16 GB

» The Data Normalization Module and Universal Name Module require additional memory if you use
these name databases:

* Arabic Plus Pack: 5.5 GB

 Asian Plus Pack - Chinese: 32 MB

* Asian Plus Pack - Japanese: 1.6 GB
* Asian Plus Pack - Korean: 8 MB

* Core Names: 1.1 GB

» The memory allocation for the Machine Learning Module should be three to four times the size of
the input file used in jobs where models are created. We recommend that the minimum memory
setting should be at least 1 GB. After installation of this release, configure minimum and maximum
memory settings for the Machine Learning Module on the Configuration Settings tab of the
Machine Learning Model Management application.

Additional Requirements

» Windows administrator rights are required to install .

* In order to use the enhanced system tray notification application the server must have .NET
Framework 3.5 SP1 (also known as 3.5.1) or higher. Current versions of Windows Server come
with the required version of .NET Framework.

System Requirements for Enterprise Geocoding and Global Geocoding modules
» The Enterprise Geocoding Module and Global Geocoding Module system requirements:

* minimum: 16 GB RAM, 4 CPU, 100 GB storage
* recommended 32 GB RAM, 8 CPU, 200 GB storage, sufficient for all datasets.

The amount of RAM will depend on how many users are on the system and how many datasets are
loaded.

Requirements for the Big Data Integration Module
For the stages using Hadoop, which are Read from Hive File, Read from Hadoop Sequence,
Write to Hadoop Sequence, and Write to Hive File, and for the activities Run Hadoop MapReduce
Job and Run Hadoop Pig:

» Hadoop version 2.6 and above

For the activities using Spark, which are Submit Spark Job and Spark Sorter:
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» Spark 2.0.1 and above.

File locations

This topic shows where files are located in the folder hierarchy of the Spectrum Technology Platform
server application folder.

The default location for the Spectrum Technology Platform
SpectrumFolder\repository\data\databasesis C:\Program Files\Pitney
Bowes\Spectrum, but you can specify a different location when you install the server.

.. | 1index ** index location
|-- logs ** log files for technical support
. .| repository ** repository location
|-- logs ** log files for technical support
..|server ** primary server folder
| -—— archive ** archive files: resource bundles, reports
| -— audit ** archive files: audit log data
| == bundles ** storage: resource bundles
| —— dataflows ** archive: imported dataflows
| —— reports ** default location for reports on disk/by
name
|-- bin ** startup scripts, wrapper
| -— conft ** configuration files
| —— deploy ** car and war files; consoles
| -— doc ** read me file(s)
| —— drivers ** jdbc drivers
| —— exports ** exported: Enterprise Designer, others
| —— import ** imported: license keys, flows, reports,
SPDs
| —— error ** import item error storage
| -— dataflows ** dataflow import errors
| -—— license-keys ** backup of imported license keys
|== 1dls ** platform jar files
|-— logs ** log files
| —— modules ** product modules
| -—— ref-data ** reference data file archive
| —— tmp ** temporary folder
| —— types ** types jar files

Network Ports

The Spectrum Technology Platform server uses several network ports for communication. Network
port conflicts can result in module components failing to start. One indication that a component has
failed to start is if it does not appear in Management Console. To troubleshoot the problem, look in
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the Spectrum Technology Platform log. This log shows which port is causing the problem. Open the
following file to view the Spectrum Technology Platform server log:

SpectrumFolder\server\logs\spectrum-server.log

Server port settings defined in the spectrum-container.properties file
You can modify network ports by modifying properties settings in the following file:
SpectrumFolder\server\conf\spectrum-container.properties
Restart the server after you make changes to the property settings.

Note: In a clustered environment you must modify the spectrum-container.properties
file on each node in the cluster.

Port Description

5001 This port is used by the Spectrum Technology Platform configuration database.

To use a different port in a non-clustered environment, configure settings in the
SpectrumFolder/repository/neo4]j.template file.

To use a different port in a clustered environment, configure the
spectrum.repository.server.seeds property to specify the seed nodes for the configuration
database.

5701 This port is used by Hazelcast for managing distributed processing between Spectrum Technology
Platform servers in a cluster.

To use a different port in a non-clustered environment, modify this property:
spectrum.cluster.port
To use a different port in a clustered environment:

+ Specify the port you want to use instead of 5701 in spectrum.cluster.port.

* Include the Hazelcast port number after each IP address specified in
spectrum.cluster.seeds.Forexample,if spectrum.cluster.portisset
to 5702 and the IP address of a seed node is 1.2.3.4.5, you would specify 1.2.3.4.5:5702
in spectrum.cluster.seeds.

6362 This port is used if you enable backups of the Spectrum Technology Platform configuration
database. To use a different port, modify this property:

spectrum.repository.backup.port

7474 This port is used by the Spectrum Technology Platform configuration database. To use a different
port, configure settings in the SpectrumFolder/repository/neodj.template file.
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Port Description

7687 This port is used by the Spectrum Technology Platform configuration database. To use a different
port, configure the spectrum.repository.port property.

8080 The port used for communication between the server and Enterprise Designer and Management
Console. This port is also used by web services. To use a different port, modify this property:
spectrum.http.port

9200 This port is used by the index server. To use a different port, modify this property:
spectrum.index.http.port

9300 This port is used by the search index engine used by the Advanced Matching Module, configured
using spectrum.index.tcp.port.

10119 This port is used for API calls made to services. To use a different port, modify this property:
spectrum.socketgateway.port

32751 This port is used for ODBC connections model stores which are created in Metadata Insights.

To use a different port, modify this property: spectrum.metadata.odbc.port

Data Hub port settings defined in the neo4j.properties file

You can modify Data Hub ports by modifying the properties in this file and restarting the server:

* SpectrumFolder\server\modules\hub\db\neodj.properties

Port Description

6044-6299 These ports are used by the Data Hub module. This is specified by the following property:
ha.host.data.port

6372-6627 These ports are used by the Data Hub module. This is specified by the following property:
dbms .backup.address

7001 This port is used by the Data Hub module. This is specified by the following property:

ha.host.coordination.base port
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Machine Learning Module

Ports documented in this section are required for the Machine Learning module.

Port Description

15431 Port 15431 is required for the Machine Learning module.

Enterprise Designer

Enterprise Designer can connect to a Spectrum Technology Platform server on any currently supported
platform.

System requirements:

» Operating system: Microsoft Windows 10

» 86 MB of disk space to install Enterprise Designer without any modules. Each module you install
requires additional disk space.

» Microsoft .NET Framework 4.6 (available from the Spectrum Technology Platform Welcome Page,
http://SpectrumServerName:8080)

» A monitor with at least 1024 x 768 resolution
» Maximum DPI setting: 150%
» Adobe Reader 7 or later (for viewing and saving reports)

Web Browsers

We recommend that you disable browser pop-up window blocking when using Spectrum Web-based
applications.

» Microsoft Internet Explorer 11

» Google Chrome 77.0 or later

* Mozilla Firefox 69.0 or later

» To use the Data Hub Relationship Analysis Client, use Microsoft Internet Explorer 11. See Get
Microsoft Silverlight (www.microsoft.com/getsilverlight).

There is no longer support for Microsoft Silverlight on Chrome, Firefox, or any browser using the
Mac operating system. For more information, see Silverlight End of Support.

Note: Metadata Insights now provides functionality previously found in Relationship Analysis
Client for creating and editing Data Hub models.
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Command Line Tools

Job Executor and Process Flow Executor

The Job Executor and Process Flow Executor command line tools require Java 8.
User Interface Languages

Spectrum Technology Platform user interfaces such as Management Console, Enterprise Designer,
and web applications are localized for these languages:

» English

* French

» German
» Japanese
» Spanish

Client SDK

The Client SDK provides API access to Spectrum Technology Platform services. To use the Client
SDK your computer must meet the following requirements:

» 1.25 GB disk space
» JDK 8 is required to install the Client SDK. Be sure that JDK 8 is in the PATH environment variable.

Supported Compilers

The Spectrum Technology Platform Client SDK is supported with the following compiler and runtime
minimum versions.

Java
Client SDK Package Directory: clientSDK/platforms/java
Client SDK requires Java version 8. This is not installed with the Client SDK.

Note: Oracle Java and Azul are supported.
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Windows 64-bit

« JDK: version 8
» C Compiler: MSVC 2005, MSVC 2008
» C++ Compiler: MSVC 2005, MSVC 2008

HP-UX RISC

» JDK: version 8
+ C Compiler: cc: HP92453-01 A.11.01.21 HP C (Bundled) Compiler
+ C++ Compiler: aCC: HP aC++ B3910B A.03.30 HP aC++ B3910B A.03.27

The clientSDK 64-bit lib is linked to these libraries:

* libpthread.1
* libnsl.1

* librt.2

* libdl.1

* libc.2

* libxti.2

* libdl.1

HP-UX Itanium

» JDK: version 8
» C Compiler: cc: HP aC++/ANSI C B3910B A.06.05
» C++ Compiler: aCC: HP aC++/ANSI C B3910B A.06.05

The clientSDK 64-bit lib is linked to the following libraries:

* libpthread.so.1
* libnsl.so.1

* librt.so.1

* libxti.so.1

* libdl.so.1

Red Hat (64-bit)

» Operating System: Red Hat Linux version 2.6.9-34.0.2.ELsmp
» C Compiler: gcc version 3.4.5
* C++ Compiler: g++ version 3.4.5

The clientSDK lib is linked to the following libraries:

* libstdc++.5s0.6
* libm.so.6
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* libgcc_s.so.1

* libpthread.so.0

* libc.s0.6

* |d-linux-x86-64.s0.2

SuSE

» Operating System: SUSE SLES 11 and 12 (powered by UnitedLinux 1.0) (i586)\nKernel
2.4.21-295-smp (0).

» C Compiler: gcc version 3.2.2

» C++ Compiler: g++ version 3.2.2

Solaris

» Operating System: Solaris 5.11
» C Compiler: cc: Forte Developer 7 C 5.4 2002/03/09
» C++ Compiler: CC: Forte Developer 7 C++ 5.4 Patch 111715-16 2005/04/28

The clientSDK 64-bit lib is linked to the following libraries:

* libpthread.so.1
* libsocket.so.1
* libnsl.so.1

* librt.so.1

* libc.so.1

* libmp.so.2

* libmd5.s0.1

* libscf.s0.1

* libaio.so.1

* libdoor.so.1

* libuutil.so.1

* libm.so.2

* libc_psr.so.1

* libmd5_psr.so.1

AIX

» Operating System: AIX version 7.x
» C Compiler: xlc 6.0 Visual Age C 6.0
» C++ Compiler: xIC 6.0 Visual Age C++ 6.0

The clientSDK 64-bit lib are linked to the following libraries:
* libC.a
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* libc_r.a
* libpthread.a
* librtl.a

Spatial Module Support

Databases

The Spatial Module, which includes routing, supports the following spatial databases for use with
the spatial services, data, and resources:

* Oracle 11GR2 and Oracle 12CR2
* SQL Server 2016 and SQL Server 2017
* PostgreSQL 11.5 (with PostGIS 2.5) and PostgreSQL 12.0 (with PostGIS 3.0)

Note: Spectrum Spatial requires the PostGIS extension for PostGreSQL data source provider
even if spatial capability will be not needed or used.

» GeoPackage (Windows and CentOS)

Data Formats
The Spatial Module supports the following data formats for use with the spatial services:

* Generic JDBC (with XY)
* TAB (native, native extended, raster, grid, seamless, DBF)
» ESRI shapefile

Raster Formats

In order to use rasters and grids as a map layer, there must be an associated .TAB file containing
georeference information about the image, including the bounds, coordinate system, and registration
points.

The Spatial Module supports the following raster and grid formats (64-bit only):

Raster Formats

Format File Extension
ADRG .gen

ASRP .gen

BMP .bmp, .wbmp
CADRG .gen
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CiB various
ECW (SDK v5) .ecw
GeofTiff .geotif
GIF .gif
JPEG .jpg/.jpeg
MrSID (SDK v9) .sid

Note: Supports MG4 (MrSID Generation 4).

NITF .ntf
PNG -png
TIFF tif

Note: TIFF files used by the Feature Service and
Mapping Service cannot exceed 2GB.

Grid Formats

Format File Extension
Defense Digital Terrain Elevation Data (DTED) .dto, .dt1, .dt2, .dt3
Maplnfo Grid .mig

MRR (Multi-Resolution Raster) .mrr

Note: This support is provided on Windows.

Vertical Mapper Classified Grid .grc
Vertical Mapper Continuous Grid .grd
Utilities

The Spatial Module utilities (Tile Generator, WMTS Tile Generator, and the Geometry Validator)
require, at a minimum, Java 8.

.NET Samples

The .NET samples require at a minimum Visual Studio 2013 and Microsoft .NET Framework 4.5.
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Maplinfo Professional Compatibility

The Map Uploader provided by the Spatial Module is compatible with Maplnfo Professional 16.x or
higher. For more information about the interoperability of the two products, see the section titled
Mapinfo Pro under Getting Started and Tools in the Spectrum Spatial Guide.

Internet Explorer

To use Internet Explorer 11, uncheck Display intranet sites in Compatibility View in the
Compatibility View settings.

WebDAV

When communicating to the server over HTTPS to map a drive to the repository, a WebDAV client
is required to use the TLS v1.2 protocol.

Deprecating
Centrus Support
To work with Centrus, you must install a 32-bit JDK.

Centrus users have an additional step after installing or upgrading the Spectrum Technology Platform
and the Spatial Module. To work with Centrus, you must update the Spectrum properties file
jdks.properties to work with your 32-bit JDK installation.

1. In a text editor, open the jdks.properties file.

* On Windows, this file is located under \ Spectrum\server\conf where the Spectrum
Technology Platform is installed (the default install path is C:\Program Files\Pitney
Bowes\).

2. Add a second property to the file, named jdk. java.exe. 32 that points to the 32-bit JDK (Java)
installation. Your file will have two entries, one set to the 64-bit JDK and a second set to the
32-bit JDK. As an example:

jdk.java.exe.64=C:/Java/Zulu/zulu-8-202/64/bin/java
jdk.java.exe.32=C:/Java/Zulu/zulu-8-202/32/bin/java
Paths must include forward slashes (/) not backslashes.

3. Restart the Spectrum Technology Platform server.

* To start the server on Windows, right-click the Spectrum Technology Platform icon in the
Windows system tray and select Start Spectrum™. Alternatively, you can use the Windows
Services control panel to start the Pitney Bowes Spectrum Technology Platform service.
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Installing a New Server

Prerequisites:

+ Before installing Spectrum Technology Platform, be sure to read the Release Notes. The Release
Notes contains important compatibility information as well as release-specific installation notes.

» Apply all the latest updates available for your operating system, especially those that resolve issues
with Java.

* You may encounter installation problems on Windows if the data execution prevention (DEP) setting
is not set correctly. The DEP setting must be set to Turn on DEP for essential Windows programs
and services only. For instructions on how to change your DEP setting, see the Windows
documentation.

To install a new server:

1. Download Spectrum Technology Platform using the download instructions contained in your
welcome letter.

2. Extract the downloaded file to a temporary location on the server where you want to install
Spectrum Technology Platform.

3. Double-click install.exe.
4. The installer guides you through the installation process. Note the following:

* If you are setting up an environment where the configuration database is installed on a separate
server choose Server only. Otherwise choose Standard installation.

* When prompted, select the modules that you want to install.

» Make sure that Spectrum Technology Platform is selected.

* If you are installing the SAP Module you must install Advanced Matching Module. The
Enterprise Tax Module is optional. The Universal Addressing Module is only required if
you will be using the SAP module service SAPValidateAddressWithCandidates.

* If you are installing the Screener module, you must also install these modules: Business
Steward Module, Data Integration Module, Data Hub Module, Universal Addressing Module,
Universal Name Module, Data Normalization Module, and Advanced Matching Module

* When prompted, enter the HTTP port that you want to use then press Enter. The default is
8080. For a complete listing of ports used by Spectrum Technology Platform see Network
Ports on page 21.

5. Unless you are installing a cluster and you cleared the check box to start the server after
installation, the Spectrum Technology Platform server starts when the installation is complete.
Wait for the server to start.

By default, the Windows Server will not auto start. If you want to enable auto start, click the check
box to do so. If you are installing in a clustered environment, you ensure that the check box is
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NOT selected, or the installation will be invalid. You can see when the server has fully started
by opening the log file SpectrumbDirectory\server\logs\spectrum-server.logand
looking for this message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform (Version
version build) Started

Important: Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

6. Install your license key. For more information, see Installing a License Key on page 38.

7. Apply all the updates for the platform and any modules you have installed. For a listing of updates,
see the Update Summary on the Pithey Bowes support website.

Note: Further module-level configurations might be required in some cases, such as Spectrum
Screener ™. See these details in the Installation section of the respective module guides.

Related concepts

Moving transactional data - upgrades only on page 6

As of release 2019.1, we are moving transactional audit log and flow history data from Neo4j to
Elasticsearch to improve the maintenance of and access to this data.

Related tasks

Migrating your search indexes on page 7

If you are upgrading to release 2019.1 from release 2018.2, your Elasticsearch search indexes will
migrate to release 2019.1 during the upgrade process.

Related reference

If you have changed default Elasticsearch certificate connection properties on page 8

Most Spectrum users will run with the default set of connection properties. However, if you did change
any connection properties, you will have to pass into Spectrum the properties file with your unique
settings using the —p command, described in the previous section.

Upgrading a Server

+ Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve issues
with Java.

» Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.
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Note: If you have customized settings in the wrapper. conf file located in

. <SpectrumDirectory>/server/bin/wrapper, we recommend that you copy this file
to a separate location before you upgrade the Spectrum Technology Platform server. After
you complete the upgrade, compare the contents of wrapper.conf installed during the
upgrade with the contents of the saved copy of the file. You can then manually copy
customizations that you want to retain after the upgrade into the updated version of the file.
This is particularly important for changes to the initial and maximum Java heap sizes.

This procedure is for upgrading a single Spectrum Technology Platform server. Follow this procedure
when upgrading a standard installation or when upgrading a node in a cluster. If you are upgrading
a cluster, be sure to follow the cluster upgrade process. For more information, see Upgrading a
Cluster on page 58.

If you upgrade the main server and start it before upgrading and starting the nodes, you will need to
recreate your connections in Management console after upgrading.

1. Download the updated version of Spectrum Technology Platform using the download instructions
contained in the release announcement email.

2. Unzip the downloaded installer to a temporary folder on the server you want to upgrade.

3. Back up the server. For instructions on creating a backup, see the Administration Guide.

4. Back up module-specific data for any of these modules if you have them installed.

Note: For the Screener module, see the section Upgrading Screener in the Screener

guide.
Module Items to Back Up
Advanced Matching Module, Data Normalization Module, Back up the contents of these subfolders located in
and Universal Name Module SpectrumDirectory/server/modules:
¢ cdgdb
* lucene
* matcher
* parser

* searchindex
* tables

Data Hub Module Open the Relationship Analysis Client and click Manage.
Select the model you want to back up then click Backup.

In addition to backing up your models, back up these two
property files:

* SpectrumFolder\server\modules\hub\hub.properties
*  SpectrumFolder\server\modules\hub\do\neod]j .properties
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Module Iltems to Back Up
Spatial Module Back up your named resources, data, and configuration
files.

5. (Optional) You can reduce the time it takes to upgrade your system by purging old records from
the execution history. Consider purging the execution history if it contains over 100,000 entries.
You can view your execution history in Enterprise Designer under View > Execution History.

If you are upgrading from 10.0 SP1, delete old history records manually using Management
Console.

If you are upgrading from version 12.0 SP1, 12.0 SP2, 12.0 SP2.1 and 18.2, use the JMX console
to delete old history records. This process is faster than manually deleting records in Management
Console, and is available on versions 12.0 SP1, 12.0 SP2, 12.0 SP2.1 and 18.2. For more
information, see Purging Execution History on page 36.

6. Stop the Spectrum Technology Platform server. To stop the server, right-click the Spectrum
Technology Platform icon in the Windows system tray and select Stop Spectrum™. Alternatively,
right-click the Spectrum Technology Platform icon in the Windows system tray (shown below)
and select Stop Spectrum™.

Customize...
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7. Wait for the server to finish the shutdown process before proceeding.

Important: If you have the Data Hub Module installed, make sure that all models are stopped.
Models that do not shut down properly will not open successfully after upgrading.

8. If you have the Global Sentry Module installed, stop the Global Sentry database server by going
to the Windows services control panel and stopping the Global Sentry Database Server service.

9. Run the Spectrum Technology Platform installer to upgrade your system.
10. Apply all the updates for the platform and any modules you have installed. For a listing of updates,
see the Update Summary on the Pithey Bowes support website.

Note: Any job or subflow stored in the system during a server upgrade is marked as exposed
to provide the same behavior for those jobs and subflows as before the upgrade. Any job or
subflow that is exported prior to the upgrade will not be exposed. Therefore, when importing
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these jobs or subflows back into the system, you must manually expose the imported job or
subflow.

Some modules have post-upgrade steps you need to perform.

Data Hub Module Open this file in a text editor:
server/modules/hub/db/neo4d]j.properties and set
this property totrue: doms . allow upgrade=true.
This property protects against unintentional and irreversible
store upgrades. Setting this property to "true" indicates that
you understand the ramifications of proceeding with an
upgrade and have taken the necessary precautions before
proceeding.

Restart the Spectrum Technology Platform server. The
server will upgrade each model. Examine the file
server/logs/spectrum-server. log for errors or
warning messages. Once all models have been upgraded,
edit the neo4j .properties file again and comment out
the dbms.allow upgrade property.

Spatial Module During an upgrade, the pool size is reset to 4 if set to a lower
value. A pool size setting of 4 or more is unaffected. To
change the Remote Component Pool Size value after
upgrading, open the Management Console and select
Resources > Spatial. Change the pool size value and click
Save. For details, see Modifying the Pool Size in the
Spectrum Spatial Guide.

Spectrum Screener ™ See the Upgrading Screener section of the Screener guide
for details.

Purging Execution History

If you have many flows, or services that are used frequently, the execution history in Management
Console can become quite large. This procedure describes how to remove old records from the
execution history. You may want to purge old records to reduce the size of the configuration database.
Purging records before upgrading to a new version can help reduce the time it takes to upgrade
Spectrum Technology Platform.

There are two purge methods:

» Purge records:
com.pb.spectrum.platform.configuration:manager=ArchiveTransactionManager
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» Purge records and provide archive status:
com.pb.spectrum.platform.transaction:manager=archiveTransactionManager

The steps below demonstrate the "purge records" (non-archive status) request.

Note: To purge execution history for all nodes on a cluster, perform the purge on each node
individually.

1. Open a web browser and goto http://server:port/jmx-console
Where:

« serveris the IP address or host name of your Spectrum Technology Platform server.
 portis the HTTP port used by Spectrum Technology Platform. The default is 8080.

2. Under Domain: com.pb.spectrum.platform.configuration, click
com.pb.spectrum.platform.configuration:manager=ArchiveConfigurationManager.

3. Optional: If you want to save an archive of the history that you are going to purge, specify the
path where you want to save the archive in the ArchiveDirectory field, then click set. Then, set
ArchiveEnabled to true and click set.

4. In the ArchiveRetain field, specify how many days of records you want to keep in the history

then click set.
For example, if you enter 45 then history records that are 45 days old or newer will be retained,
and records 46 days old and older will be purged. To determine how many days of records you
can retain, look at the job and process flow history in Enterprise Designer and identify the point
in time where the number of records exceeds 100,000.

5. Optional: If you want to schedule a purge to occur on a regular schedule, enter the schedule in
the CronExpression field using a Cron expression.
A cron expression consists of six space-separated values, with an optional seventh value:

Seconds
Minutes

Hours

Day of the month
Month

Day of the week
Year (Optional)

For example, this expression would purge the execution history at midnight every Sunday:
0 00 ? * SUN

For more information about cron expressions, see quartz-scheduler.org/documentation.

After specifying a cron expression, click the set button next to the CronExpression field, set
PurgeEnabled to true, and click the set button next to the PurgeEnabled field.
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Note: You do not need to schedule purges if you want to purge the history only one time
for the purposes of speeding up the upgrade process.

6. Optional: If you want to set a maximum number of records to remain in the history after the purge,
specify the maximum number of records in the MaxHistoryRecordCount field.

This is useful if you have a large number of history records each day, and even after purging old
records based on the value in the ArchiveRetain field, the size of the execution history is still
larger than you want. After purging the old records based on the value in the ArchiveRetain
field, additional records will be purged until the number of records that remains is equal to the
number in the MaxHistoryRecordCount field. If you do not want to specify a maximum number
of history records, specify -1.

Note: The limit you specify in MaxHistoryRecordCount sets the limits for process flows
and jobs separately. For example, if you specify 5000, the maximum number of process
flow history records will be 5,000, and the maximum number of job history records will be
5,000, for a total maximum number of 10,000 records.

7. Inthe PurgeOperation field, leave the value set to ALL.
8. Select All MBeans to return to the main JMX Console screen.

9. Under Domain: com.pb.spectrum.platform.configuration, select
com.pb.spectrum.platform.transaction:manager=ArchiveTransactionManager.

10. To run the purge, click Invoke.

This purges the execution history so that you now have a smaller configuration database.

Installing a License Key

The license key provides access to software pursuant to the terms of your license. It is an encrypted
XML file with a file name ending in . key.

Note: When you upgrade an existing Spectrum Technology Platform installation, you may
continue to use your existing license key. You do not need to get a new one.

To install a license key:

1. Locate the email containing your license key that you received from Precisely.

Important: You must install the license key within 45 days of receiving it. If you do not you will
need to contact Precisely for another license key.

2. Copy the . key file to this directory:

SpectrumPlatformLocation\server\import
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The license key is applied to your system. There is no need to restart your server.

If there was a problem installing the license key, check the log file in:
SpectrumDirectory\server\logs

Depending on whether the key was processed successfully or there was an error processing the
key, the processed key goes into one of these folders:

* SpectrumDirectory\server\archive\license-keys>
* SpectrumDirectory\import\error\license-keys

Installing the Server with a Silent Installer

The silent install process for the server allows you to pre-configure the server installation process
so that it runs without user intervention. Instead of responding to prompts for information such as
the installation location and which modules to install, you specify these responses in a properties
file which the installer uses instead of user prompts.

In the Spectrum Technology Platform installer, go to the folder SilentInstaller.

2. Open the file installer.properties in a text editor.

3. Editinstaller.properties asnecessary to specify the installation settings you want to use.
See the comments in installer.properties for additional information.

4. To run the installer in silent mode, place installer.properties in the same directory as
install.exe. When the installer runs it will detect installer.properties and automatically
run in silent mode.

Alternatively, you can place installer.properties in different directory and give the absolute
path to the property in the command prompt using the - £ argument, as follows:

install.exe -f PathOfPropertyFile\installer.properties

Adding Modules

Spectrum Technology Platform is designed so that modules can be added as you grow your system
over time. For example, you may have one Spectrum Technology Platform module, then license

another module a few months later. The second product may be built on a newer version of Spectrum
Technology Platform. This will require you to upgrade your version of Spectrum Technology Platform.
In another case, the second product is compatible with the installed version. In both cases, the install
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program recognizes if it needs to upgrade Spectrum Technology Platform and will do so without
prompting. If an upgrade is not required, the installer will skip the Spectrum Technology Platform
install steps and install the new module.

The process for adding a module is similar to that of a new installation. In both cases you start the
installation process by running the Spectrum Technology Platform installer. Note that Spectrum
Technology Platform modules do not have their own installer. Instead, you use the Spectrum
Technology Platform installer to add modules.

1. If the Spectrum Technology Platform server is running, stop it. To stop the server, right-click the
Spectrum Technology Platform icon in the Windows system tray (shown below) and select Stop
Spectrum™.

Customize...
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2. Launch the Spectrum Technology Platform installer by double-clicking Install.exe. The
installer guides you through the installation process. When prompted, select the modules that
you want to install. Your currently installed modules are selected.

3. Install any necessary databases for the new product. For more information about installing
databases, see Spectrum Databases on page 90.

4. After you install the necessary databases (if any), start Spectrum Technology Platform by
right-clicking the Spectrum Technology Platform icon in the Windows system tray and selecting
Start Spectrum™.

5. Install the license key for the module. For more information, see Installing a License Key on
page 38.

Removing the Server

Before uninstalling any product, back up any files you may need in the future. Uninstalling Spectrum
Technology Platform will remove all jobs and settings.
1. Stop the Spectrum Technology Platform.

To stop the server, right-click the Spectrum Technology Platform icon in the Windows system
tray (shown below) and select Stop Spectrum™.
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2. Go to Start > Programs > Pitney Bowes > Spectrum Technology Platform > Server and
select Uninstall Pitney Bowes Spectrum Technology Platform.

Note: Some Java files will not be removed because the uninstall process itself uses them.

Typically, the uninstaller program and the uninstall log remain after you complete this procedure.
The repository folder may also remain if background processes were running during the installation.
You can manually remove the SpectrumDirectory and any remaining files and folders that you
do not want to keep.
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Clustered Architecture

In a clustered environment, processing is shared among two or more instances of the server. All
communication with Spectrum Technology Platform goes through a load balancer. Instead of using
the URL and port of the Spectrum Technology Platform server, you use the URL and port of the load
balancer. Consider using this approach if you require failover redundancy and high-volume,
high-performance processing.

Important: As part of your cluster setup and machine preparation, ensure that all system times are
synchronized across all nodes in the cluster.

This diagram illustrates the cluster architecture:

Requests
{Such as API calls, web service requests, clients)

Cluster
Load Balancer
@
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External Resources
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Load Balancer

As requests come into the cluster, the load balancer identifies the best available Spectrum Technology
Platform node to handle the request. The request is then passed to a Spectrum Technology Platform
node.

From the user's perspective, the distributed architecture is handled automatically behind the scenes.
The user sends a request to the load balancer URL and port for Spectrum Technology Platform
(typically port 80 for a distributed environment) as if it were a single Spectrum Technology Platform
server.

Nodes

A node is a Spectrum Technology Platform server installation. Each node has a copy of the
configuration database. Each copy is continuously synchronized. This enables each node to share
the same settings, such as license information, dataflows, and database resources.
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To configure the cluster, simply point Management Console or Enterprise Designer to the load
balancer URL and port for Spectrum Technology Platform (typically port 80 for a distributed
environment).

External Resources

The definitions for external resources such as database resources (postal databases and geocoding
databases for example), JDBC connections, and file servers, reside in the configuration database.
The resources themselves (databases, files, web services) can reside anywhere you choose. Database
resources can be installed either on each node in the cluster or on a shared network location.

Because the database resources themselves reside outside the cluster, multiple clusters can share
the same database resources. You must create the resource definitions in each cluster using
Management Console. For example if you want multiple clusters to share the same geocoding
database, you can install the geocoding database on a server accessible from each cluster, then in
Management Console point each cluster to the geocoding database.

Installing a Cluster

See Installing a Cluster on page 48 for more information.

Clustered Architecture for the Data Hub Module

In a clustered environment, Data Hub Module graph databases are replicated to each Spectrum
Technology Platform server in the cluster. The server that receives the first request to open a model
is the master. All other servers maintain a replicated mirror of that master. If different servers receive
requests to open different models, the masters for the models are on different servers. All writes to
the database are synchronized with the master. Any server can process read requests.

We recommend that clusters have a minimum of three servers in order to achieve a level of fault
tolerance. Also, an odd number of servers provides better individual server resiliency than an
even-numbered cluster. We make these recommendations because once the model is running, the
system will continue running as long as more than half the servers are in communication. For example,
in a cluster of six servers, four must stay in communication; for a cluster of three servers, two must
stay in communication, and for a cluster of two servers, all servers must be in communication. Both
a three-server cluster and a four-server cluster can tolerate a maximum of one lost server.

All servers in the cluster must be available in order to open or create a model. If any server is
unavailable, the server will wait for all servers to join the cluster. If this number of servers do not join
within the timeout period, the operation fails.
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Clustered Architecture for the Global Geocoding Module

In a clustered environment, processing is shared among two or more instances of the server. The

diagram below illustrates the deployment architecture of such a configuration. Load balancing can
be used to support high availability and scaling. The deployment architecture includes a load balancer,
Spectrum Technology Platform nodes with Global Geocoding Modules and Geocoding databases.

l Requests

Load Balancer
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Spectrum Node 1 Spectrum Node 2
(with Global Geocoding Module) (with Global Geocoding Module)

Spectrum Node 3
(with Global Geocoding Module)

|
| /
-

| |
s O

Geocoding database Geocoding database

|
O

Geocoding database

Cluster

Note: Each Geocoding database MUST be installed in the same location on all of the nodes
for the cluster to work properly. For example, if the Geocoding database for "Spectrum Node
1" is installed on C:\data\, then the other Spectrum nodes' Geocoding database must also

reside on C:\data\.

Clustered Architecture for the Spatial Module

In a clustered environment, processing is shared among two or more instances of the server. The
diagram below illustrates the deployment architecture of such a configuration. Load balancing can

be used to support high availability and scaling. The deployment architecture includes a load balancer,
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a Spectrum Spatial cluster, a database, and a file share. With this approach it is possible to scale
both horizontally and vertically. You can cluster the Spatial Module with or without platform clustering.

Note: Setting up both a Spectrum Technology Platform cluster and a Spatial Module cluster
is recommended and has several benefits:

» Security (ACL) synchronization happens automatically for named resources .

» Dataflows, users, and roles created on one node will automatically synchronize to all nodes.

+ All Spatial Module demo pages and utilities (such as Spectrum Spatial Manager) can and
should point to the load balancer.

HTTP/HTTPS

Load Balancer

HTTP

_/

J@ysn|) Jantag |eneds
pasueleg peo

Spectrum Spatial Server
(Server 1) (Server 2) (Server 3)

(/
o

C N

Database Server Map Image File Share

Load Balancer

The load balancer spreads requests between the Spectrum Spatial instances. Any load balancer
that supports load balancing HTTP/HTTPS requests can be used.
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Spectrum Spatial Cluster

The cluster is a collection of Spectrum instances with the Spatial Module sharing administration,
named resources, geographical metadata content and configuration settings. Additional nodes can
be added to the cluster for resilience or to deliver support for greater loads. Each node can be scaled
vertically through additional hardware resources and/or additional instances should this be required
for hardware with massive resources. Spectrum can be configured to use restricted numbers of
CPUs.

Database

Spectrum stores named resources (maps, layers, tables and styles), geographic metadata and
configuration in a repository. In the default single server installation an embedded database is used
to store these resources on the local server. To create a resilient scalable solution this embedded
database should be replaced with a resilient independent database. Oracle, PostGreSQL/PostGIS
and Microsoft SQL Server are the supported repository databases.

In the load balanced configuration, Spectrum nodes cache these resources in a local cache and
search index in each node in the cluster. When a Spectrum node receives a request it uses the local
cache and index to find resources. Named resources can be added through any node in the cluster.
Each node keeps its cache current by checking for differences between its local cache and the central
database. This check occurs every 2 seconds by default. Time frequency can be configured. This
architecture ensures the server delivers high performance transactions and the load on the repository
database is kept to a minimum. If a new Spectrum node is added to the cluster the cache and index
are created automatically. Such a scenario can occur to remedy a node failure or grow the capability
of the deployment.

File Share

The file share provides a folder to hold map images generated by Spectrum. When maps are rendered
using the web services the server supports the map images being returned through URLSs or returned
as a base 64 encoded image. When a URL is returned the map image is stored as a file and served
on request of the URL. To ensure any Spectrum node can return the map image a file share is used
to store the images.

Requirements

A cluster should consist of at least three nodes.

* All servers that host a node must have their system clocks synchronized in order for the cluster to
function. Verify that all systems point to the same time service to synchronize their clocks.
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* All nodes in a cluster must be the same version of Spectrum Technology Platform so be sure that
the version you install is the same as the existing nodes.
* All nodes in a cluster must have the same modules installed.

Installing a Cluster

Installing a cluster involves setting up one Spectrum Technology Platform server at a time.

Each time you add a server you need to point it to an existing server which will act as a seed node.
A seed node is a server that has a copy of the Spectrum configuration data that it can copy to a new
node so that the new node's configuration is synchronized with the other nodes in the cluster.

Note: All similar nodes should contain all seed addresses. In a combined installation, where
the product server and repository are located on the same physical or virtual machine, the
seeds would be identical. However, in a separated installation, where the product server and
repository server are on separate physical or virtual machines, the server nodes would contain
only server seeds and the repository would contain only repository seeds.

The following diagrams illustrate this process.

After installing the first node you will, in effect, have a cluster with only one node:

Cluster

Spectrum Node 1

I 5ﬁn‘

When you install the second node it must point to the first node as a seed node. This will enable the
second node to receive a copy of the first node's configuration database, resulting in a cluster with
two nodes with synchronized configuration information.

Cluster

Spectrum Node 1 Spectrum Node 2
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As you add additional nodes, the new nodes can point to any of the existing nodes as a seed node.
You must also configure the first node to point to at least one other node in the cluster so that if it is
ever brought down it can rejoin the cluster.

Cluster

Spectrum Node 1 Spectrum Node 2

B = =
=

Spectrum Node 3

[ =4

Before you begin, install an appropriate load balancer. Follow the procedures described in the load
balancer's documentation when installing.

Note: The load balancer must be configured to allow encoded forward slashes. If the load
balancer does not allow encoded forward slashes you may get HTTP 404 errors while using
the cluster. For example, if you are using an Apache load balancer, you can configure it to
allow encoded forward slashes by opening the httpd. conf file and specifying this property:
AllowEncodedSlashes On. For other types of load balancers, refer to the load balancer's

documentation.

Once you have your load balancer installed, follow these steps to install nodes in the cluster.

1. Install Spectrum Technology Platform on a server where you want to host a node. For instructions,
see Installing a New Server on page 32.

Important: The installer will provide the option to auto start Spectrum Technology Platform
server. By default this option is not selected. Do not enable this option if installing a clustered
environment.

2. Configure the properties files.
a) Editthe propertiesinfile server/conf/spectrum-container.properties, as described
in Cluster Properties on page 52.
b) Save and close the spectrum-container.properties file.
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c) Some modules have module-specific settings that you must configure to enable the module
to work in a cluster.

Module Cluster Configuration Settings

Advanced Matching Module These settings configure clustering for full-text search indexes. If
you do not use full-text search indexes you do not need to configure
these settings.

Open this file in a text editor:
. .\server\modules\searchindex\es-container.properties
Configure these properties:

es.index.default_number_of_replicas Enter the number of additional
copies you want created for
each search index. This
number should be the number
of nodes in your cluster minus
1. For example, if your cluster
has five nodes, you would
enter "4" in this property.

es.index.default_number_of_shards Enter the number of shards
you want your index to have in
the distributed environment.
The more nodes that are in
your cluster, the higher this
number should be.

Save and close
es-container.properties
when you are done editing
these properties.

Note: Search indexes created prior Spectrum Technology
Platform 10.0 do not support clustering. To enable
clustering for indexes created prior to the 10.0 release,
you must recreate the search index using the 10.0 API
after modifying the es-container.properties file.
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Cluster Configuration Settings

Data Hub Module

Open this file in a text editor:

. .\server\modules\hub\hub.properties

Configure these properties:

hub.models.path.base

hub.neodj.database.type

hub.servers.per.cluster

Specifies the folder where models are
stored. By default, each model is
placed in a subdirectory under the

. .\server\modules\hub\db
folder. If you want to store models in
a different location, uncomment this
property and specify the folder where
you want to store models.

Change the value of this property to
ha. The default value embedded is for
non-clustered installations.

Uncomment this line. Set the value of
this property to the number of
Spectrum Technology Platform
servers in the cluster.

Save and close hub.properties when you are done editing

these properties.

The . .\server\modules\hub\db\neo4j.properties
controls how the graph databases are configured, using Neo4;j
Enterprise. This file is used as a template for each model. If
needed, each model can be configured separately by placing a
copy of the neo4j.properties file into the store directory for

that model.

3. Start the server. To start the server, right-click the Spectrum Technology Platform icon in the
Windows task bar and select Start Server.

4. Repeat this procedure to install additional nodes in the cluster.

5. After installing all the nodes, go back to the first node and add the other nodes as seed nodes.

a)

On the first node you installed, open the properties file

server/conf/spectrum-container.properties.

b)

In the property spectrum.cluster.seeds, add the host name or IP address of the other

nodes in the cluster, separating each with a comma: ipaddress1, ipaddress?2,...,ipaddressn

C)
the server.

Save and close the spectrum-container.properties file. You do not need to restart

Cluster
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Cluster

The spectrum-container.properties file contains the properties that configure a cluster. This
table describes how to set the cluster properties for a cluster where the server and configuration
database are installed together on each node, and for nodes in the server cluster in a separated
configuration database installation. If you are setting up a configuration database cluster, see Cluster
Properties for a Configuration Database Cluster on page 75.

Property

Description

spectrum.cluster.enabled

Indicates whether a clustered configuration is used. Set this
to true.

spectrum.cluster.name

If this is the first node in the cluster, set this to the name you
want to give to the cluster.

If this is not the first node in the cluster, set this to the name
of the cluster that you want this node to join. If you are
unsure of the cluster name, check the
spectrum.cluster.name property on another node
in the cluster.

spectrum.

cluster.

seeds

List the IP address and host name for all seeds of the cluster.
For example, if your configuration includes three nodes, list
NodelIPorHostName, Node2IPorHostName,
Node3IPorHostName.

spectrum.

cluster.

nodelID

Set this to an integer value to use as the ID for this node.
The ID must be an integer and must be unique among all
nodes in the cluster.

Tip: We recommend that the first node you install have a
node ID of 1, the second one 2, and so on.

spectrum.

runtime.

hostname

Un-comment this property and set this property to the load
balancer host name.

spectrum.

runtime.

port

Un-comment this property and set this property to the port
on which you have configured the load balancer to listen.
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Property Description

spectrum.repository.addresses Note: This property can be commented out, unless

a distributed installation is used. For distributed
installations, this property must point to all
repository nodes.

In distributed clustered configurations, with separate clusters
of servers and repositories, on different machines, specify
the IP addresses of each node in the configuration database
cluster. Separate each IP address with a comma. For
example, in a three-node database cluster, you would
specify:
FEdmmresitory.atieses Bl -[Roliess, diNoE-TRuless dNoE3-TRoliess

Installing a Cluster for the Spatial Module

To set up a cluster for the Spatial Module, you must first configure a common repository (depending
on the type of database you have) then configure your system to prepare it for clustering.

Note: Setting up both a Spectrum Technology Platform cluster and a Spatial Module cluster
is recommended and has several benefits:

» Security (ACL) synchronization happens automatically for named resources .

» Dataflows, users, and roles created on one node will automatically synchronize to all nodes.

+ All Spatial Module demo pages and utilities (such as Spectrum Spatial Manager) can and
should point to the load balancer.

Related tasks

Installing a Cluster on the Platform on page 48
Installing a cluster involves setting up one Spectrum Technology Platform server at a time.

Setting Up a Common Repository Database

You must configure the Spatial Module to use a common repository database for the cluster. This
ensures that named resources, geographic metadata and configuration settings are managed across
the cluster.

The repository is installed with a set of named resources, geographic metadata and configuration
files. To migrate these resources to the common database repository the resources need to be
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exported from the default internal repository database and reimported into the new shared repository
database.

For bulk export and import of repository content, use the 1imrepo import and limrepo export
commands in the Administration Utility. These commands give you the option of preserving
permissions (see the Administration section of the Spectrum Spatial Guide for instructions.)

These steps describe how to set up your repository on a common database, either PostgreSQL,
Oracle, or Microsoft SQL Server:

1. Export all repository resources to a local folder using the 1imrepo export command in the
Administration Utility (see the Administration section of the Spectrum Spatial Guide for
instructions).

The contents of the installed repository must be exported. This step only needs to be performed
once, as the contents of the repository should be the same at this point for all instances of
Spectrum Technology Platform.

2. Stop the Spectrum Technology Platform server on all nodes (for instructions, see Stopping a

Cluster on page 67.)

3. Onall nodes of the Spectrum Technology Platform modify the configuration to specify the common
database.

a) Copy the contents of repository.<databaseType>.xml {0 repository.xml located
under the server/modules/spatial/jackrabbit folder where <databaseType> is
the appropriate type for your database (postgres, oracle, or mssql).

b) Inrepository.xml:

» Modify the DataSource section with the server host name, port, database, user, and
password.

» Modify the Cluster section to assign a distinct cluster ID, like Node1. Ensure unique IDs
are assigned to every subsequent node in the cluster (for example, Node2, Node3).

» Save the changes to repository.xml.

c) Remove these folders from the /server/modules/spatial/jackrabbit folder:
repository, version, workspaces.

4. If your database has previously contained any repository content, you must remove these tables
to create a clean repository:

* default_binval

* default_bundle
 default_names

* default_refs

* rep_fsentry

* rep_global_revision
* rep_journal

* rep_local_revisions
* security_binval

Cluster
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* security_bundle
* security_names
* security_refs

* version_binval
* version_bundle
* version_names
* version_refs

If using Oracle, then also delete version seq names id, security seq names_ id,and
default seg names id.
5. On the seed node only, import the backed up repository content.

a) Start the Spectrum Technology Platform server (for instructions, see Starting a Cluster on
page 66).
b) Import the contents using the 1imrepo import command, pointing to the seed node.

6. Start the remaining nodes in the cluster (for instructions, see Starting a Cluster on page 66).
Configuring Your System

Once the Spectrum Technology Platform is installed and you have configured a common repository,
you need to configure your instance before you can replicate it to another virtual machine. If you are
not using a virtual machine environment, you will need to perform these steps on each of your
Spectrum Technology Platform installations.

Configure the Map File Share

To configure the map file share (a shared image folder) to Spectrum Technology Platform, you first
need a shared map image directory.

Note: To create a Unix/Linux map file share, see Creating a Map Image File Share on
Unix/Linux on page 56.

Note: To create a Windows map file share, see Creating a Map Image File Share on
Windows on page 57.

Once a map image directory has been created, configure the map file share:

1.  Modify the Mapping Service configuration by pointing to a shared image folder and load balance
server. In the ImageCache change the Directory parameter to a common image directory, and
change the AccessBaseURL parameter to the load balancer machine image URL.

If you are using a virtual machine environment, remember this IP address, as you must set the
load balancer VM to this IP address.

Cluster
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For Unix/Linux installations:

<ImageCache>
<Directory>/<spatial server
root>/server/modules/spatial/images</Directory>
<AccessBaseURL>http://<loadbalance IP address>/rest/Spatial/
MappingService/internal/imageCache</AccessBaseURL>
<FileExpire>30</FileExpire>
<ScanInterval>30</ScanInterval>
</ImageCache>

For Windows installations:

<ImageCache>

<Directory>\\server\Share\images</Directory>
<AccessBaseURL>http://<loadbalance IP address>/rest/Spatial/MappingService/
internal/imageCache

</AccessBaseURL>

<FileExpire>30</FileExpire>

<ScanInterval>30</ScanInterval>

</ImageCache>

2. For Unix/Linux installations, you must set up a symbolic link to enable map images to go to the
shared file system.
Create an images subfolder in the mounted share folder, for example, /mnt/<linux
mount>/images

cd /<spatial server root>/server/modules/spatial
rm —-Rf images
In -s /mnt/<linux mount>/images ./images

Creating a Map Image File Share on Unix/Linux

The file share provides a folder to hold map images generated by Spectrum Spatial. Create a shared
folder accessible to all Spectrum nodes. The file share is not required if maps are returned from the
web services as Base64-encoded images.

To create a map image file share on Unix/Linux:

1. Mount a shared folder on each operating system hosting Spectrum. The commands below mount
a drive on a Microsoft Windows Server or network drive supporting CIFS.

mkdir /mnt/<linux mount>
mount -t cifs //<windows host>/<windows share> /mnt/<linux mount>-o
username=shareuser, password=sharepassword, domain=pbi
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2. Set the image share to load at startup in /etc/fstab.

//<windows ip address for share>/share /path to/mount cifs
username=server user,password=secret, netdev 0 0

Creating a Map Image File Share on Windows

The file share provides a folder to hold map images generated by Spectrum Spatial. Create a shared
folder accessible to all Spectrum nodes. The file share is not required if maps are returned from the
web services as Base64-encoded images.

To create a map image file share on Windows:

1. In Windows Explorer, select the image folder you want to share.
2. Right-click, then click Share or Share with.

3. Select the users who will be writing to the image folder. These users must have read/write
privileges.

Modifying OGC Service Configurations for Clustering

To ensure clustering works when you have both a Spectrum Technology Platform cluster and a
Spatial Module cluster, changes are required to the Open Geospatial Consortium (OGC) services
configuration files using Spectrum Spatial Manager: From the WFS, WMS, and WMTS settings
pages, change the online resource (service) URL to the IP address and port of the load balancer.
See the Spectrum Spatial Manager Guide in the Ultilities section of the Spectrum Spatial Guide for
more information.

Configuring Ports for Multiple Spectrum Instances

If you have multiple Spectrum Technology Platform instances on a single machine, you must change
the port numbers for each instance. Change all ports in <Spectrum
root>/server/conf/spectrum-container.properties to new port values that are not in
use. The HTTP port reflects the port number entered in the installer.

Shared Spectrum Local Data

If you are using TAB file data on the file system, this data needs to be in a shared location accessible
by all instances of Spectrum in the load balanced environment. It is also important to note that all
named resources in the repository accessing data on the file system should point to this shared
location.

Each VM or machine hosting Spectrum needs to have access to the mounted shared drive.

Note: Using named resources that point to database tables do not require a shared drive, as
the named resources in the repository do not access the data using a file path; rather they
use a named connection to the data in the database.
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Upgrading a Cluster

» Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve issues
with Java.

» Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

Note: If you have customized settings in the wrapper. conf file located in

. <SpectrumDirectory>/server/bin/wrapper, we recommend that you copy this file
to a separate location before you upgrade the Spectrum Technology Platform server. After
you complete the upgrade, compare the contents of wrapper . conf installed during the
upgrade with the contents of the saved copy of the file. You can then manually copy
customizations that you want to retain after the upgrade into the updated version of the file.
This is particularly important for changes to the initial and maximum Java heap sizes.

This procedure is for upgrading a cluster where the Spectrum Technology Platform server and
configuration database are installed on each node of the cluster. To upgrade a cluster, you upgrade
one node at a time. The first node you upgrade is handled slightly differently than the other nodes
because you must point the node to itself as a seed node since no other nodes will be running in the
cluster when it starts up.

Note that these scenarios have special procedures for upgrading a cluster:

For this scenario... Use this information...

...separate clusters for server nodes and Upgrading a Cluster with a Separated

configuration database nodes Database on page 76.

...upgrading a cluster for the Spatial Module only [ Upgrading a Cluster with the Spatial Module
on page 63

...upgrading both Spectrum and Spatial Module |Upgrading a Cluster with the Spatial Module

clusters on page 63

...upgrading a cluster running the Data Hub Before shutting down all nodes, see "Upgrading

Module a Cluster with the Data Hub Module" in the

Spectrum Installation Guide.

If the above scenarios do not apply to you, follow this procedure to upgrade your cluster:

1. Back up the server. For instructions on creating a backup, see the Administration Guide.
2. Stop all the nodes in the cluster. For more information, see Stopping a Cluster on page 67.
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3. On the last node that you stopped:

a. Upgrade the node. For more information, see Upgrading a Server on page 33.
b. Openthefile spectrum-container.properties in atexteditor and configure the cluster
properties. For more information, see Cluster Properties on page 52.

4. Upgrade each of the other nodes, one at a time. Follow this procedure only when upgrading
nodes other than the first node.

Note: Be sure to back up your server before proceeding. This step is only applicable
when upgrading from Spectrum Technology Platform versions 11.1 or older.

a. Add or ensure that you have set spectrum.cluster.nodeID — Set this to "1" on the first
node, and this value will increase for subsequent nodes.

b. Delete this folder, if present:
SpectrumDirectory\server\repository\store\databases.

c. Upgrade the node. For more information, see Upgrading a Server on page 33.

d. Openthefile spectrum-container.properties inatexteditor and configure the cluster
properties. For more information, see Cluster Properties on page 52. Save and close the
file when you are done.

5. Start all nodes consecutively, after upgrading. Make sure that you start node 2 within only a few
seconds after starting node 1, and repeat this for each remaining node.

You may find it necessary to stop nodes manually, as in the case of applying software updates.
When you stop all nodes of the cluster manually, or if all nodes are down, you must start as a new
cluster/session.

Upgrading a Cluster with the Data Hub Module

» Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve issues
with Java.

» Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

Note: If you have customized settings in the wrapper. conf file located in

. <SpectrumDirectory>/server/bin/wrapper, we recommend that you copy this file
to a separate location before you upgrade the Spectrum Technology Platform server. After
you complete the upgrade, compare the contents of wrapper . conf installed during the
upgrade with the contents of the saved copy of the file. You can then manually copy
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customizations that you want to retain after the upgrade into the updated version of the file.
This is particularly important for changes to the initial and maximum Java heap sizes.

In a cluster that runs the Data Hub Module, each node hosts the Spectrum Technology Platform
server as well as Data Hub Module models. When upgrading, you need to upgrade your models in
addition to upgrading the Spectrum Technology Platform server.

The upgrade process consists of these steps:

1. Back up your models and properties files.
2. On the master server, upgrade Spectrum Technology Platform then upgrade your models.

3. On each non-master server, upgrade Spectrum Technology Platform then copy the upgraded
models from the master server to the non-master server.

To upgrade a cluster that runs the Data Hub Module, follow this procedure:
1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

2. Open the Relationship Analysis Client and click Manage. Select the model you want to back up
then click Backup.

In addition to backing up your models, back up these two property files:

* SpectrumFolder\server\modules\hub\hub.properties

* SpectrumFolder\server\modules\hub\db\neo4j.properties

3. Identify which node is the serving as the master server for the Data Hub Module.
a) Open a web browser and go to:

http://LoadBalancer:8080/jmx-console/HttpAdaptor/list

b) Scroll down to the neodj.org domain.

You will see a set of objects for each model. The Role attribute in the HighAvailability object
indicates whether a server is the master for a model.

c) If you have more than one model and each model has a different master, you need to make
one server the master of all the models. To do this, restart the cluster then open the
Relationship Analysis Client using the hostname or IP address of one of the nodes rather
than the load balancer. In the Relationship Analysis Client, open each model by running a
query on each model. This will make the server you are connected to the master for each
model.

4. Stop each non-master node in the cluster; stop the master server last. Stop nodes one at a time
rather than all at once.

Important: Make sure that Spectrum Technology Platform stops without errors. If a server does
not stop properly, Data Hub Module models on the server will not open successfully after

Cluster
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upgrading. To ensure that Spectrum Technology Platform stopped cleanly, examine the
SpectrumFolder\server\logs\spectrum-server. log file for errors during shutdown.

5. Upgrade the master server.

a)

d)

f)

)
h)

)

k)

If you are upgrading from Spectrum Technology Platform 11.0 or later, each model directory
must contain a version.data file. Review all the model . Mode 1 Name subdirectories
located under SpectrumFolder\server\modules\hub\db to confirm that they contain
aversion.data file. If any model directory is missing this file, copy the corresponding
version.data file from one of the non-master nodes.

Important: The installer will prompt you to start Spectrum Technology Platform after the
installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

Run the Spectrum Technology Platform installer to upgrade the master server to the new
version of Spectrum Technology Platform.

Open the file SpectrumFolder\server\modules\hub\hub.properties in an editor
and confirm that the following property is set to embedded:

hub.neo4j.database.type=embedded

Open the file SpectrumFolder\server\modules\hub\db\neo4j.propertiesinan
editor and set the following property to true.

dbms.allow upgrade=true

Start the Spectrum Technology Platform server.

Open each model in the Relationship Analysis Client and run a query. Any query is sufficient.
Stop the Spectrum Technology Platform server.

Indexed properties are now restricted to a maximum length of 4036 bytes. If your model has
an indexed property that exceeds this limitation, proceed to step 6 on page 61.

If your model does not have an indexed property that exceeds this limitation, continue with
substep 5.i on page 61.

Open the SpectrumFolder\server\modules\hub\hub.properties file in an editor
and set the following property to ha:

hub.neo4j.database.type=ha

Compare any properties files that you backed up to the installed files and make any necessary
changes. Do not overwrite new files with old files because new files may contain properties
that old files do not.

Skip step 6 on page 61 and continue to step 7 on page 62.

6. Indexed properties are now restricted to a maximum length of 4036 bytes. If a model has an
indexed property that exceeds this limitation, you will not be able to open that model until you
complete the following steps:
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a) Copythe SpectrumFolder\server\modules\hub\db\neodj.properties filetothe
SpectrumFolder\server\modules\hub\db\model . ModelName folder for each model
that exceeds the property constraint of 4036 characters.

b) Open the neodj.properties files that you copied in Step a. In a text editor, uncomment and
setdbms.index.default schema providertolucene+native-1.0.Make surethe
neo4j store upgrade is uncommented and that the following property is set to true:

dbms.allow upgrade=true

c) Start the Spectrum Technology Platform server.

d) Remove the
SpectrumFolder\server\modules\hub\db\model .ModeIName\neodj.properties
file in each model folder that had the constraint.
After you remove the files, native-btree-1.0 indexing will be used by default. We recommend
that you fix all models that failed upgrade due to the 4036 indexed property constraint and
re-index those models from Lucerne+native-1.0 indexes to the latest native-btree-1.0 indexes.
See the hub model reindex command in the Administration Utility section of the
Administration Guide.

e) Stop the Spectrum Technology Platform server.

f) Openthe SpectrumFolder\server\modules\hub\hub.properties file in an editor
and set the following property to ha:

hub.neo4j.database.type=ha

g) Compare any properties files that you backed up to the installed files and make any necessary
changes. Do not overwrite new files with old files because new files may contain properties
that old files do not.

7. Upgrade the non-master servers.
a) Delete the models in the SpectrumFolder\server\modules\hub\db directory.

Warning: Do not delete the models from the master server.

b) Important: The installer will prompt you to start Spectrum Technology Platform after the
installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

On one of the non-master servers, run the Spectrum Technology Platform installer to upgrade
it to the new version of Spectrum Technology Platform.

c) Open the SpectrumFolder\server\modules\hub\hub.properties file in an editor
and confirm that the following property is set to embedded:

hub.neodj.database.type=embedded

d) Compare any properties files that you backed up to the installed files and make any necessary
changes. Do not overwrite new files with old files because new files may contain properties
that old files do not.
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e) Copy all SpectrumFolder\server\modules\hub\db\model .ModelName directories
from the master server to the non-master server.
f) Repeat these steps for each non-master server in the cluster.

8. Start the cluster.

a) Start the master server, followed by non-master servers.

b) Ensure that each server in the cluster is functioning. Check
SpectrumFolder\server\logs\spectrum-server. log forany errors.

c) While directly connected to the master server (bypassing the load balancer), open each
model, one at a time, and inspect the spectrum-server.log file for errors.

Upgrading a Cluster with the Spatial Module

When a common repository database is used for clustering, these additional steps are required
before and after the Spectrum Technology Platform upgrade process. This upgrade process must
be followed even if you have a single node with a common repository database.

Before the upgrade, you must move to a local database setup; after the upgrade, you then change
back to the cluster setup by pointing repository.xml to the external database.

Note: To preserve access control settings, use the Administration Utility instead of WebDAV.
See the Administration section of the Spectrum Spatial Guide for instructions on using the
Administration Utility. The 1imrepo commands in the Administration Utility were available
beginning in version 11.0; if you are upgrading from a version prior to 11.0, you must use
WebDAV.

1. Before upgrading Spectrum Technology Platform, back up the repository by following these

steps.

a) Select a node from the cluster. This will be the seed node (see Installing a Cluster on page
48).

b) Back up the repository content using the Administration Utility's 1imrepo export command
with ACL, pointing to the seed node.

c) Back upthe Spectrum\server\modules\spatial\jackrabbit folder to a location
outside the installation folder.

2. Switch the common repository database to a local database (temporarily, just for upgrade
purposes). Apply these steps to all nodes in the cluster.

a) Stop the Spectrum Technology Platform server on all nodes (for instructions, see Stopping
a Cluster on page 67).

b) Delete the repository, version, workspaces folders and the 1ock.properties file (if
available) from the jackrabbit folder
(Spectrum\server\modules\spatiall\jackrabbit).
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c) Create a backup copy of repository.xml and name it repository-Copy.xml for
example.

d) Copy the contents of repository.standalone.xml t0 repository.xml.

e) Start the Spectrum Technology Platform server on all nodes (for instructions, see Starting
a Cluster on page 66).

f) Import the repository content (backed up in Step 1b) into the repository using the 1imrepo
import command with ACL for all nodes.

g) Stop the Spectrum Technology Platform server.

3. Follow normal procedures in Upgrading a Cluster on page 58 to upgrade Spectrum Technology
Platform to the new version on all nodes.

4. Forthe seed node only, after the Spectrum Technology Platform upgrade is complete, back up
the upgraded content by following these steps.

a) Start the upgraded Spectrum Technology Platform server on the seed node and download
the Administration Utility.

b) Back up the content from the repository using the 1imrepo export command with ACL
by pointing to the seed node.

c) Stop the Spectrum Technology Platform server on all nodes (for instructions, see Stopping
a Cluster on page 67).

d) Onallnodes, back up the upgraded Spectrum\server\modules\spatial\jackrabbit
folder to a location outside the installation folder.

5. Onall nodes of the Spectrum Technology Platform modify the configuration to specify the common
database.
a) Restore the backup repository-Copy.xmnl file to repository.xml.
b) Remove these folders from the /server/modules/spatial/jackrabbit folder:
repository, version, workspaces.

6. If your database has previously contained any repository content, you must remove these tables
to create a clean repository:

* default_binval

* default_bundle

» default_names
default_refs

* rep_fsentry

* rep_global_revision
* rep_journal

* rep_local_revisions
* security_binval

» security_bundle

* security_names

* security_refs

* version_binval
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* version_bundle
* version_names
* version_refs

If using Oracle, then also delete version seq names id, security seq names id,and
default seqg names id.
7. On the seed node only, import the backed up repository content.

a) Start the Spectrum Technology Platform server (for instructions, see Starting a Cluster on
page 66).
b) Import the contents using the 1imrepo import command, pointing to the seed node.

8. Start the remaining nodes in the cluster (for instructions, see Starting a Cluster on page 66).

Removing a Node from a Cluster

To remove a node from a cluster, stop the Spectrum Technology Platform server.

1. To stop the server, right-click the Spectrum Technology Platform icon in the Windows system
tray (shown below) and select Stop Spectrum™.

2. Stop the node you want to remove:

change the working directory to the Spectrum Technology Platform server's bin directory, source
the setup file, then type the following command: . /server.stop .

On Windows, right-click the Spectrum Technology Platform icon in the system tray and select
Stop Spectrum™.

3. Open the file server/conf/spectrum-container.properties in a text editor and set
spectrum.cluster.enabledto false.

4. On each of the other nodes in the cluster, open the spectrum-container.properties file
and remove the node from the spectrum.cluster.seeds property.

For Spatial Module users: If you want to keep the node standalone and able to run outside the
cluster, copy back the original repository.xml file and remove the following folders from the
/server/modules/spatial/jackrabbit directory for each instance of Spectrum Technology
Platform: repository, version, workspaces. Restart the server and import the repository content.

Adding Nodes to a Cluster

This procedure describes how to add one or more nodes to an existing cluster.

Cluster

Spectrum Technology Platform 2019.1.0 Installation Guide

65



1. Stop all the Spectrum Technology Platform nodes in the cluster. For more information, see
Stopping a Cluster on page 67. If your cluster has a separated configuration database cluster,
you only need to stop the server cluster, not the configuration database cluster.

Warning: To prevent data loss you must stop the cluster by following the procedure described
in Stopping a Cluster on page 67.

2. On any node in the cluster, install the module or modules you want to add.
3. Open this file in a text editor:

server/conf/spectrum-container.properties

4. Inthe spectrum.cluster.seeds property, remove all host names and IP addresses except
for the one for this server. Save the host names and IP addresses so that you can re-add them
later.

5. Save the file.
6. Start the server.

Note: Wait for the server to fully start before proceeding.

7. Inthe file spectrum-container.properties, add the host names and IP addresses that
you had removed.

8. Save the file. You do not need to restart the server.

9. Install the modules on each of the other nodes in the cluster. Start each node after installing the
modules on it, and wait for it to fully start before installing the modules on the next node. You do
not need to modify the spectrum.cluster. seeds property when installing modules on
subsequent nodes.

Starting a Cluster

These instructions assume that the server is stopped.

If all the nodes in a cluster are stopped, you must follow this procedure to start the cluster safely and
avoid data loss.

On the last node that was stopped last, start the server. Do this for each node in the cluster.

Warning: The first node that you start must be the last node that was stopped to preserve the most
recent data. Starting another node first may result in loss of data such as job history and configuration
settings. If you do not know which node was stopped last, look in each node's log for the time stamp
of the shutdown message. You can find the log in:
SpectrumDirectory\server\logs\spectrum-server.log.

a) Start the server.
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b) Start all nodes consecutively, after upgrading. Make sure that you start node 2 within only a few
seconds after starting node 1, and repeat this for each remaining node.

You can tell when the Spectrum Technology Platform server has completely started by looking
in the log file: SpectrumbDirectory\server\logs\spectrum-server.log. This message
is displayed when the server is completely started:

Pitney Bowes Spectrum(TM) Technology Platform (Version Version Number)
Started.

The log will show the IP address for one of the nodes bound to the Spectrum Technology Platform
service.

Stopping a Cluster

To stop an entire cluster:

1. Identify which nodes are seed nodes. To do this, open the file
SpectrumDirectory/server/conf/spectrum-container.properties andlook atthe
nodes listed in the spectrum.cluster. seeds property.

2. Stop each Spectrum Technology Platform server in the cluster, making sure that the last node
you stop is a seed node.

3. Right-click the Spectrum Technology Platform icon in the Windows system tray and select Stop
Spectrum™.

Warning: To prevent loss of data when starting the cluster, the first node you start must be the
last node that was stopped, and that node must be a seed node.

Using Enterprise Designer with a Cluster

1. Launch Enterprise Designer.
2. Inthe Server name field, enter the server name of the load balancer.
3. Inthe Port field, enter the port that you have configured the load balancer to listen on.

Note: Input files, output files and database resources must be on a shared drive, or file
server, or some commonly-accessible location. Otherwise, all files must be loaded on
each server that hosts a Spectrum Technology Platform server and must be located in
the same path.
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Once you have logged in you can use Enterprise Designer as normal. The actions you take will apply
to all Spectrum Technology Platform instances in the cluster where you are logged in.

Disabling Host Checks in Token Authentication

In token authentication, the Spectrum Technology Platform server examines the token presented by
the client before responding to the request. The server checks the token to see if it has expired, if it
is encrypted correctly, and if it is from the correct host. For session tokens, the server also checks
the session ID. If any of these checks fail, the token is rejected and the server does not respond to
the request.

In a clustered environment, it is possible that requests may be redirected in a way that makes the
request appear to be coming from a different host than is specified in the token, resulting in "invalid
token" errors. For example, say you have a cluster with two nodes as shown here:

> g
Q‘_ Mode 1: Requests are
» A from host 2222
% = '

Load Balancer

Client 2222

1111 ’ . >
Proxy or VM Adapter Mode 2: Requests are
3333 from host 3333

Let's say that the client makes a request and is the request is routed to Node 1. A token is created
and tied to host 2.2.2.2 (the load balancer) since the node views the request as coming from the
load balancer. If the next request from the client is routed to Node 2, the token will still be tied to host
2.2.2.2 but the request will appear to be coming from the proxy server, 3.3.3.3. In this case the node
will reject the token because it appears that it is not associated with the host making the request.

In this situation you must configure the Spectrum Technology Platform server to ignore the host
information included in the token. This should only be done if you have an environment where there
are different network devices between the load balancer and the nodes. If all nodes are behind the
same network device, there is no need to disable the host check.

Note: If you follow this procedure, client tokens become "open" tokens, since the host check
is disabled. Session tokens will continue to be associated with a specific session ID, but not
with a specific host.

1. Open the following properties file on the Spectrum Technology Platform server:
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SpectrumDirectory/server/conf/spectrum-container.properties
2. Set the following property to false.

spectrum.security.authentication.token.remoteClientCheck.enabled=false

3. Save and close the properties file.
4. Repeat this process on all the nodes in the cluster.
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Cluster with Separated Configuration Database

Installing a Cluster with a Separated
Configuration Database

This procedure creates two clusters: one for the server nodes and one for configuration database
nodes. The nodes in the server cluster point to the servers in the configuration database cluster for
their configuration data. The nodes in the configuration database cluster replicate their data between
each other.

The following diagram illustrates this installation scenario:
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Load Balancer
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To install a separate database repository, you first install the configuration database on servers in
a cluster, then install the server on nodes in a separate cluster. At least one configuration database
must be running before you can install the server.

Note: In the case of a separated database configuration cluster setup, as shown here, you
can apply load balancing only to the Spectrum server cluster. You cannot apply load balancing
to the separated database cluster.

1. Place the Spectrum Technology Platform installer on the server where you want to install the
configuration database.
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3. Double-click installdb.exe.
4. Follow the prompts to install the configuration database.

Important: When prompted with the option to start Spectrum Technology Platform after the
installation, you must disable this option so that the database does not start automatically when
the installation completes.

5. Edit the file Database/repository/spectrum-container.properties as described in
Cluster Properties for a Configuration Database Cluster on page 75.

6. Save and close spectrum-container.properties.

7. Start the configuration database. To start the configuration database, right-click the Spectrum
Technology Platform icon in the Windows system tray and select Start Spectrum™. Alternatively,
you can use the Windows Services control panel to start the configuration database by starting
the Spectrum Database service.

8. Install the configuration database on additional servers as needed to complete the configuration
database cluster.

9. Install the server cluster.

a) Install Spectrum Technology Platform on a server where you want to host a node. For
instructions, see Installing a New Server on page 32.

Important: When installing each server select the Server only option in the installer and
provide the host and port of one or more of the configuration database servers. You can find
the port in the file
SpectrumDirectory\Database\repository\spectrum-container.properties.
The port is specified in the spectrum.repository.server.connector.bolt.port
property.

b) If the Spectrum Technology Platform server is running, stop it. To stop the server, right-click
the Spectrum Technology Platform icon in the Windows system tray and select Stop
Spectrum™.

c) Editthe propertiesinfile server/conf/spectrum-container.properties, asdescribed
in Cluster Properties on page 52.

d) Save and close the spectrum-container.properties file.

e) Some modules have module-specific settings that you must configure to enable the module
to work in a cluster.
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Module Cluster Configuration Settings

Advanced Matching Module These settings configure clustering for full-text search indexes. If
you do not use full-text search indexes you do not need to configure
these settings.

Open this file in a text editor:
..\server\modules\searchindex\es-container.properties
Configure these properties:

es.index.default_number_of_replicas Enter the number of additional
copies you want created for
each search index. This
number should be the number
of nodes in your cluster minus
1. For example, if your cluster
has five nodes, you would
enter "4" in this property.

es.index.default_number_of_shards Enter the number of shards
you want your index to have in
the distributed environment.
The more nodes that are in
your cluster, the higher this
number should be.

Save and close
es-container.properties
when you are done editing
these properties.

Note: Search indexes created prior Spectrum Technology
Platform 10.0 do not support clustering. To enable
clustering for indexes created prior to the 10.0 release,
you must recreate the search index using the 10.0 API
after modifying the es-container.properties file.
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Module Cluster Configuration Settings

Data Hub Module Open this file in a text editor:
. .\server\modules\hub\hub.properties
Configure these properties:

hub.models.path.base Specifies the folder where models are
stored. By default, each model is
placed in a subdirectory under the
. .\server\modules\hub\db
folder. If you want to store models in
a different location, uncomment this
property and specify the folder where
you want to store models.

hub.neodj.database.type Change the value of this property to
ha. The default value embedded is for
non-clustered installations.

hub.servers.per.cluster Uncomment this line. Set the value of
this property to the number of
Spectrum Technology Platform
servers in the cluster.

Save and close hub.properties when you are done editing
these properties.

The . .\server\modules\hub\db\neo4j.properties
controls how the graph databases are configured, using Neo4;j
Enterprise. This file is used as a template for each model. If
needed, each model can be configured separately by placing a
copy of the neo4j.properties file into the store directory for
that model.

f) Start the server. To start the server, right-click the Spectrum Technology Platform icon in
the Windows task bar and select Start Server.

g) Repeat this procedure to install additional nodes in the server cluster.

10. After installing all the nodes in the server cluster, go back to the first node you installed in the

server cluster and add the other nodes as seed nodes.

a) On the first node you installed, open the properties file
server/conf/spectrum-container.properties.

b) Inthe property spectrum.cluster.seeds, add the host name or IP address of the other
nodes in the cluster, separating each with a comma.

c) Save and close the spectrum-container.properties file. You do not need to restart
the server.
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Cluster Properties for a Configuration Database Cluster

A configuration database cluster is a cluster where each node contains the configuration database
only, and not the server. If you are setting up a cluster where the server and configuration database
are installed together on each node, or are setting up a server-only cluster, see Cluster Properties
on page 52.

The settings for a configuration database cluster are located in this properties file:
Database\repository\spectrum-container.properties

This table describes each property:

Property Description

spectrum.cluster.enabled Indicates whether a clustered configuration is used. Set this
to true.

spectrum.cluster.name If this is the first node in the cluster, set this to any name

you want to give to the configuration database cluster. Be
sure that the name is unique if you have multiple clusters.

If you are adding a node to an existing cluster, set this to
the name of the configuration database cluster that you want
this node to join.

spectrum.cluster.seeds If you are setting up the first node in the cluster, or if this is
the first node you are starting after having stopped the
cluster, specify only the host name or IP address of this
server. This effectively points this node to itself as a seed
node, which is necessary in order for it to be able to start as
the first node in the cluster.

If this is not the first node in the cluster, specify the host
name or IP address of each of the other nodes in the cluster,
including nodes that you have not yet installed. Separate
each seed node with a comma. When starting up, this
property should be set to all nodes in the cluster when
cluster.enabled = true.

Tip: We recommend that you specify multiple seed nodes
so that if one seed node is down others can be used to allow
nodes to join the cluster. We also recommend that you
specify the same seed nodes in the same order on all nodes
in the cluster.
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Property Description

spectrum.cluster.nodelD Set this to an integer value to use as the ID for this node.
The ID must be an integer and must be unique among all
nodes in the database cluster. For example, you could set
the node ID for the first node to 1, the second node's node
ID to 2, and the third node's node ID to 3.

Upgrading a Cluster with a Separated
Database

» Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve issues
with Java.

» Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

Note: If you have customized settings in the wrapper. conf file located in

. <SpectrumDirectory>/server/bin/wrapper, we recommend that you copy this file
to a separate location before you upgrade the Spectrum Technology Platform server. After
you complete the upgrade, compare the contents of wrapper. conf installed during the
upgrade with the contents of the saved copy of the file. You can then manually copy
customizations that you want to retain after the upgrade into the updated version of the file.
This is particularly important for changes to the initial and maximum Java heap sizes.

This procedure describes how to upgrade Spectrum Technology Platform when you have separated
the configuration database from the server. To upgrade an environment that has a separated
configuration database, you first upgrade the configuration database cluster, then the server cluster.

1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

2. Back up module-specific data for any of these modules if you have them installed.

Note: For the Screener module, see the section Upgrading Screener in the Screener
guide.
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Module Iltems to Back Up

Advanced Matching Module, Data Normalization Module, Back up the contents of these subfolders located in
and Universal Name Module SpectrumDirectory/server/modules:

¢ cdgdb

¢ lucene

* matcher

* parser

* searchindex
¢ tables

Data Hub Module Open the Relationship Analysis Client and click Manage.
Select the model you want to back up then click Backup.

In addition to backing up your models, back up these two
property files:

* SpectrumFolder\server\modules\hub\hub.properties
*  SpectrumFolder\server\modules\hub\do\neod]j .properties

Spatial Module Back up your named resources, data, and configuration
files.

3. Stop all the nodes in the server cluster then stop all the nodes in the configuration database
cluster. Make a note of the last node that you stop in the configuration database cluster. You
must start this node first after upgrading. For instructions on stopping a cluster, see Stopping
a Cluster on page 67.

4. Onthe last node that you shut down in the configuration database cluster, run installdb.exe.
The installer upgrades the configuration database.

Warning: The first node that you upgrade must be the last node that was stopped. This is
because on some operating systems the configuration database will start automatically at the
end of the upgrade process. If the first node that starts is not the last node that was stopped,
data such as job history and configuration settings may be lost. If you do not know which node
was stopped last, look in each node's log for the time stamp of the shutdown message. You can
find the log in: SpectrumbDirectory\Database\logs\spectrum-server.logq.

Important: When prompted with the option to start Spectrum Technology Platform after the
installation, you must disable this option so that the database does not start automatically when
the installation completes.

5. After the upgrade is complete, the configuration database starts up automatically. Verify that the
configuration database is fully started before continuing by opening the log file
SpectrumInstallationLocation\Database\logs\spectrum-server.logandlooking
for the message Started.

6. Stop the configuration repository.
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Right-click the Spectrum Technology Platform icon in the Windows system tray and select Stop
Spectrum™. Alternatively, you can use the Windows Services control panel to stop the
configuration database by stopping the Spectrum Database service.

Important: Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

7. Configure the database cluster.

a) Editthefile Database/repository/spectrum-container.properties asdescribed
in Cluster Properties for a Configuration Database Cluster on page 75.

b) Save and close the spectrum-container.properties file.

c) Start the last node that was stopped in the configuration database cluster. To start the
configuration database, right-click the Spectrum Technology Platform icon in the Windows
system tray and select Start Spectrum™. Alternatively, you can use the Windows Services
control panel to start the configuration database by starting the Spectrum Database service.

d) To start the configuration database, right-click the Spectrum Technology Platform icon in
the Windows system tray and select Start Spectrum™. Alternatively, you can use the
Windows Services control panel to start the configuration database by starting the Spectrum
Database service.

e) After the upgraded configuration database is fully started, repeat the previous steps to
upgrade each of the remaining servers in the configuration database cluster and start each
of them.

8. Upgrade each node in the server cluster. For more information, see Upgrading a Cluster on
page 58.

Important: When installing each server select the Server only option in the installer and provide
the host and port of one or more of the configuration database servers. You can find the port in
thefile Spectrumbirectory\Database\repository\spectrum-container.properties.
The port is specified in the spectrum.repository.server.connector.bolt.port
property.

Note: Any job or subflow stored in the system during a server upgrade is marked as exposed
to provide the same behavior for those jobs and subflows as before the upgrade. Any job or
subflow that is exported prior to the upgrade will not be exposed. Therefore, when importing
these jobs or subflows back into the system, you must manually expose the imported job or
subflow.

Some modules have post-upgrade steps you need to perform.
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Data Hub Module Open this file in a text editor:
server/modules/hub/db/neodj.properties and set
this property totrue: doms . allow upgrade=true.
This property protects against unintentional and irreversible
store upgrades. Setting this property to "true" indicates that
you understand the ramifications of proceeding with an
upgrade and have taken the necessary precautions before
proceeding.

Restart the Spectrum Technology Platform server. The
server will upgrade each model. Examine the file
server/logs/spectrum-server. log for errors or
warning messages. Once all models have been upgraded,
edit the neo4j .properties file again and comment out

the dbms.allow upgrade property.

Spatial Module During an upgrade, the pool size is reset to 4 if set to a lower
value. A pool size setting of 4 or more is unaffected. To
change the Remote Component Pool Size value after
upgrading, open the Management Console and select
Resources > Spatial. Change the pool size value and click
Save. For details, see Modifying the Pool Size in the
Spectrum Spatial Guide.

Spectrum Screener ™ See the Upgrading Screener section of the Screener guide
for details.

Related concepts

Moving transactional data - upgrades only on page 6

As of release 2019.1, we are moving transactional audit log and flow history data from Neo4j to
Elasticsearch to improve the maintenance of and access to this data.

Related tasks

Migrating your search indexes on page 7

If you are upgrading to release 2019.1 from release 2018.2, your Elasticsearch search indexes will
migrate to release 2019.1 during the upgrade process.

Related reference

If you have changed default Elasticsearch certificate connection properties on page 8
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Most Spectrum users will run with the default set of connection properties. However, if you did change
any connection properties, you will have to pass into Spectrum the properties file with your unique
settings using the —p command, described in the previous section.

Upgrading a Cluster with a Separated
Database and Data Hub Module

+ Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve issues
with Java.

* Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

Note: If you have customized settings in the wrapper. conf file located in

. <SpectrumDirectory>/server/bin/wrapper, we recommend that you copy this file
to a separate location before you upgrade the Spectrum Technology Platform server. After
you complete the upgrade, compare the contents of wrapper.conf installed during the
upgrade with the contents of the saved copy of the file. You can then manually copy
customizations that you want to retain after the upgrade into the updated version of the file.
This is particularly important for changes to the initial and maximum Java heap sizes.

This procedure describes how to upgrade Spectrum Technology Platform when you have separated
the configuration database from the server and you have the Data Hub Module installed. The upgrade
process consists of these steps:

Stop the server cluster.

Stop the configuration database cluster.

Upgrade the last node that was stopped in the configuration database cluster.
Upgrade the other nodes in the configuration database cluster.

Upgrade the server acting as the Data Hub Module master in the server cluster.
Upgrade the non-master servers in the server cluster.

L o

To upgrade a cluster with a separated configuration database and the Data Hub Module, follow this
procedure:

1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.
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2. Open the Relationship Analysis Client and click Manage. Select the model you want to back up
then click Backup.

In addition to backing up your models, back up these two property files:

* SpectrumFolder\server\modules\hub\hub.properties
* SpectrumFolder\server\modules\hub\db\neo4j.properties

3. Identify which node is the serving as the master server for the Data Hub Module.
a) Open a web browser and go to:

http://LoadBalancer:8080/jmx-console/HttpAdaptor/list

b) Scroll down to the neo4j.org domain.

You will see a set of objects for each model. The Role attribute in the HighAvailability object
indicates whether a server is the master for a model.

c) If you have more than one model and each model has a different master, you need to make
one server the master of all the models. To do this, restart the cluster then open the
Relationship Analysis Client using the hostname or IP address of one of the nodes rather
than the load balancer. In the Relationship Analysis Client, open each model by running a
query on each model. This will make the server you are connected to the master for each
model.

4. Stop all the non-master nodes in the server cluster then stop the master server last. Stop nodes
one at a time rather than all at once.

Important: Make sure that Spectrum Technology Platform stops without errors. If a server does
not stop properly, Data Hub Module models on the server will not open successfully after
upgrading. To ensure that Spectrum Technology Platform stopped cleanly, examine the
SpectrumFolder\server\logs\spectrum-server. log file for errors during shutdown.

5. Stop all the nodes in the configuration database cluster. Make a note of the last node that you
stop in the configuration database cluster. You must start this node first after upgrading.

6. On the /ast node that you shut down in the configuration database cluster, execute
installdb.exe. The installer upgrades the configuration database.

Warning: The first node that you upgrade must be the last node that was stopped. This is
because on some operating systems the configuration database will start automatically at the
end of the upgrade process. If the first node that starts is not the last node that was stopped,
data such as job history and configuration settings may be lost. If you do not know which node
was stopped last, look in each node's log for the time stamp of the shutdown message. You can
find the log in: Spectrum Location\server\logs\spectrum-server.log.

7. After the upgrade process finishes, wait for the server to start, then stop the server.
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You can see when the server has started up by opening the log file
SpectrumDirectory\server\logs\spectrum-server.logandlooking for this message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform Database
(Version version build) Started

Important: Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

8. Configure clustering for the database cluster.

a) Editthefile server/conf/spectrum-container.properties as describedin Cluster
Properties for a Configuration Database Cluster on page 75.

b) Save and close the spectrum-container.properties file.

c) Startthe /ast node that was stopped in the configuration database. To start the configuration
database, right-click the Spectrum Technology Platform icon in the Windows system tray
and select Start Spectrum™. Alternatively, you can use the Windows Services control panel
to start the configuration database by starting the Spectrum Database service.

Warning: The first node that you start must be the last node that was stopped to preserve
the most recent data. Starting another node first may result in loss of data such as job history
and configuration settings. If you do not know which node was stopped last, look in each
node's log for the time stamp of the shutdown message. You can find the log in:
SpectrumDirectory\server\logs\spectrum-server.log.

d) After the upgraded configuration database is fully started, repeat the previous steps to
upgrade each of the remaining servers in the configuration database cluster and start each
of them.

9. Upgrade the Data Hub Module master server in the server cluster.

a) If you are upgrading from Spectrum Technology Platform 11.0 or later, each model directory
must contain a version.data file. Review all the model . Mode 1Name subdirectories
located under SpectrumFolder\server\modules\hub\db to confirm that they contain
aversion.data file. If any model directory is missing this file, copy the corresponding
version.data file from one of the non-master nodes.

b) Important: The installer will prompt you to start Spectrum Technology Platform after the
installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

Run the Spectrum Technology Platform installer to upgrade the master server to the new
version of Spectrum Technology Platform.

c) Open the file SpectrumFolder\server\modules\hub\hub.properties in an editor
and confirm that the following property is set to embedded:

hub.neod4j.database.type=embedded
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d) Openthefile SpectrumFolder\server\modules\hub\db\neo4j.propertiesinan
editor and set the following property to true.

dbms.allow upgrade=true

e) Start the Spectrum Technology Platform server.

f)  Open each model in the Relationship Analysis Client and run a query. Any query is sufficient.

g) Stop the Spectrum Technology Platform server.

h) Indexed properties are now restricted to a maximum length of 4036 bytes. If your model has
an indexed property that exceeds this limitation, proceed to step
#unique_60/unique_60_Connect_42_d65e317.

If your model does not have an indexed property that exceeds this limitation, continue with
substep 9.i on page 83.

i) Openthe SpectrumFolder\server\modules\hub\hub.properties file in an editor
and set the following property to ha:

hub.neo4dj.database.type=ha

i) Compare any properties files that you backed up to the installed files and make any necessary
changes. Do not overwrite new files with old files because new files may contain properties
that old files do not.

k) Skip step #unique_60/unique_60_Connect_42_d65e317 and continue to step
#unique_60/unique_60_Connect_42_d65e417.

10. Upgrade the Data Hub Module non-master servers in the server cluster.

Important: When installing each server select the Server only option in the installer and provide
the host and port of one or more of the configuration database servers. You can find the port in
thefile Spectrumbirectory\Database\repository\spectrum-container.properties.
The port is specified in the spectrum.repository.server.connector.bolt.port
property.

a) Delete the models in the SpectrumFolder\server\modules\hub\db directory.

Warning: Do not delete the models from the master server.

b) Important: The installer will prompt you to start Spectrum Technology Platform after the
installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

On one of the non-master servers, run the Spectrum Technology Platform installer to upgrade
it to the new version of Spectrum Technology Platform.

c) Openthe SpectrumFolder\server\modules\hub\hub.properties file in an editor
and confirm that the following property is set to embedded:

hub.neo4j.database.type=embedded
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d) Compare any properties files that you backed up to the installed files and make any necessary
changes. Do not overwrite new files with old files because new files may contain properties
that old files do not.

e) Copyall SpectrumFolder\server\modules\hub\db\model .ModelName directories
from the master server to the non-master server.

f) Repeat these steps for each non-master server in the cluster.

11. Start the cluster.

a) Start the master server, followed by non-master servers.
b) Ensure that each server in the cluster is functioning. Check
SpectrumFolder\server\logs\spectrum-server.log forany errors.

c) While directly connected to the master server (bypassing the load balancer), open each
model, one at a time, and inspect the spectrum-server.log file for errors.

Converting to a Separated Configuration
Database

Converting an existing Spectrum Technology Platform installation to a separated configuration
database enables you to take advantage of the improved scalability of a separated configuration
database. When you convert to a separated configuration database, your existing installation is
converted from one where the configuration database is part of the server to one where the
configuration database is in a separate cluster.

At a high level, this is the conversion process:

+ Stop your existing Spectrum Technology Platform server.
+ Set up the new configuration database cluster:

* Install the separate configuration database software on a new server.
» Copy your existing configuration database to the new server.
» Configure clustering and start the configuration database cluster.

* Install the server-only cluster and start it up.
Note: This procedure applies both to converting a single server to a separated configuration
database, and converting a cluster to a separated configuration database.

To convert to a separated configuration database:

1. Back up module-specific data for any of these modules if you have them installed.

Note: For the Screener module, see the section Upgrading Screener in the Screener
guide.
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Module Iltems to Back Up

Advanced Matching Module, Data Normalization Module, Back up the contents of these subfolders located in
and Universal Name Module SpectrumDirectory/server/modules:

¢ cdgdb

¢ lucene

* matcher

* parser

* searchindex
¢ tables

Data Hub Module Open the Relationship Analysis Client and click Manage.
Select the model you want to back up then click Backup.

In addition to backing up your models, back up these two
property files:

* SpectrumFolder\server\modules\hub\hub.properties
*  SpectrumFolder\server\modules\hub\do\neod]j .properties

Spatial Module Back up your named resources, data, and configuration
files.

2. If the server you are converting is running Spectrum Technology Platform 11.0 SP1 or earlier,
you must upgrade to the latest version of Spectrum Technology Platform before converting from

a standard installation to a separated configuration database. For more information, see

Upgrading a Server on page 33 (for upgrading a single server) or Upgrading a Cluster on

page 58 (for upgrading a cluster).

3. Stop the server. If you have a clustered installation, stop the cluster.
4. Install the configuration database to a new server.

a) Place the Spectrum Technology Platform installer on the machine where you want to install
the configuration database. This must be a different machine from the one where you have
your existing Spectrum Technology Platform server installed.

b) Double-click installdb.exe.

c) Follow the prompts to install the configuration database.

Important: When prompted with the option to start Spectrum Technology Platform after the
installation, you must disable this option so that the database does not start automatically
when the installation completes.

d) Copy the databases folder from your existing server to the server where you installed the
separate configuration database. Replace the existing folder.

Important:
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* If you are upgrading from 11.1, copy this folder:
. .SpectrumDirectory\Database\server\app\repository\store\databases
folder.

* If you are upgrading from any version higher than 11.1, copy this folder:
. .SpectrumDirectory\Database\repository\data\databases folder.

For more information about path changes, see Path structure and log name changes.

a) Configure the cluster properties for the database cluster by editing the file
Database\repository\spectrum-container.properties as described in Cluster
Properties for a Configuration Database Cluster on page 75.

b) Save and close the spectrum-container.properties file.

c) Startthe configuration database. To start the configuration database, right-click the Spectrum
Technology Platform icon in the Windows system tray and select Start Spectrum™.
Alternatively, you can use the Windows Services control panel to start the configuration
database by starting the Spectrum Database service.

d) Install the configuration database on additional servers as needed to complete the
configuration database cluster.

5. Install the server.

a) (Optional) If you are upgrading to a new version and you want to use the same machine to
host the upgraded server as hosted the existing server, uninstall the existing server of
Spectrum Technology Platform.

b) Install the server cluster. For more information, see Installing a Cluster on page 48.

Important: When installing each server select the Server only option in the installer and
provide the host and port of one or more of the configuration database servers. You can find
the port in the file
SpectrumDirectory\Database\repository\spectrum-container.properties.
The port is specified in the spectrum. repository.server.connector.bolt.port
property.

Converting from a Separated Configuration
Database to a Standard Installation

If you have a cluster that consists of separate clusters for the server and for the configuration database,
you can convert your installation to a standard installation where the server and configuration database
are installed together on the same server.

1. Back up module-specific data for any of these modules if you have them installed.
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Note: For the Screener module, see the section Upgrading Screener in the Screener

guide.
Module Items to Back Up
Advanced Matching Module, Data Normalization Module, Back up the contents of these subfolders located in
and Universal Name Module SpectrumDirectory/server/modules:
* cdgdb
* lucene

* matcher

* parser

* searchindex
¢ tables

Data Hub Module Open the Relationship Analysis Client and click Manage.
Select the model you want to back up then click Backup.

In addition to backing up your models, back up these two
property files:

* SpectrumFolder\server\modules\hub\hub.properties
* SpectrumFolder\server\modules\hub\db\neod] .properties

Spatial Module Back up your named resources, data, and configuration
files.

2. Stop all the nodes in the server cluster, then stop all the nodes in the configuration database
cluster.

3. The configuration database must be of the same version of Spectrum Technology Platform as
the server you are converting to. If the configuration database is from an older version, upgrade
the configuration database to the same version of Spectrum Technology Platform as the version
you want to use for the standard server. The installer upgrades the configuration database.

Warning: The node that you upgrade must be the last node that was stopped. This is so that
data such as job history and configuration settings are not lost. If you do not know which node
was shut down last, look in each node's log for the time stamp of the shutdown message. You
can find the log in: SpectrumDirectory\ server\logs\spectrum-server.log.

4. After the upgrade process finishes, wait for the server to start, then stop the server.

You can see when the server has started up by opening the log file
SpectrumDirectory\Database\logs\spectrum-server.logand looking for the message
Started.
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Important: Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

5. Install a new server.
For instructions, see Installing a New Server

Note: When prompted, be sure to select Standard Installation, not Server only.

6. Stop the server.

7. Copy the databases folder from the last configuration database server you stopped to the new
server, replacing the existing folder.

Important:

* If you are upgrading from 11.1, copy this folder:
. .SpectrumDirectory\Database\server\app\repository\store\databases
folder.

* If you are upgrading from any version higher than 11.1, copy this folder:
. .SpectrumDirectory\Database\repository\data\databases folder.

For more information about path changes, see Path structure and log name changes.

8. Start the server.

Adding Nodes to a Cluster

This procedure describes how to add one or more nodes to an existing cluster.

1. Stop all the Spectrum Technology Platform nodes in the cluster. For more information, see
Stopping a Cluster on page 67. If your cluster has a separated configuration database cluster,
you only need to stop the server cluster, not the configuration database cluster.

Warning: To prevent data loss you must stop the cluster by following the procedure described
in Stopping a Cluster on page 67.

2. On any node in the cluster, install the module or modules you want to add.
3. Open this file in a text editor:

server/conf/spectrum-container.properties

4. Inthe spectrum.cluster.seeds property, remove all host names and IP addresses except
for the one for this server. Save the host names and IP addresses so that you can re-add them
later.
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5. Save the file.
6. Start the server.

Note: Wait for the server to fully start before proceeding.

7. Inthefile spectrum-container.properties, add the host names and IP addresses that
you had removed.

8. Save the file. You do not need to restart the server.

9. Install the modules on each of the other nodes in the cluster. Start each node after installing the
modules on it, and wait for it to fully start before installing the modules on the next node. You do
not need to modify the spectrum.cluster.seeds property when installing modules on
subsequent nodes.
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After you have installed the server you need to install the databases that
support the modules you have installed. Databases provide the information
that Spectrum Technology Platform modules use to process data, such as
postal address data, name data, or geospatial data. For example, if you
have installed the Enterprise Geocoding Module, you will need to install
databases that contain geospatial data; if you have installed the Universal
Addressing Module, you will need to install databases that contain postal
data.

In this section
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Installing a Spectrum Database

Spectrum databases contain reference data from trusted data providers that is used to enhance and
validate your data. For example, to perform address validation, Spectrum Technology Platform uses
official address data from postal authorities to compare your address to addresses of record. Other
types of processing that use Spectrum databases include geocoding, routing, and tax jurisdiction
assignment for a given address.

We update Spectrum databases periodically to provide you with the most up-to-date data from
third-party data providers. Database updates occur independently from software updates, in some
cases quarterly or even monthly. When a database update is available you will receive an email
notification that includes a link to download the updated database. You should install it as soon as
possible so that you are using the most accurate data available.

Spectrum Technology Platform provides CLI commands that help you install, maintain, and archive
SPD files.

* Use the productdata archive register command to configure an alternate (non-default) location
for the Spectrum Platform Data (SPD) archive.

» Use the productdata extract register command to specify an alternate (non-default) extract
location for a set of product data on the server.

The default SPD file archival area is . . /archive/ref-data. Extracted SPD files are located in
../ref-data.

* Use the productdata install command to install your data files.

We recommend using the productdata extract register and productdata archive
register commands to ensure that the SPD data, which may be large, resides in an appropriate
and manageable location of your choosing on the server. The default location inside the Spectrum
folders can make upgrades and re-installations more difficult and require even greater temporary
space.

SPD Setup on a New Spectrum Server

If you are a new customer to the Spectrum Technology Platform or setting up a new Spectrum server,
we recommend setting a location for your Spectrum Product Data (SPD) that is separate from the
Spectrum Technology Platform installation folder.

The Spectrum Technology Platform has Command Line Interface (CLI) commands for setting the
SPD file archive location and for setting the extract location. The archive location establishes the
archive location for the data on the Spectrum server. The extract location establishes the extract
location for the data on the Spectrum server. You only need to run these commands once to set the
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extract and archive locations. Spectrum remembers these locations for future Spectrum Product
Data (SPD) installations.

If you do not use these commands to set the location for your Spectrum Product Data (SPD), then
Spectrum installs the data to default locations: the default SPD file archive area is
../archive/ref-data and extracted SPD files are in . . /ref-data under the spectrum folder
where the Spectrum Technology Platform is installed. Installing to the default location may affect:

» How long it takes to upgrade the Spectrum Technology Platform because everything under the
spectrum folder, including data, is backed up to a ZIP archive file during the upgrade. If there is
not enough space on the server, the upgrade will stop.

» How long it takes to uninstall and reinstall the Spectrum Technology Platform, which would include
the extra step of reinstalling Spectrum Product Data (SPD). Uninstalling the Spectrum Technology
Platformremoves everything under the spectrum installation folder including any data files.

» The space requirements for the Spectrum server machine.
* The length of the folder paths to the data.

Setting Product Data Extraction and Archive Locations

This procedure describes how to set the folder locations that a Spectrum server uses for its Spectrum
Product Data (SPD).

We recommend different locations for the Spectrum install and the Spectrum archive and extract
folders. You must be a Spectrum Technology Platform administrator (admin) to perform this task.

The Spectrum Technology Platform has Command Line Interface (CLI) commands for setting the
SPD file archive location and for setting the extract location. You only need to run the product data
extract, and product data archive commands once to set the extract and archive locations. Spectrum
remembers these locations for future Spectrum Product Data (SPD) installations.

To set the data file archive location and extract locations:

Verify that the Spectrum Technology Platform server is running before you begin.
2. Open a command-line window.
3. Connect to the Spectrum server by typing this command:

connect —--h servername:port —--u username —--p password —--s SSLtrueFalse
For example,

connect --h myserver:8080 --u admin --p myPasswordl --s false

4. Establish the extract location for the data on the server by typing:

productdata extract register --p product --d directory
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For example,

productdata extract register --p platform --d
E:/SpatialFiles/SpectrumbDataStorage

5. Establish the archive location for the data on the server by typing:
productdata archive register --p product --d directory
For example,

productdata archive register --p platform --d E:/SpatialFiles/Archive

You are now ready to install Spectrum Product Data (SPD). For details, see Installing Spectrum
Product Data on page 93

Installing Spectrum Product Data

This procedure describes how to install Spectrum Product Data (SPD) from Pitney Bowes. Spectrum
data is downloaded using the link provided in a Pitney Bowes communication or from the Pitney
Bowes Software and Data Marketplace (SDM).

To add Spectrum Product Data (SPD) to a Spectrum server:

1. Add Spectrum data using product data Command Line Interface (CLI) commands as described
in Adding Data to Spectrum on page 93.

2. Create a database resource using the Management Console as described in Creating a Database
Resource on page 95.

Modules may have additional instructions that are specific to the module and data used by the
module. See Spectrum Databases on page 90 to locate additional module-specific information or
instructions.

Adding Data to Spectrum

You must be a Spectrum Technology Platform administrator (admin) to perform this task. If you are
a new customer to the Spectrum Technology Platform or setting up a new Spectrum server, we
recommend setting a location for your Spectrum Product Data (SPD) that is separate from the
Spectrum Technology Platform installation folder. For details, see SPD Setup on a New Spectrum
Server on page 91 and Setting Product Data Extraction and Archive Locations on page 92.

The Spectrum Technology Platform has Command Line Interface (CLI) commands to install Spectrum
data without having to download the data to the Spectrum server or having to connect your Spectrum
server to the internet. The CLI commands copy data to the Spectrum server.
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After installing the data, we suggest keeping your download files so that those files are available if
you need to reinstall Spectrum data in the future. If you need to remove data from the Spectrum
server, use the Spectrum command line (CLI) commands.

To install Spectrum Product Data (SPD):

1. Verify that the Spectrum Technology Platform server is running before you begin.

2. Download your Spectrum Product Database (SPD) format files from Pitney Bowes using the link
provided in the Pitney Bowes communication or from the Pitney Bowes Software and Data
Marketplace (SDM). If the download is a zip file, extract it to a temporary location.

3. Open a command-line window.
4. Connect to the Spectrum Technology Platform server by typing this command:

connect —--h servername:port —--u username —--p password --s SSLtrueFalse
For example,

connect --h myserver:8080 --u admin --p myPasswordl --s false

5. Optionally list the locations of extracted Spectrum Product Data (SPD) files based on product
name by typing:

productdata extract list

The command output shows the directory where files are located for each product.
6. Install the data to the Spectrum server by typing:

productdata install --f fileOrDirectory —--w waitOrReturn
For example,
productdata install --f E:/SpatialFiles/Geocoding/KNT072019.spd --w

If installing a Spectrum product with multiple . spd files, then use the folder path to the files. The
command installs the data files that are in the folder and subfolders. For example:

productdata install --f E:/SpatialFiles/Geocoding —--w

7. Define a database resource for the data in the Management Console or by using the
Administration Utility database commands. Instructions may vary by module and data, see
Spectrum Databases on page 90 to locate additional module-specific information or instructions.
For general instructions, see Creating a Database Resource on page 95.

For more information about these Product Data CLI commands, see Product Data under Administration
Utility in the Spectrum Technology Platform Administration Guide.
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Creating a Database Resource

You must be a Spectrum Technology Platform administrator (admin) or Spatial administrator
(spatial-admin) to perform this task. If you are a Spatial sub-administrator (spatial-sub-admin), then
you must have permission to the folder that you are editing.

To create a database resource for Spectrum:

1.
2.

8.

Open Management Console.
Go to Resources > Spectrum Databases.

If you do not see the Spectrum Databases menu, then you do not need to define database
resources.

Click the Add button ¥ to create a new database resource.

Enter a name for the database resource in the Name field. The name can be anything you
choose.

In the Module field, select the name of your module.
If you have modules that use Spectrum databases, they display in the Module field.

Note: Modules may have additional fields and settings beyond what the following steps
describe. If this is the case, see Spectrum Databases on page 90 for more details about
the module you have installed.

If applicable, in the Type field, select the type of data.
A list of available databases displays in the table, including description and vintage.

Select one or more entries from the list.

This list should include the data you installed using the productdata install command as
described in Adding Data to Spectrum on page 93.

Click Save to create the database.

A list of the Spectrum databases and status displays. (It may take a moment to refresh the Status
column.)

Deleting Data from Spectrum

Warning: Do not manually delete any files in the Spectrum data archive or extract locations.

To delete data from a Spectrum server, to replace the data with a newer version or to clean the data
from a machine, use the Spectrum command line (CLI) commands.

To remove data from a Spectrum server:

1.

In the Management Console, delete the database resource that is using the data as described
in Deleting a Database Resource on page 96.
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2. Using CLI commands, delete the data from the Spectrum server as described in Deleting Data
from Spectrum on page 96.

Modules may have additional instructions that are specific to the module and data used by the
module. Check the Spectrum Databases on page 90 section for the module you have installed.

Deleting a Database Resource

Warning: Before deleting any resource, verify that jobs or services are not using the resource.
Deleting a resource that is referenced by jobs or services causes those jobs or services to fail.

You must be a Spectrum Technology Platform administrator (admin) or Spatial administrator
(spatial-admin) to perform this task. If you are a Spatial sub-administrator (spatial-sub-admin), then
you must have permission to the folder that you are editing.

To delete a database from Spectrum:

1. Open Management Console.

2. Go to Resources > Spectrum Databases.

3. Put a check mark next to the Spectrum database you want to delete.
4

Click the Delete button ™ .

Deleting a Spectrum database does not delete the actual data files. After deleting the resource, you
must delete the data files from the Spectrum server if you want to free up space on your system. For
instructions, see Deleting Data from Spectrum on page 96.

Deleting Data from Spectrum
You must be a Spectrum Technology Platform administrator (admin) to perform this task.

Before deleting data, verify that it is not being used by a database resource in the Management
Console. For details, see Deleting a Database Resource on page 96.

To delete data from a Spectrum server:
1. Verify that the Spectrum Technology Platform server is running before you begin.
2. Connect to the Spectrum Technology Platform server by typing this command:
connect —--h servername:port —--u username —--p password --s SSLtrueFalse

For example,

connect --h myserver:8080 --u admin --p myPasswordl --s false

3. Runthe productdata 1list command to view the details for the currently installed data. The
results provide current information without having to access the file system. We recommend
using this command before using the productdata delete command to make an informed
decision about the data to delete.
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Open a command-line window and type the following:

productdata list

4. Runthe productdata delete command to delete the data from a Spectrum server by typing:

productdata delete --p productName --c productComponent --q qualifier
--v dataVintage

For example,

productdata delete --p gam --c gav —--g GAV-DEU --v 201907

For more information about these Product Data CLI commands, see Product Data under Administration
Utility in the Spectrum Technology Platform Administration Guide.

Modifying a Spectrum Database Resource

You must be a Spectrum Technology Platform administrator (admin) to perform this task.

A Spectrum database may include multiple data entries: a North American database might include
Canada, United States (USA), and Mexico data; a population survey database might include yearly
updates for a sales region. Managing a database may include adding data to it to increase its

coverage, relevance, or accuracy, or removing data from it to change its coverage or reduce its size.

Every Spectrum database resource has a name, which is used in your dataflows as well as web
service APls. Itis important when modifying a database that the database name remains untouched.

To modify a database by adding or removing data:

1. Open Management Console.

2. Go to Resources > Spectrum Databases.

3. Putacheck mark next to the Spectrum database you want to modify and then click Modify button
)

4. Either add data or remove data from the database.

» To add data, select a data entry. If the data you want to add is not in the list, then you must
add it to the Spectrum server, as described in Adding Data to Spectrum on page 93.

» To remove data, clear the check box beside the data entry.

5. Click Save.

Removing data from a Spectrum database does not delete the actual data files. If you wish to also
delete the files from the Spectrum server to free up space on your system, see Deleting Data from
Spectrum on page 96.
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Installing Advanced Matching Module
Database

The Advanced Matching Module provides a load utility to install databases. The database files that
you install depend on the databases you have licensed.

Note: To install the Advanced Matching Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.

2. Stop Spectrum Technology Platform. To do this, right-click the Spectrum Technology Platform
icon in the Windows task bar and select Stop Server.

3. Insert the database DVD or download the database from the Pithey Bowes eStore.

Note: If you download the database from the web site, it will be downloaded as a zip file.
Unzip the database before proceeding with the installation.

4. Select Start > Programs > Pithey Bowes > Spectrum Technology Platform > Modules >
Universal Name and Advanced Matching Modules > Universal Name and Advanced
Matching Modules Database Load Utility.

5. Follow the prompts during the rest of the installation process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. Openthefile SpectrumbDirectory\server\bin\wrapper\wrapper.conf in a text editor.

7. Increase the Java settings for initial heap size (wrapper.java.initmemory)and maximum
heap size (wrapper. java.maxmemory) to reflect the total amount of memory required for the
Arabic Plus Pack and Asian Plus Pack.

* Arabic Plus Pack: 5.5 GB

* Asian Plus Pack - Chinese: 32 MB

* Asian Plus Pack - Japanese: 1.6 GB
* Asian Plus Pack - Korean: 8 MB

» Core Names: 1.1 GB

8. Save and close wrapper.conf.

9. Start Spectrum Technology Platform. To do this, right-click the Spectrum Technology Platform
icon in the Windows task bar and select Start Server.
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Installing Data Normalization Module
Databases

The Data Normalization Module provides a load utility to install databases for the Advanced
Transformer, Open Parser, and Table Lookup components. The database files that you install depend
on the databases you have licensed. Use this list of database tables to determine which files you
should download and install. For more information about tables contained in each database, refer
to the reference documentation for each component.

Stage Available Databases

Advanced Transformer Data Normalization Module - Base Tables

Open Parser o
» Data Normalization Module - Base Tables

» Core Names Database

» Company Names Database
* Arabic Plus Pack

* Asian Plus Pack

Table Look
able Lookup » Data Normalization Module - Base Tables

» Core Names Database

* Arabic Plus Pack

* Asian Plus Pack

+ ZREPLACE (Used by the SAP Module for French address
validation)

Note: To install the Data Normalization Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.

2. Stop Spectrum Technology Platform. To do this, right-click the Spectrum Technology Platform
icon in the Windows task bar and select Stop Server.

3. Insert the database DVD or download the database from the Pitney Bowes eStore. You received
a download link with your product release announcement.

Note: If you download the database from the web site, it will be downloaded as a zip file.
Unzip the database before proceeding with the installation.
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4. Select Start > Programs > Pithey Bowes > Spectrum Technology Platform > Modules >
Data Normalization Module > Data Normalization Module Database Load Utility.

5. Follow the prompts during the rest of the installation process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. Start Spectrum Technology Platform. To do this, right-click the Spectrum Technology Platform
icon in the Windows task bar and select Start Server.

Installing Geocoding Databases (SPD format)

Review the following items.

» Spectrum Server is running and the Administration Utility (CLI Command tool) is available to you.
If you haven't used the tool before, see Getting Started with the Administration Utility.

» Java 8 is installed.
* (Optional) If needed, run the following command to identify the directory where Spectrum will store
the extracted files.

productdata extract list

* (Optional) If you need to know more about existing Spectrum Product Data (SPD) files, run the
following command. The results will display PRODUCT, COMPONENT, QUALIFIER, VINTAGE,
EXPIRATION, DESCRIPTION, and IDENTIFIER information.

productdata list

Geocoding databases contain the data necessary to perform geocoding and reverse geocoding for
locations. Each country has its own database, and some countries have optional databases that
provide enhanced geocoding.

These databases are for use in the Global Geocoding or Enterprise Geocoding modules.

Note: Do notinstall geocoding datasets on a network drive. Doing so can cause performance
problems.

1. Select and download your licensed SPD files (xxx.spd) from Pitney Bowes using the link provided
in the Pitney Bowes communication or from the Pitney Bowes Software and Data Marketplace.

2. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

3. Install the SPD files:
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a) Place the SPDfilesin SpectrumDirectory/server/import. Thisisthe default location
for SPD files. The Spectrum™ Technology Platform server monitors this folder and looks for
new files in two-second intervals.

You can change the location of the data import directory by altering the spectrum.import.dir
property in the
SpectrumDirectory/server/conf/spectrum-container.properties file.

b) When the server detects new SPD files, the server automatically extracts the SPD files to
SpectrumDirectory/server/ref-data.

You can change the location of the data storage folder by altering the
spectrum.data.manager.storage.dir property in the Data Manager settings section of the
SpectrumDirectory/server/conf/spectrum-container.properties file.

4. Atthis point the data will become available and you can add it as a Spectrum™ database resource
in the Spectrum™ Databases section of Management Console.

5. After you install the database files, use either the Database Resource tool in the Management
Console or the Administration Utility database commands to define the database as a resource.

6. After the SPD files are extracted and are no longer needed, use the CLI commands to delete
the SPD files. Do not manually delete the SPD files from the location where the server extracted
the SPD files. Instead, use these CLI commands to delete the SPD files. For more information
about the Product Data CLI commands, see Administration Utility in your Spectrum™ Technology
Platform Administration Guide.

a) Runthe productdata list command to view the details for the currently installed SPD
files. The results provide current information without having to access the file system. We
suggest that you run this command before you run the productdata delete command,
to make an informed decision about the data to delete.

b) Runthe productdata delete command to delete the SPD files from the Spectrum™
Technology Platform.

Example

productdata delete --p productName --c productComponent --q qualifier --v dataVintage

spectrum> productdata delete --p gam --c gav --g GAV-DEU --v 201907

AUS G-NAF

If you installed the Australia Geocoded National Address File (G-NAF), you must specify the GNAF123
and GNAF456 as separate paths but in the same database resource in Management Console.

GNAF123 contains the point-level dictionary. This has the highest precision of geocoding (characterized
by Reliability Level 1, 2, or 3.) GNAF456 contains the remainder of address information in G-NAF
that does not meet high precision geocoding criteria (characterized by Reliability Level 4, 5, or 6.)
We recommend that you use both databases to validate the existence of addresses but only use
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GNAF123 for parcel-level geocoding. If you do not require parcel-level geocodes you can use GNAF456
for geocoding.

U.S. Geocoding Databases

The U.S. geocoding databases contain the spatial data necessary to perform address standardization
and geocoding. You must install at least one of these databases.

» Centrus Enhanced Geocoding—This database consists of TIGER data provided by the U.S.
Geological Survey and address data provided by the U.S. Postal Service.

« TomTom Geocoding—This database provides more up-to-date data than the Centrus Enhanced
Geocoding database. It requires an additional license. The data is provided by TomTom, a third-party
provider of spatial data, and postal data from the U.S. Postal Service.

*+ HERE Geocoding—This database provides more up-to-date data than the Centrus Enhanced
Geocoding database. It requires an additional license. HERE data is provided by HERE, a third-party
provider of spatial data. For more information about these databases, contact your sales
representative.

» ZIP + 4 Centroid—This database provides only address standardization and ZIP + 4 centroid
matching. It does not provide street-level matching.

These databases use proprietary files called SPD files. For ZIP Code centroid matching, the file
us.Z9 contains all the centroid info for all states and normally has a z9 extension.

Each geocoding database has an optional Statewide Intersections Index. The Statewide Intersection
Index is designed to enable fast intersection identification on a statewide basis. For example, the
Statewide Intersection Index will allow the database to search for "1st and Main St, CO" and return
a list of possible matches in Colorado more quickly than searching the entire geocoding database
for each instance of the intersection.

1. Download your licensed SPD files (xxx.spd) using the link provided in the Pitney Bowes
communication or from the Pitney Bowes Software and Data Marketplace (SDM).

2. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

3. Toinstall, see Installing Geocoding Databases (SPD format) on page 100.

Points Databases (U.S. Only)

Points databases contain data for locating the center of a land parcel. These databases provides
enhanced geocoding accuracy for internet mapping, property and casualty insurance,
telecommunications, utilities, and others. To install, see Installing Geocoding Databases (SPD
format) on page 100.
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» Master Location Data —This database provides the best available address point location for every
mailable and deliverable address in the United States.

» Centrus Points—This database contains the data necessary to locate the center of a parcel or
building. It does not contain assessor's parcel number (APN) or elevation data.

» Centrus Elevation—This database contains the same data as Centrus Points, plus elevation data.

» Centrus Enhanced Points—This database contains the same data as Centrus Points, plus APN
data.

» Centrus Premium Points—This database contains the same data as Centrus Points, plus both
APN and elevation data.

+ TomTom Points Database—The data in this database is provided by TomTom, a third-party
provider of spatial data.

+ HERE Points—This database is provided by HERE, a third-party data provider. It contains data
used to locate addresses at the center of the actual building footprint or parcel.

Early Warning System (U.S. Only)

The USPS provides free Early Warning System (EWS) data to prevent matching errors due to the
age of the address information in the .gsd files. The USPS creates a new EWS data set each week
that you can download from the USPS website (https://postalpro.usps.com/cass/EWS).

To install the Early Warning System (EWS) database, rename the database file from OUT to EWS.txt
and place it in the same folder as the primary database.

Installing Enterprise Tax Module Databases

Depending on the features you have licensed, you need to install one or more of these databases.
Database Compatibility

The Enterprise Tax Module version 9.0 SP2 and later uses a different data format than previous
releases. You must download and install the GeoTAX/Enterprise Tax Premium database for use
in this version. The GeoTAX/Enterprise Tax Premium database is not compatible with any releases
prior to version 9.0 SP2.
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Downloading Database Files

Note: Prior to downloading the data files: If you have previously installed database files,
you should back up those files and delete any copies of the .gdi, .gsd, gsi, .gsl,
.gsu, .gsz, .gsx, .z9, .dir, .las and .los files inthe data install directory.

Downloading from the eStore

Use the link in your welcome email to download the zip file. Extract the files and make note of the
directory where you save the files.

Downloading from the Technical Support Web Site

Download the database from the the Pitney Bowes eStore. You received a download link with your
product release announcement or Welcome letter. The data file will be downloaded as a .zip file.
Extract the files and make note of the directory where you save the files.

Downloading Florida Format Files

You can obtain the Florida format files from the Florida Department of Revenue. The Florida
Department of Revenue compiles the database based on county.

1. Download the files from the Florida website at:
https://pointmatch.state.fl.us/General/AddressFiles.aspx/.
2. Unzip the downloaded files and transfer them to the server.

Note: Be sure to FTP your files in binary format.

3. Combine the county files into a single file if you downloaded more than one county. If you
downloaded the entire state list, you have approximately 67 files. You must combine all the files
into one file.

Your file is ready for loading.

Downloading TS-158 Format Files

The Federation of Tax Administrators (FTA) maintains a website with links to all data sources that
use the TS-158 format.

1. Download the files from the Florida website at:
https://pointmatch.state.fl.us/General/AddressFiles.aspx.

2. Unzip the downloaded files and transfer them to the Spectrum Technology Platform server.
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3. State files are often broken up into individual county files. Combine all state and/or county files
into a single file.
Your file is ready for loading.

Database Options

The following describes the database options presented in the Windows Database Load Ulility.

GeoTAX master files

The GeoTAX/Enterprise Tax Premium Database is a required dataset and is the
master file for the Enterprise Tax Module software. The master files identify all
geographic components associated with a street address, such as the
latitude/longitude, census tract, and block group.

Point Data files

Point Data products include Master Location Data (MLD), Centrus Points, HERE
Points, and TomTom Points. The point data provides point-level geocoding for the
most accurate placement of addresses throughout the U.S. The Master Location Data
database provides the best available address point location for every mailable and
deliverable address in the United States.

User auxiliary file

This is a user-defined file that the Enterprise Tax Module uses to override results from
the master files in street-level matching. If you have data that is more current than
that in the master files, you can enter the new data into the auxiliary file and use it for
your address matching. The Enterprise Tax Module returns matches made with a
code that signifies the answer came from the auxiliary file. You can also return
user-defined data from the auxiliary file with the match. The install program creates
the file G1GTAUX in the specified destination.

GeoTAX auxiliary file

This file contains new addresses that have not yet been added to the master files. It
provides the most up-to-date address data possible. The install program creates the
indexed sequential file GIGTAX2 in the specified destination.

Landmark auxiliary file

This is a user-defined file that allows you to specify customized address information
in your input records. The recommended primary use of this file to match to your
company’s non-address locations such as well heads, transmission towers or any
other descriptive location. The latitude/longitude that is part of the input needed to
build this file allows companies to automatically keep track of any jurisdictional changes
that affect these unique locations. Matching to this file requires that the input record
information match exactly to the Landmark file contents. This also applies to street
records if you choose to enter them in the Landmark file. For more information, refer
to the Enterprise Tax Module Guide.

State-supplied Florida format file
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This is a state-supplied file in Florida-native format which is provided by individual
state governments. The Enterprise Tax Module first attempts to match to the state
database. If the Enterprise Tax Module cannot find a state match, it attempts a match
to the GeoTAX Auxiliary file, if loaded, then to the master files.

State-supplied TS-158 format file

This is a state-supplied file in TS-158 (ANSI Transaction Set No. 158) format which
is provided by individual state governments. The Enterprise Tax Module first attempts
to match to the state database. If the Enterprise Tax Module cannot find a state match,
it attempts a match to the GeoTAX Auxiliary file, if loaded, then to the master files.

Boundary file
Boundary files provide additional data about locations of special tax districts:

» Special Purpose Tax Districts (spd.txb)

* Insurance Premium Tax Districts (ipd.txb)
 Payroll Tax Districts (pay.txb)

» User-defined Boundary file (usr.txb)

PB Software tax rate file

The Pitney Bowes Sales and Use Tax Rate file allows you to use the Enterprise Tax
Module to provide sales and use tax rates for each of the assigned tax jurisdictions
as well as the total rate for the assigned locations. The install program creates the
indexed sequential file GTTAXRT.

Payroll tax correspondence file

Payroll tax cross-reference file allow you to use third-party software to determine the
payroll tax rates. The cross-reference files combine the U.S. Government Federal
Information Processing Standards (FIPS) codes with the proprietary geocodes used
by tax software from third parties. The Payroll System Tax Code file is a customized
file that you build to return the payroll tax codes used by your payroll system. The
install program produces database files called G1GTPTC and G1GTPTC.vix.

Sovos cross reference file

This sales tax cross-reference file enables you to use the Enterprise Tax Module to
determine tax jurisdictions for a given address, then use Sovos software to determine
the sales tax rates for those jurisdictions.

PB Software Vertex® cross reference file

This is a Vertex® cross-reference file supplied by Precisely. The install program
produces a database file GTMSTR2 in the specified destination.

Installing the Database Files

1. Select Start > Programs > Pithey Bowes > Spectrum Technology Platform > Modules >
Enterprise Tax Module > Database Load Utility.
The Database Load Utility window launches.
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2. Select the database you want to install.

Note: For Point Data, select the GeoTAX master files option.

3. Follow the instructions provided by the wizard.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. In Management Console, open the Enterprise Tax Module database resource tool and define a
database resource that includes the database you just installed. Be sure to update Assign
GeoTAX Info and Reverse GeoTAX Info Lookup to use the new database resource.

Installing GeoEnrichment Module Databases

GeoEnrichment Module database resources are used by GeoEnrichmentLookup. Given a lookup
key as input, the GeoEnrichmentLookup stage accesses a registered database and returns additional
attribute data for the referenced address.

To install Spectrum Product Data (SPD) data from Pitney Bowes for use with GeoEnrichmentLookup,
you must:

1. Download the SPD format files that you purchased from Pitney Bowes using the link provided
in the Pithey Bowes communication or from the Pitney Bowes Software and Data Marketplace.

2. Use Command Line Interface (CLI) commands to install the Spectrum Product Data to a Spectrum
database. This copies the data to the Spectrum database and makes the Spectrum Technology
Platform aware of the data in the database. For details, see Adding Data to Spectrum on page
93.

3. In Management Console, create a new database resource for the Spectrum Product Data, or
change an existing database resource to include the Spectrum Product Data. For details, see
Adding a GeoEnrichment Module Database Resource in the GeoEnrichment Guide.

If you are installing Spectrum Product Data for the first time, because you are a new customer to the
Spectrum Technology Platform or setting up a new Spectrum server, then we recommend you set
the data extract and archive locations before installing Spectrum Product Data. For details, see SPD
Setup on a New Spectrum Server on page 91. We recommend using the productdata extract
register and productdata archive register commands to ensure that the Spectrum
Product Data, which may be large, resides in an appropriate and manageable location of your
choosing on the server. The default location inside the Spectrum folders can make upgrades and
re-installations more difficult and require even greater temporary space.
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Installing Global Addressing Module Databases

Global Addressing Module Databases

Global Addressing Module databases are distributed in the Spectrum™ Product Database (SPD)
format from the Pitney Bowes Software and Data Marketplace.

Disk Space
The disk space requirements for extracted and non-extracted SPD bundles are:

+ Extracted bundles (all SPD) - 100 GB
* Non-extracted bundles (all SPD) - 32 GB

Memory

A typical Global Address Validation (GAV) country database can take 700 MB of memory when
loaded but can take as much as 3000 MB. A typical Global Type Ahead (GTA) database also takes
about 700 MB of memory when loaded but rarely exceeds that value.

To download and install a Global Addressing Module database resource in the Spectrum™ Product
Database (SPD) format, see Installing Global Addressing Module SPD Files on page 108.

Installing Global Addressing Module SPD Files

You must be a Spectrum Technology Platform administrator (admin) to perform this task. Before
deleting data, verify that the data is not being used by a database resource in the Management
Console.

To download and install a Global Addressing Module database resource in the Spectrum™ Product
Database (SPD) format:

1. Select and download your licensed SPD format files (xxx.spd) from Pitney Bowes using the link
provided in the Pitney Bowes communication or from the Pitney Bowes Software and Data
Marketplace (SDM). If the download is a zip file, extract it to a temporary location.

2. Verify that the Spectrum Technology Platform server is running before you continue.
3. Open a Spectrum™ command line window.
4. Connect to the Spectrum Technology Platform server by typing this command:

connect --h servername:port —--u username —--p password —--s TrueOrFalse
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If your Spectrum™ server requires a secure connection, set --s True. The default is False.

For example,

connect --h myserver:8080 --u admin --p myPasswordl --s False

5. Install the data to the Spectrum™ server by typing:
productdata install --f fileOrDirectory —--w TrueOrFalse
To wait for the installation to complete, set --w True. To allow the installation to proceed in the
background, set --w False. The default is False.
For example,
productdata install --f E:/GAM/GAE092019.spd --w False
If installing a Spectrum™ product with multiple . spd files, then use the folder path to the files.
The command installs the data files that are in the folder and subfolders.

For example,

productdata install --f E:/GAM/GAV --w False

6. After you install the SPD files, see either Using Management Console to Create a Database
Resource on page 110 or Using CLI Commands to Create a Database Resource on page 112
to define the database as a resource.

For more information about the Product Data specific CLI commands, see Product Data under
Administration Utility in the Spectrum Technology Platform Administration Guide.

Deleting Global Addressing Module SPD Files

You must be a Spectrum Technology Platform administrator (admin) to perform this task. Before
deleting data, verify that the data is not being used by a database resource in the Management
Console.

Do not manually delete the SPD files from the location where the server extracted the SPD files.
Instead, use these CLI commands to delete the SPD files. For more information about the Product
Data CLI commands, see "Administration Utility" in your Spectrum™ Technology Platform
Administration Guide.

1. Verify that the Spectrum Technology Platform server is running before you begin.

2. Connect to the Spectrum Technology Platform server by typing this command:

connect --h servername:port —--u username —--p password --s TrueOrFalse
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If your Spectrum™ server requires a secure connection, set --s True. The default is False.

For example,

connect --h myserver:8080 --u admin --p myPasswordl --s False

Run the productdata 1ist command to view the details for the currently installed SPD files.
The results provide current information without having to access the file system. We recommend
using this command before using the productdata delete command to make an informed
decision about the data to delete.

Open a Spectrum CLI window and type the following:

productdata list

Run the productdata delete command to delete the SPD files from the Spectrum™
Technology Platform:

productdata delete --p productName --c Component —--q Qualifier —-v
Vintage

For example,

productdata delete --p GAM --c GAV --g GAV DEU --v SEP2019

Creating a Global Addressing Module Database Resource

After you install new Spectrum™ Product Database (SPD) format files, use either Using Management
Console to Create a Database Resource on page 110 or Using CLI Commands to Create a
Database Resource on page 112 to define the newly installed database as a Global Addressing
Module database resource.

Using Management Console to Create a Database Resource

To create a Global Addressing Module database resource in Management Console from a newly
installed SPD file:

1.
2.

Open Management Console.
Go to Resources > Spectrum Databases.

If you do not see the Spectrum Databases menu, then you do not need to define database
resources.

You can use the buttons at the top left to manage your databases.

To create a new database, click Add + .
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To create a new database by copying an existing database, click Copy .

4. Enter a name for the database resource in the Name field. The name can be anything you
choose. If you are creating a new database resource by copying an existing database resource,
rename as needed. You cannot modify the name of an existing database resource.

5. Inthe Pool size field, specify the maximum number of concurrent requests you want this database
to handle.

The optimal pool size varies by module. You will generally see the best results by setting the
pool size between one-half to twice the number of CPUs on the server, with the optimal pool
size for most modules being the same as the number of CPUs. For example, if your server has
four CPUs you may want to experiment with a pool size between 2 (one-half the number of
CPUs) and 8 (twice the number of CPUs) with the optimal size possibly being 4 (the number of
CPUs).

When modifying the pool size you must also consider the number of runtime instances specified
in the dataflow for the stages accessing the database. Consider for example a dataflow that has
a Global Address Validation stage that is configured to use one runtime instance. If you set the
pool size for the Global Address Validation database to four, you will not see a performance
improvement because there would be only one runtime instance and therefore there would only
be one request at a time to the database. However, if you were to increase the number of runtime
instances of the Global Address Validation stage to four, you might then see an improvement in
performance since there would be four instances of the Global Address Validation stage accessing
the database simultaneously, therefore using the full pool. For more information about setting
runtime instances, see the Spectrum™ Technology Administration Guide.

Tip: You should conduct performance tests with various settings to identify the optimal pool
size and runtime instance settings for your environment.

6. In the Module field, select Global Address Validation Coder.
7. In the Type field, select the type of data.

a) Select the Global Addressing database for international address processing.
b) Select the US Addressing database for United States (USA) address processing.

8. To select all Global Addressing databases and all countries within those databases, click Include
at the top of the list of available databases. To select only specific individual databases and all
countries within those individual databases, click Include next to the individual databases.

Tip: To see the countries included in an individual database, click the arrow to the left of a
database. You can also click Include at this level to include only specific countries in an individual
database.

Note: We recommend grouping countries into regional Database Resources. For example,
group the APAC countries into one Database Resource and the EMEA countries into
another Database Resource. Attempting to add all countries for the Global Addressing
Validation stage and the Global Type Ahead stage into just one Database Resource may
cause the Database Resource creation process to time out and fail to create the Database
Resource.
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9. Click Save to add and save the database resource. The Spectrum™ Databases page displays
the added database resource.

Using CLI Commands to Create a Database Resource

To create and configure a Global Addressing Module database resource from a newly installed SPD
file, use the gamdb create command.

For detailed descriptions of all Global Addressing Module CLI command options, type:
help gamdb

For a detailed descriptions of the available options for a specific Global Addressing Module CLI
command, type "Help" and the command name.

For example,

help gamdb create

gamdb create

The gamdb create command creates and configures Global Addressing Module databases.

Usage
gamdb create --n Name --d Dataset Name --v Dataset Vintage —-c Country —-t Type --g
Group —-p Poolsize--mn minimum_memory_size --mx maximum_memory_size

Required Argument Description
Yes --n Name Specifies the name of the database resource to create.
Yes -—d Dataset Name Specifies the name of the SPD dataset.
Yes --v Dataset Specifies the vintage of the dataset.
Vintage
No --c Country Specifies the three-digit ISO code for each country to include in the

databases specified by the "t" option (type of SPD) where Countries
is a list of three-digit ISO codes separated by semicolons. For more
information about ISO codes, see your Spectrum™ Technology
Platform Addressing Guide.

Yes --t Type Specifies the type of dataset.
GAV Global Address Validation dataset.
GTA Global Type Ahead dataset.
Yes --g Group Specifies the coder for Global Address Validation.
Global Global Address Validation International coder.
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Required Argument Description
us Global Address Validation US coder.

No --p Poolsize Specifies the maximum number of concurrent requests you want this
database to handle. The default is 4.

No —--mn Or Defines the minimum amount of memory allocated for this database.
--minMem This value must be less than or equal to the --mx setting.
minimum_memory size

No --mx Of Defines the maximum amount of memory allocated for this database.
--maxMem This value must be greater than zero, but cannot exceed 65536 MB.

maximum _memoly sze

Example

This example creates a Global Addressing Validation database for Germany named
"GAV_DEU" using the database resource "GAV_EMEA" with a December 2018
vintage and the International coder. This example configures the GAV_DEU
database with a pool size of 5, and memory allocation between 12200 and 65536
MB.

gamdb create --n GAV DEU --d GAV _EMEA --v DEC2018 --c DEU --t
GAV --g Global --p 5 -—mn 12200 --mx 65536

Example

This example creates a Global Type Ahead database for Austria named "GTA_AUT
using the database resource "GTA_EMEA" with a December 2018 vintage. This
example configures the GTA_AUT database with a pool size of 6, , and memory
allocation between 12200 and 65536 MB.

gamdb create --n GTA AUT --d GTA EMEA --v DEC2018 --c AUT --t
GTA --p 6 ——mn 12200 --mx 65536

Modifying a Global Addressing Module Database Resource

You can use either the Database Resource tool in the Management Console or the Global Addressing
Module CLI commands to modify a Global Addressing Module database resource. For more
information about modifying a Global Addressing Module database resource, see either Using
Management Console to Modify a Database Resource on page 114 or Using CLI Commands to
Modify a Database Resource on page 114.
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Using Management Console to Modify a Database Resource
To modify a Global Addressing Module database resource:
1. Open Management Console.

2. Goto Resources > Spectrum Databases.

3. To modify an existing database, select the database and then click Edit .

4. Make your required changes. For more information on database resource fields, see Using
Management Console to Create a Database Resource on page 110.

5. Click Save to save your changes to the selected database resource. The Spectrum™ Databases
page displays the modified database resource.

Using CLI Commands to Modify a Database Resource
To modify a Global Addressing Module database resource, use the gamdb modify command.

For detailed descriptions of all Global Addressing Module CLI command options, type:

help gamdb

For a detailed descriptions of the available options for a specific Global Addressing Module CLI
command, type "Help" and the command name.

For example,

help gamdb modify

gamdb modify

The gamdb modify command modifies and updates Global Addressing Module databases.

Usage
gamdb modify --n Name --d Dataset Name --v Dataset Vintage --c Country --t Type —--g
Group --p Poolsize

Required Argument Description
Yes --n Name Specifies the name of the database resource to modify.
Yes --d Dataset Name Specifies the name of the SPD dataset.
Yes --v Dataset Specifies the vintage of the dataset.
Vintage
No --c Country Specifies the three-digit ISO code for each country to include in the

databases specified by the "t" option (type of SPD) where Countries
is a list of three-digit ISO codes separated by semicolons. For more
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Required Argument Description

information about ISO codes, see your Spectrum " lechnology
Platform Addressing Guide.

Yes --t Type Specifies the type of dataset.
GAV Global Address Validation database.
GTA Global Type Ahead database.
Yes --g Group Specifies the coder for Global Address Validation.
Global Global Address Validation International coder.
uUs Global Address Validation US coder.
No -—p Poolsize Specifies the maximum number of concurrent requests you want this

database to handle. The default is 4.

Example

This example modifies the poolsize of the Global Addressing Validation database
for Germany named "GAV_DEU". This example specifies the Global Address
Validation International coder.

gamdb modify --n GAV DEU --d GAV EMEA --v DEC2018 --c DEU --t
GAV --g Global --p 6

Example

This example modifies the poolsize of the Global Type Ahead database for Austria
named "GTA_AUT".

gamdb modify --n GTA AUT --d GTA EMEA --v DEC2018 --c AUT --t
GTA --p 3

Deleting a Global Addressing Module Database Resource

You can use either the Database Resource tool in the Management Console or the Global Addressing
Module CLI commands to delete a Global Addressing Module database resource. For more information
about modifying a Global Addressing Module database resource, see either Using Management
Console to Delete a Database Resource on page 115 or Using CLI Commands to Delete a
Database Resource on page 116.

Using Management Console to Delete a Database Resource

To delete a Global Addressing Module database resource:
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Open Management Console.
Go to Resources > Spectrum Databases.

To delete a database, select the database and then click Delete [}

You will be asked to confirm that you want to delete the selected database resource. To confirm
and delete the database resource, click Yes.

5. The database resource is deleted and no longer displays on the Spectrum™ Databases page.

P w N~

Using CLI Commandss to Delete a Database Resource
To delete a Global Addressing Module database resource, use the gamdb delete command.

For detailed descriptions of all Global Addressing Module CLI command options, type:
help gamdb

For a detailed descriptions of the available options for a specific Global Addressing Module CLI
command, type "Help" and the command name.

For example,

help gamdb delete

gamdb delete

The gamdb delete command deletes a Global Addressing Module database.

Usage

gamdb delete —-n Name --g Group

Required Argument Description

Yes --n Name Specifies the name of the database.

Yes --g Group Specifies the coder for Global Address Validation.
Global Global Address Validation International coder.
us Global Address Validation US coder.

Example

This example deletes a Global Address Validation database for Germany named
"GAV_DEU". This example specifies the Global Address Validation International
coder.

gamdb delete --n GAV DEU --g Global
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Example

This example deletes a Global Type Ahead database for Austria named "GTA_AUT".

gamdb delete --n GTA AUT

Installing Global Sentry Module Database

These databases are required to run Global Sentry in real-time mode:

« ofac.db
* pep.db
 sanctions.db

These files are required to run Global Sentry in batch mode:

» globalsentrydb.addresses-ofac.csv

* globalsentrydb.fullNames-ofac.csv

* globalsentrydb.ids-ofac.csv

* globalsentrydb.names-ofac.csv

* globalsentrydb.addresses-pep.csv

+ globalsentrydb.fullNames-pep.csv

* globalsentrydb.ids-pep.csv

* globalsentrydb.names-pep.csv

+ globalsentrydb.addresses-sanctions.csv
+ globalsentrydb.fullNames-sanctions.csv
* globalsentrydb.ids-sanctions.csv

* globalsentrydb.names-sanctions.csv

In addition, you must install the Data Normalization Module and Advanced Matching Module
databases to use Global Sentry. For instructions, see Installing Data Normalization Module
Databases on page 99 and Installing Advanced Matching Module Database on page 98.

Ensure the Global Sentry Database Server is in up and running. In case it is not, use the option in
the utility to start it before you begin data loading.

Note: You need to perform data loading after every upgrade of Spectrum Technology Platform.

1. Stop the Spectrum Technology Platform server.
2. Insert the database DVD or download the database from the technical support web site.

Note: If you download the database from the Precisely web site, it will be downloaded
as a zip file. Unzip the database before proceeding with the installation.
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3. Select Start > Programs > Pithey Bowes > Spectrum Technology Platform > Modules >
Global Sentry Module > Global Sentry Module Database Load Utility.

4. Follow the prompts during the rest of the installation process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. Start Spectrum Technology Platform. To do this, right-click the Spectrum Technology Platform
icon in the Windows task bar and select Start Server.

6. After installing the Global Sentry Module database, you must configure a JDBC connection in
the Spectrum Technology Platform Management Console. Go to Start > Settings > Control
Panel > Administrative Tools > Services to verify that the Global Sentry Database is running.

7. Login to the Management Console and configure the driver and connection properties using
these steps:

a) Inaweb browser go to this URL:
http://server.portimanagementconsole

Where serveris the server name or IP address of your Spectrum Technology Platform server
and port is the HTTP port used by Spectrum Technology Platform. By default, the HTTP
port is 8080 and the HTTPS port is 8443.

b) Enter your user name and password to access the Home page of the Management Console.
c) On the Main Menu, click Systems > Drivers to open the Drivers page

d) Click Add

e) Type these JDBC properties in the applicable text boxes:

» JDBC driver configuration name: HSQLDB
» JDBC driver class name: org.hsqldb.jdbcDriver
« Connection string template: jdbc:hsqldb:hsql://${host}:${port}/${instance}

f)  Add this driver file:
SpectrumDirectory/GlobalSentryDatabase/lib/hsgldb. jar

g) To define connection properties, go to Resources > Data Sources.
h) Click Add, and define these connection properties:

» Connection name: Global Sentry
» Database driver: select the HSQLDB JDBC driver that you created in the previous steps.

i) Enter these values in the Connection Properties dialog box:

* host: localhost or <your server name>
* port: 9001
* instance: globalsentrydb

i) Click Test to verify the connection works.
k) Click OK, then click Save
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Installing Routing Databases

Spatial Module routing database resources are used by Find Nearest, Get Travel Boundary, Get
Travel Cost Matrix, Get Travel Directions, Get Route Data, and Persistent Update.

To install routing Spectrum Product Data (SPD) data from Pitney Bowes, you must:

1. Download the routing SPD format files that you purchased from Pitney Bowes using the link
provided in the Pitney Bowes communication or from the Pitney Bowes Software and Data
Marketplace.

2. Use Command Line Interface (CLI) commands to install the routing Spectrum Product Data to
a Spectrum database. This copies the data to the Spectrum database and makes the Spectrum
Technology Platform aware of the data in the database. For details, see Adding Routing Data
to Spectrum on page 119.

3. In Management Console, create a new database resource for the routing Spectrum Product
Data, or change an existing database resource to include the routing Spectrum Product Data.
A database resource is how you add the data to projects. For details, see Creating a Routing
Database Resource on page 122.

If you are installing Spectrum Product Data for the first time, because you are a new customer to the
Spectrum Technology Platform or setting up a new Spectrum server, then we recommend you set
the data extract and archive locations before installing Spectrum Product Data. For details, see SPD
Setup on a New Spectrum Server on page 91. We recommend using the productdata extract
register and productdata archive register commands to ensure that the Spectrum
Product Data, which may be large, resides in an appropriate and manageable location of your
choosing on the server. The default location inside the Spectrum folders can make upgrades and
re-installations more difficult and require even greater temporary space.

Adding Routing Data to Spectrum

You must be a Spectrum Technology Platform administrator (admin) to perform this task.
To install routing Spectrum Product Data (SPD):

1. Verify that the Spectrum Technology Platform server is running before you begin.

2. Download your Spectrum Product Database (SPD) format files from Pitney Bowes using the link
provided in the Pitney Bowes communication or from the Pitney Bowes Software and Data
Marketplace (SDM). If the download is a zip file, extract it to a temporary location.

3. Open a command-line window.

Spectrum Technology Platform 2019.1.0 Installation Guide n9


https://pbs-access.pitneybowes.com
https://pbs-access.pitneybowes.com
https://pbs-access.pitneybowes.com
https://pbs-access.pitneybowes.com

Spectrum Databases

4. Connect to the Spectrum Technology Platform server by typing this command:
connect —--h servername:port —--u username —--p password --s SSLtrueFalse
For example,

connect --h myserver:8080 --u admin --p myPasswordl --s false

5. Install the routing data to the Spectrum server by typing:
productdata install --f fileOrDirectory --w waitOrReturn
For example:
productdata install --f C:/Downloads/C1A122018/CA Driving.spd --w

To import and extract multiple Spectrum Product Data (. spd) files, when installing both pedestrian
and driving data for example, provide the path to the folder:

productdata install --f C:/Downloads/C1A122018 --w

6. Run the following command to view information about the Spectrum data:
productdata list

This command lists all the information related to Spectrum Product Data (SPD), which are:

PRODUCT
COMPONENT
QUALIFIER
VINTAGE
EXPIRATION
DESCRIPTION
IDENTIFIER

@ "0 oo0 oo

7. Run one of the following commands to generate a template for adding Spectrum data to Spectrum.
* Run the following command to create a template file (.json file) in the current directory:
ermdb template

« Alternatively, include the file name with the command to export the template to a specific
location:

ermdb template path of the directory
For example:

ermdb template C:/Downloads/Templates/ermdbresource.json
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The current file folder or the path you specified now has a template file (. json) that contains
information like:

[{"product":"Spatial",

"module" :"routing",
"name" :"enter database name",
"properties": {"isSPD":"true",

"DatasetPaths":"${spectrum.spd.Spatial/routing/add IDENTIFIER from
productdata list};"},
"maxActive":4}

8. Configure the JSON template (. json) file by adding the database display name for the name
tag and adding the IDENTIFIER information from running productdata list (in step 2)to
the DatasetPaths tag.

For example:

[{"product":"Spatial",

"module" :"routing",

"name" :"Austria",

"properties": {"isSPD":"true",
"DatasetPaths":"${spectrum.spd.Spatial/routing/AlT Pedestrian Mar 2019};"},

"maxActive":4}]

9. Save your changes to the template file.
10. Run the import command to add the SPD to the Management Console.

ermdb import --f path to JSON template

For example, if the template is stored in a JSON file named ermdbresource. json, then the
command will look like:

ermdb import --f C:/Downloads/File/ermdbresource.json

You are now ready to create a database resource for the routing data as described in Creating a
Routing Database Resource on page 122.

For more information about these Product Data CLI commands, see Product Data and Spatial Module
and Routing Databases in the Spectrum Technology Platform Administration Guide.
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Creating a Routing Database Resource

You must be a Spectrum Technology Platform administrator (admin) or Spatial administrator
(spatial-admin) to perform this task. If you are a Spatial sub-administrator (spatial-sub-admin), then
you must have permission to the folder that you are adding to or editing.

To create a routing database resource for Spectrum:
1. In Management Console, go to Resources > Spectrum Databases.

2. Click the Add button * to create a new database resource, or change an existing database
resource by clicking the Edit button )

Note: You can create a new database resource by copying an existing one by clicking
the Copy button .

3. If you are creating a new database, enter a name for the database resource in the Name field.

The name can be anything you choose. If you create a new database by copying an existing
one, then rename it. You cannot modify the name of an existing database resource, because
any services or jobs that reference the database resource by its original name would fail.

4. Change the Pool Size value if needed, by specifying the maximum number of concurrent requests
you want this database to handle.

Note: This setting represents the number of threads on the components that are listening
for service requests from the Spectrum Technology Platform for executing a Spatial routing
stage (thatis, the maximum number of managed connections). Every web service request
enters Spectrum from the platform and passes to the components. To accommodate
greater request loads, increase the default value (which is 4). We recommend a pool size
that matches the number of CPUs. The maximum setting should not go above twice the
number of the CPU core; for example, on a 4 CPU machine, the combined number of
threads for all services should not exceed 8. Run performance tests with various settings
to find the optimal performance.

Specify the Min memory (MB) and Max memory (MB) heap memory values.
In the Module field, select Spatial.
In the Type field, select Enterprise Routing.

From Network Type, select the type of network that is applicable for the database. You can
choose between Driving and Pedestrian.

A list of available databases appears in the table below. Each database is listed with its description
and vintage.

9. Select the databases from the list.

To find out more about installing Spectrum data, see Installing a Spectrum Database on page
9.

® N o o

Spectrum Technology Platform 2019.1.0 Installation Guide 122



Spectrum Databases

10. Select Override advanced settings if applicable. This feature lets you override settings such
as additional command-line arguments when starting process, properties, and environment
variables for remote process.

11. Click Save to add the database.

A list of the Spectrum databases and their status displays. (It may take a moment to refresh the
Status column.)
The database resource now displays in the list of available database resources for Route, Travel

Boundary, Cost Matrix, Find Nearest, Get Travel Boundary, Get Travel Cost Matrix, Get Travel
Directions, and Get Route Data.

Installing Universal Addressing Module
Databases

Universal Addressing Module Databases

Note: This section is valid only for users of UAM- US , UAM- Canada, UAM- International,
Loqate, and Validate Address Global.

Universal Addressing Module databases are distributed in the Spectrum™ Product Database (SPD)
format from the Pitney Bowes Software and Data Marketplace. After upgrading to Spectrum
Technology Platform version 2019.1 from any previous version, you must delete and reconfigure all
the previously configured databases using SPDs. You cannot install older databases or vintages.

Disk Space
The disk space requirements for extracted and non-extracted SPD bundles are:

 Extracted bundles (all SPD) - 50 GB
* Non-extracted bundles (all SPD) - 20 GB

To download and install a Universal Addressing Module database resource in the Spectrum™ Product
Database (SPD) format, see Installing Universal Addressing Module SPD Files on page 124.

Spectrum Technology Platform 2019.1.0 Installation Guide 123


https://pbs-access.pitneybowes.com/

Spectrum Databases

Installing Universal Addressing Module SPD Files

You must be a Spectrum Technology Platform administrator (admin) to perform this task. Before
deleting data, verify that the data is not being used by a database resource in the Management
Console.

To download and install a Universal Addressing Module database resource in the Spectrum™ Product
Database (SPD) format:

1. Select and download your licensed SPD format files (xxx.spd) from Pitney Bowes using the link
provided in the Pitney Bowes communication or from the Pitney Bowes Software and Data
Marketplace (SDM). If the download is a zip file, extract it to a temporary location.

2. Verify that the Spectrum Technology Platform server is running before you continue.
3. Open a Spectrum™ command line window.
4. Connect to the Spectrum Technology Platform server by typing this command:

connect --h servername:port —--u username —--p password --s TrueOrFalse

If your Spectrum™ server requires a secure connection, set --s True. The default is False.

For example,

connect --h myserver:8080 --u admin --p myPasswordl --s False

5. Install the data to the Spectrum™ server by typing:
productdata install --f fileOrDirectory --w TrueOrFalse

To wait for the installation to complete, set --w True. To allow the installation to proceed in the
background, set --w False. The default is False.

For example,
productdata install --f E:/UAM/USS112019 201820.spd --w False

If installing a Spectrum™ product with multiple . spd files, then use the folder path to the files.
The command installs the data files that are in the folder and subfolders.

For example,

productdata install --f E:/UAM/ValidateAddress --w False

6. After you install the SPD files, see either Using Management Console to Create a Database
Resource on page 126 or Using CLI Commands to Create a Database Resource on page 127
to define the database as a resource.
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For more information about the Product Data specific CLI commands, see Product Data under
Administration Utility in the Spectrum Technology Platform Administration Guide.

Deleting Universal Addressing Module SPD Files

You must be a Spectrum Technology Platform administrator (admin) to perform this task. Before
deleting data, verify that the data is not being used by a database resource in the Management
Console.

Do not manually delete the SPD files from the location where the server extracted the SPD files.
Instead, use these CLI commands to delete the SPD files. For more information about the Product
Data specific CLI commands, see Product Data under Administration Utility in the Spectrum
Technology Platform Administration Guide.

1. Verify that the Spectrum Technology Platform server is running before you begin.
2. Connect to the Spectrum Technology Platform server by typing this command:

connect --h servername:port —--u username —--p password --s TrueOrFalse

If your Spectrum™ server requires a secure connection, set --s True. The default is False.

For example,

connect --h myserver:8080 --u admin --p myPasswordl --s False

3. Runthe productdata list command to view the details for the currently installed SPD files.
The results provide current information without having to access the file system. We recommend
using this command before using the productdata delete command to make an informed
decision about the data to delete.

Open a Spectrum CLI window and type the following:

productdata list

4. Runthe productdata delete command to delete the SPD files from the Spectrum™
Technology Platform:

productdata delete --p productName --c Component —--q Qualifier —--v
Vintage

For example,

productdata delete --p "Universal Addressing Module" --c C6P --g UAM-CAN
--v SEP2019
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Creating a Universal Addressing Module Database Resource

After you install new Spectrum™ Product Database (SPD) format files, use either Using Management
Console to Create a Database Resource on page 126 or Using CLI Commands to Create a
Database Resource on page 127 to define the newly installed database as a Universal Addressing
Module database resource.

Using Management Console to Create a Database Resource

To create a Universal Addressing Module database resource in Management Console from a newly
installed SPD file:

Open Management Console.
2. Go to Resources > Spectrum Databases.

If you do not see the Spectrum Databases menu, then you do not need to define database
resources.

3. You can use the buttons at the top left to manage your databases.

To create a new database, click Add + .
To create a new database by copying an existing database, click Copy .

4. Enter a name for the database resource in the Name field. The name can be anything you
choose. If you are creating a new database resource by copying an existing database resource,
rename as needed. You cannot modify the name of an existing database resource.

5. Inthe Pool size field, specify the maximum number of concurrent requests you want this database
to handle.

The optimal pool size varies by module. You will generally see the best results by setting the
pool size between one-half to twice the number of CPUs on the server, with the optimal pool
size for most modules being the same as the number of CPUs. For example, if your server has
four CPUs you may want to experiment with a pool size between 2 (one-half the number of
CPUs) and 8 (twice the number of CPUs) with the optimal size possibly being 4 (the number of
CPUs).

When modifying the pool size you must also consider the number of runtime instances specified
in the dataflow for the stages accessing the database. Consider for example a dataflow that has
a Universal Addressing Module stage that is configured to use one runtime instance. If you set
the pool size for the Universal Addressing Module database to four, you will not see a performance
improvement because there would be only one runtime instance and therefore there would only
be one request at a time to the database. However, if you were to increase the number of runtime
instances of the Universal Addressing Module stage to four, you might then see an improvement
in performance since there would be four instances of the Universal Addressing Module stage
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accessing the database simultaneously, therefore using the full pool. For more information about
setting runtime instances, see the Spectrum™ Technology Administration Guide.

Tip: You should conduct performance tests with various settings to identify the optimal pool
size and runtime instance settings for your environment.

6. Inthe Min memory (MB) field, specify the minimum amount of memory allocated for this database
resource.

7. In the Max memory (MB) field, specify the maximum amount of memory allocated for this
database resource.

8. Inthe Module field, select Universal Addressing Module.
9. In the Type field, select the type of data.

a) Select the Canada Address Coders database for Canada address processing.
b) Select the International Address Coders database for International address processing.
c) Select the US Address Coders database for United States (USA) address processing.

10. For Canada Address Coders, in the *Canada: field, select the base database vintage.

11. For International Address Coders, in the *International: field, select the base database vintage.

12. For US Address Coders, in the *US: field, select the base database vintage.

13. For US Address Coders, specify the database vintage for the following optional databases you
use for processing.

* Delivery Point Validation (DPV)
LACSLink

SuiteLink

» Residential Delivery Indicator (RDI)
« Early Warning System (EWS)

14. To override advanced settings such as additional command line arguments when starting
processing, properties, and environmental variables for remote processing, select Override
advanced settings.

15. Click Save to add and save the database resource. The Spectrum™ Databases page displays
the added database resource.

Using CLI Commands to Create a Database Resource

To create and configure a Universal Addressing Module database resource from a newly installed
SPD file, use the uamdb create command.

For detailed descriptions of all Universal Addressing Module CLI command options, type:
help uamdb

For a detailed descriptions of the available options for a specific Universal Addressing Module CLI
command, type "Help" and the command name.
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For example,

help uamdb create

uamdb create

The uamdb create command creates a new Universal Addressing Module database.

Usage
uamdb create --t Type --n Name --c CacheSize --i Country --p1 PreloadingType
--dt DatabaseType --b BasePath --d DPVPath --1 LACSPath --s SuiteLinkPath —-r
RDIPath --e EWSPath --p Poolsize --mm minimumMemorySize --mx maximumMemorySize

Note: To see a list of parameters, type help uamdb create.

Required Argument Description
Yes --t Type Specifies the type of database, where Type is one of the following:
USA United States database
CAN Canadian Database
INTL International Database
Loqgate Logate Database
Global Validate Address Global Database
Amas Australian Database
Yes --n Name Specifies the name of the database.
No —--c CacheSize Specifies the cache size of a Validate Address Global database,
where CacheSize is one of the following:
None No cache
Small Small cache
Large Large cache (default)
No --1i Country Specifies the three-digit ISO code(s) for each country in a Validate

Address Global database that you want to use, where Country is
either "All" (default) or a list of codes separated by comma.

No --pl Specifies the amount of a Validate Address Global database that is
PreloadingType  preloaded, where PreloadingType is one of the following:

None No data is preloaded (default).

Partial Loads the metadata and indexing structures into memory.
The reference data itself will remain on the hard drive.
Offers some performance enhancements and is an
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Required Argument Description

alternative when not enough memory is available to fully
load the desired databases.

Full Moves the entire reference database into memory. This
may need a significant amount of memory for countries
with large databases such as the USA or the United
Kingdom, but it will significantly increase the processing

speed.
No --dt Specifies the processing mode for a Validate Address Global
DatabaseType database, where DatabaseType is one of the following:

Used in batch processing or interactive environments. It is optimized
for speed and will terminate attempts to correct an address when
ambiguous data is encountered that cannot be corrected
automatically (default).

Used in batch processing environments for Australian mail to
standardize and validate mail against the Postal Address File.

Used to enter truncated data in address fields and have Validate
Address Global generate suggestions.

Yes --b BasePath Specifies the base subscription database path.

Note: For USA, CAN, INTL, Loqgate, and Validate Address
Global specify the database vintage in place of database path.
Example: NOV2017

No --d DPVPath Specifies the DPV database vintage.

No --1 LACSPath Specifies the LACS database vintage.

No --s SuiteLinkPath Specifies the SuiteLink database vintage.

No --r RDIPath Specifies the RDI database vintage.

No --e EWSPath Specifies the EWS database vintage.

No --p Poolsize Specifies the maximum number of concurrent requests you want this

database to handle. The default is 4.

No —--mn Or Defines the minimum amount of memory allocated for this database.
—--minMemnm This value must be less than or equal to the --mx setting.
minimum_memory size

No --mx Of Defines the maximum amount of memory allocated for this database.
--maxMem This value must be greater than zero, but cannot exceed 65536 MB.

maximum _memoly_sze
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Note: The database vintage can be obtained using the uamdb listdatasets command. For
more information see uamdb listdatasets.

Example

To create a database for UAM US, CAN, INTL, Loqate, or Validate Address Global
provide input in this format:

uamdb create --t USA --n UAM US --b FEB2018 --d AUG2018 --r
SEP2018 --mn 1200 --mx 65536

Modifying a Universal Addressing Module Database Resource

You can use either the Database Resource tool in the Management Console or the Universal
Addressing Module CLI commands to modify a Universal Addressing Module database resource.
For more information about modifying a Universal Addressing Module database resource, see either

Using Management Console to Modify a Database Resource on page 130 or Using CLI Commands
to Modify a Database Resource on page 130.

Using Management Console to Modify a Database Resource
To modify a Universal Addressing Module database resource:

1. Open Management Console.
2. Goto Resources > Spectrum Databases.

3. To modify an existing database, select the database and then click Edit .

4. Make your required changes. For more information on database resource fields, see Using
Management Console to Create a Database Resource on page 126.

5. Click Save to save your changes to the selected database resource. The Spectrum™ Databases
page displays the modified database resource.

Using CLI Commands to Modify a Database Resource
To modify a Universal Addressing Module database resource, use the uamdb modify command.

For detailed descriptions of all Universal Addressing Module CLI command options, type:

help uamdb

For a detailed descriptions of the available options for a specific Universal Addressing Module CLI
command, type "Help" and the command name.
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For example,

help uamdb modify

uamdb modify

The uamdb modify command updates an existing Universal Addressing Module database.

Usage
uamdb modify --t Type --n Name --b BasePath --d DPVPath --1 LACSPath --s
SuiteLinkPath --r RDIPath --e EWSPath --p Poolsize

Required Argument Description
Yes --t Type Specifies the type of database, where Type is one of the following:
USA United States database
CAN Canadian Database
INTL International Database
Global Validate Address Global Database
Yes --n Name Specifies the name of the database.
Yes --b BasePath Specifies the base subscription database path.

Note: For USA, CAN, INTL, Loqgate, and Validate Address
Global specify the database vintage in place of database path.
Example: NOV2017

No --d DPVPath Specifies the DPV database vintage.

No --1 LACSPath Specifies the LACS database vintage.

No --s SuiteLinkPath Specifies the SuiteLink database vintage.

No --r RDIPath Specifies the RDI database vintage.

No --e EWSPath Specifies the EWS database vintage.

No --p Poolsize Specifies the maximum number of concurrent requests you want this

database to handle. The default is 4.

Note: The database vintage can be obtained using the uamdb listdatasets command. For
more information see uamdb listdatasets.

Example

To create a database for UAM US, CAN, INTL, Loqate, or Validate Address Global
provide input in this format:
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uamdb modify --n UAM US --t USA --b SEP2018 --d AUG2018 --r
0OCT2018

Deleting a Universal Addressing Module Database Resource

You can use either the Database Resource tool in the Management Console or the Universal
Addressing Module CLI commands to delete a Universal Addressing Module database resource.
For more information about deleting a Universal Addressing Module database resource, see either
Using Management Console to Delete a Database Resource on page 132 or Using CLI Commands
to Delete a Database Resource on page 132.

Using Management Console to Delete a Database Resource
To delete a Universal Addressing Module database resource:

Open Management Console.

Go to Resources > Spectrum Databases.

To delete a database, select the database and then click Delete ™ .

You will be asked to confirm that you want to delete the selected database resource. To confirm
and delete the database resource, click Yes.

5. The database resource is deleted and no longer displays on the Spectrum™ Databases page.

A w Db~

Using CLI Commands to Delete a Database Resource
To delete a Universal Addressing Module database resource, use the uamdb delete command.

For detailed descriptions of all Universal Addressing Module CLI command options, type:

help uamdb

For a detailed descriptions of the available options for a specific Universal Addressing Module CLI
command, type "Help" and the command name.

For example,

help uamdb delete

uamdb delete

The uamdb delete command deletes a Universal Addressing Module database.
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Usage

uamdb delete --t Type --n Name

Required Argument Description

Yes --t Type Specifies the type of database, where Type is one of the following:
USA United States database
CAN Canadian Database
INTL International Database
Loqate Logate Database
Global Validate Address Global Database
Amas Australian Database

Yes --n Name Specifies the name of the database.

Example

This example deletes a Canadian database named "UAM_CAN".

uamdb delete --t CAN --n UAM CAN

Installing Validate Address Global Databases

This procedure describes how to install the databases used by the Validate Address Global stage.
For instructions on installing databases used by other Universal Addressing Module stages, see the
Spectrum Technology Platform Administration Guide.

1.

Download your licensed SPD files (xxx.spd) using the link provided in the Pitney Bowes
communication or from the Pitney Bowes Software and Data Marketplace (SDM).

The SPD files are:

* VAGlobal-EMEA.spd—Contains the data for Europe, Middle East, and Africa.
* VAGIlobal-APAC.spd—Contains the data for Asia-Pacific.
* VAGlobal-Americas.spd—Contains the data for the Americas.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing the databases on a network rather than accessing the
databases locally.

Stop the Spectrum Technology Platform. To do this, open the Windows system tray and select
Stop Spectrum™.

Install the unlock code:
a) Open the following file in a text editor:
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<SpectrumDirectory>\server\modules\addressglobal\conf\unlockcodes.txt

b) Enter your unlock codes, one per line.
c) Save and close the file.

5. Start Spectrum Technology Platform. To do this, right-click the Spectrum Technology Platform
icon in the system tray and select Start Spectrum™.

Installing Validate Address Loqate Databases

This procedure describes how to install the databases used by the Validate Address Logate stage.
For instructions on installing databases used by other Universal Addressing Module stages, see the
Spectrum Technology Platform Administration Guide.

1. Download your licensed SPD files (xxx.spd) using the link provided in the Pitney Bowes
communication or from the Pitney Bowes Software and Data Marketplace (SDM).

2. The database SPD files are:

* LQO — Contains a separate lib file for the Windows installation of data in the . spd file format.
Irrespective of which Windows and non-Windows platform you are using, there will be a different
IqO0 file (lib file) for these platforms:

* Win-LQO_win

* Linux- LQO_Linux

* AIX7.1-LQO_AIX7 1

* AIX7.2- LQO_AIX7.2
* Solaris-LQO_Solaris
* HPUX-LQO_hpux

LQO/DB_Setup—Contains general database setup files.

Note: Regardless of which set of data you use, the files in LQO must be installed.

LQ1-APAC_AFR_ME—Contains the data for Asia-Pacific, Africa, and Middle East.
LQ2-Americas—Contains the data for Americas regions.
* LQ3-Europe—Contains the data for Europe region.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

You may install databases on a network share, but performance will be affected since you will
be accessing them on a network rather than accessing them locally.
3. The database is downloaded as a .spd file. Install the SPD file:

a. Placethe SPDfiles at <SpectrumLocation>/server/import. Thisis the default location
for the SPD files. The Spectrum Technology Platform server monitors this folder and looks
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for new files in two-second intervals. You can change the location of the data import directory
by altering the spectrum.import.dir property in this file:
<SpectrumLocation>/server/conf/spectrum-container.properties.

b. When the server detects new SPD files, the server automatically extracts the SPD files to
<SpectrumLocation>/server/ref data. You can change the location of the data
storage folder by altering the spectrum.data.manager.storage.dir property in the Data Manager
settings section of the
<SpectrumLocation>/server/conf/spectrum-container.properties file.

c. Bydefault, the SPD files will be archived in <SpectrumlLocation>/server/archive/ref
data.

4. Atthis point the data will become available and you can add it as a Spectrum™ database resource
in the Spectrum™ Databases section of Management Console.

Installing Universal Name Module Databases

The Universal Name Module provides a load utility to install databases. The database files that you
load depend on the databases you have licensed.

Note: To install the Universal Name Module databases on Windows Server 2008 you need
administrator privileges.

1. Make sure no applications are running.
2. Stop the Spectrum Technology Platform server.

3. Download the database from the Pitney Bowes eStore or Software Data Marketplace using the
link provided in the Pitney Bowes communication or from the Pitney Bowes Software and Data
Marketplace.

4. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

5. Select Start > Programs > Pithey Bowes > Spectrum Technology Platform > Modules >
Universal Name and Advanced Matching Modules > Universal Name and Advanced
Matching Modules Database Load Utility.

6. Follow the prompts to complete the installation process. The database files are you can install
are:

* Arabic Plus Pack: gl-cdg-cjki-arabic-<date>.jar

 Asian Plus Pack - Chinese: gl-cdg-cjki-chinese-<date>.jar

» Asian Plus Pack - Japanese: gl-cdg-cjki-japanese-<date>.jar
» Asian Plus Pack - Korean: gl-cdg-cjki-korean-<date>. jar

» Core Names Database: gl-cdg-nomino-base-<date>.jar
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Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

7. To load the complete Core Names Database, you must also install Open Parser and Table
Lookup data from the Data Normalization Module Database Load Utility.

a) Select Start > Programs > Pithey Bowes > Spectrum Technology Platform > Modules
> Data Normalization Module > Database Load Utility > Open Parser.

b) Follow the prompts to complete the installation process. The database file you need to install
is:

» cdg-OpenParser-EnhancedNames.tba

c) Select Start > Programs > Pithey Bowes > Spectrum Technology Platform > Modules
> Data Normalization Module > Database Load Utility > Table Lookup.

d) Follow the prompts to complete the installation process. The database file you need to install
is:

» cdg-TableLookup-EnhancedGenderCodes.tha

8. Openthefile Spectrumbirectory\server\bin\wrapper\wrapper.conf in atext editor.

9. Increase the Java settings for initial heap size (wrapper.java.initmemory)and maximum
heap size (wrapper. java.maxmemory) to reflect the total amount of memory required for the
Arabic Plus Pack and Asian Plus Pack.

* Arabic Plus Pack: 5.5 GB

 Asian Plus Pack - Chinese: 32 MB

+ Asian Plus Pack - Japanese: 1.6 GB
» Asian Plus Pack - Korean: 8 MB

* Core Names: 1.1 GB

10. Save and close wrapper.conf.

11. Start Spectrum Technology Platform. To do this, right-click the Spectrum Technology Platform
icon in the Windows task bar and select Start Server.

Using the Database Silent Installer

The silent install process allows you to preconfigure the database installation process so that it runs
without user intervention.

Instead of responding to prompts from the installation process for information such as the installation
location, you specify these responses in a properties file that the installer uses instead of user
prompts.
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Using the Logate Database Silent Installer

1. In the Spectrum Technology Platform server installer (not the database installer), browse to the
SilentInstaller folder.
2. Using a text editor, open the uam logate.installer.properties file.

3. Edit the properties file as necessary to specify the installation settings you want to use. See the
comments in the properties file for additional information.

4. To run the installer in silent mode, place the properties file in any directory except the location
where you are going to install the Logate data and give the absolute path to the property in the

command prompt, as follows:

install.bat %PathOfPropertyFile%\uam logate.installer.properties
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Installing the Client Tools

The Spectrum Technology Platform client tools are applications that you use to administer your
server and design and run dataflows and process flows. You must install your Spectrum Technology
Platform server before installing the client tools.

Before installing, be sure to read the release notes. The release notes contains a list of known issues,
important compatibility information, and release-specific installation notes.

This procedure describes how to install the client tools:

» Enterprise Designer allows you to create, modify, and run dataflows.

* Flow Designer is the next-generation Web Ul dataflow design tool. This release provides a technical
preview version of Flow Designer.

Note: Enterprise Designer will be retired once Flow Designer contains the full feature set
in a future release.

» Job Executor is a command line tool that allows you to run a job from a command line or script.
The job must have been previously created and saved on Spectrum Technology Platform using
Enterprise Designer or Flow Designer.

* Process Flow Executor is a command line tool that allows the execution of a process flow from
a command line or script. The process flow must have been previously created and saved on
Spectrum Technology Platform using Enterprise Designer or Flow Designer.

+ Administration Utility provides command line access to several administrative functions. You
can use it in a script, allowing you to automate certain administrative tasks. You can also use it
interactively.

To install the client tools:
1. Open a web browser and go to the Spectrum Technology Platform Welcome Page at:
http://<servername>:<port>

For example, if you installed Spectrum Technology Platform on a computer named
myspectrumplatform and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080

2. Click Platform Client Tools.
3. Download the client tool you want to install.
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Installing Enterprise Designer with a Silent
Installer

The silent install process installs Enterprise Designer without user intervention. Instead of prompting
the user for information such as the installation location, the installer uses preconfigured selections

that you specify.

To use the silent installer you must first create an installer properties file by running the client installer

and responding to the prompts. The resulting properties file can then be used to silently install
Enterprise Designer on other computers.

1.

Open a web browser and go to the Spectrum Technology Platform Welcome Page at:
http://<servername>:<port>

For example, if you installed Spectrum Technology Platform on a computer named
myspectrumplatform and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080
Click Platform Client Tools.

Click Download Installer.
Choose to save the file to a location on your computer.

Note: Save the installer on a Windows computer that does not already have Enterprise
Designer installed. You will need to run the installer in order to specify the options you
want to use in the silent install process.

Open a Windows command prompt.
In the command prompt, change directories to the directory where you saved the installer.
Execute the following command:

Setup.exe -r installer.properties

Respond to the installer prompts by selecting the options that you want to use when the installer

runs silently.

For example, if you want the silent installer to install Enterprise Designer to

C:\Spectrum\EnterpriseDesigner, specify C:\Spectrum\EnterpriseDesigner when

prompted for an installation folder.

When the installer finishes running, a properties file named installer.properties is created

in the same folder as the setup.exe file.

Open thefile installer.properties in a text editor.
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10. Add the following on line 8 of the file:
INSTALLER UI=silent

Note: This is case sensitive to be sure to enter it exactly as shown above.

11. Save and close the properties file.

You have now configured a properties file that will enable you to install Enterprise Designer
silently.

12. To install Enterprise Designer silently, place installer.properties and Setup.exe in the
same folder on the computer where you want to install Enterprise Designer and run Setup. exe.
When the installer executes it will detect installer.properties and automatically run in
silent mode.

Alternatively, you can place installer.properties in different directory and give the absolute
path to the property in the command prompt using the -f argument, as follows:

Setup.exe —-f PathOfPropertyFile\installer.properties

Upgrading Enterprise Designer

Upgrading from 12.0 or 11.0 SP1

If you are upgrading to Spectrum Technology Platform 12.0 SP1 from 12.0 or 11.0 SP1, you do not
need to upgrade Enterprise Designer. However, you should delete this file before logging in to 12.0
SP1:

C:\Users\UserName\RppData\Roaming\Pitney Bowes\Enterprise
Designer\Settings.xml

Upgrading from a version prior to 11.0

If you are upgrading to Spectrum Technology Platform 12.0 SP1 from a version prior to 11.0 SP1,
you must upgrade Enterprise Designer due to security changes.

Important: Once you upgrade your server to 12.0 SP1, you will not be able to log in to Enterprise
Designer until you upgrade it.

To upgrade Enterprise Designer:

1. Uninstall the existing client tools by going to Start > All Programs > Pitney Bowes > Client
Tools > Setup.
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2. Make sure that you have .NET 4.6 installed on the client machine. This is a newer version of
.NET than was required in previous releases. Note that Windows 10 comes with this version of
.NET installed by default.

3. Download the client tools installer from the Spectrum Technology Platform welcome page,
http://SpectrumServer.Port. The default port is 8080.

4. Run the installer.

Removing Enterprise Designer

1. Back up any files you may need in the future.
2. Use the Windows Add/Remove Programs control panel to uninstall Enterprise Designer.
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Installing the Client AP

The Client APl is used to integrate Spectrum Technology Platform functionality into your applications.
If you will be creating your own program to call Spectrum Technology Platform, you need to install
the Spectrum Technology Platform Client APl on the system where you will be developing your
application. The Client API allows access to Spectrum Technology Platform through several
programming languages, including Java, C++, and web services.

1. Open the folder where you have downloaded the Spectrum Technology Platform Client API
installer.
2. Double-click the file sdkinst.exe.

3. The installer guides you through the installation process.

Removing the Client API

Use the Windows Add/Remove Programs control panel to uninstall the Spectrum Technology Platform
Client API.
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Configuring SAP

Integrating with SAP

To integrate Spectrum Technology Platform with SAP, you need to install supporting databases and
dataflows on the Spectrum Technology Platform server, and then configure your SAP system to
communicate with Spectrum Technology Platform. Once you do this, users of SAP will have access
to address validation and geocoding functionality from within SAP.

1. On the Spectrum Technology Platform server, install the databases required to perform address
validation, geocoding, and tax jurisdiction assignment and define database resources for each
database.

You must give the database resources the following names.

Database Required Name for Database Resource
Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Enterprise Tax Module Database ETM

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Logate Database Loqate

Universal Addressing Module - U.S. Database UAM_US

2. When you install the SAP Module, several dataflow files are automatically installed. Other dataflow
files must be manually copied into Spectrum Technology Platform.

a) If you are adding the Enterprise Tax Module or Universal Addressing Module to an existing
installation, open Spectrum Technology Platform Enterprise Designer, select View > Server
Explorer, and delete this dataflow: SAPValidateAddressWithCandidates.

b) Goto: Spectrumbirectory\server\modules\dataflows\sap.

c) Review the following table then copy the applicable dataflow files to:
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SpectrumDirectory\server\import

If you are installing this set of Copy these dataflow files to the import folder
modules

Universal Addressing Module ValidateAddresswithCandidates_UAM.df

Enterprise Geocoding Module . i )
ValidateAddressWithCandidates_EGM.df

Enterprise Geocoding Module ValidateAddressWithCandidates_ UAM_EGM.df
Universal Addressing Module

Enterprise Tax Module ValidateAssignGeoTAXInfo.df
Universal Addressing Module SAPBatchAssignGeoTAXInfo.df

SAPValidateAddressAndAssignGeoTAXInfo.df
ValidateAddressWithCandidates UAM_ETM .df

Enterprise Geocoding Module
Enterprise Tax Module
Universal Addressing Module

Universal Addressing Module without
Logate SAPValidateAddressWithCandidate  UAM.df

Universal Addressing Module without ValidateAssignGeoTAXInfo.df

Logate SAPBatchAssignGeoTAXInfo.df

Enterprise Tax Module
SAPValidateAddressAndAssignGeoTAXInfo.df
ValidateAddressWithCandidates.UAM_ETM.df

Universal Addressing Module with ValidateAddressWithCandidates_ UAM_Loqate.df
Logate

Universal Addressing Module with ValidateAddressWithCandidates_ UAM_Logate_ EGM.df
Logate
Enterprise Geocoding Module
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If you are installing this set of Copy these dataflow files to the import folder
modules

Universal Addressing Module with ValidateAddressWithCandidates_ UAM_Loqate_ETM.df
Logate
Enterprise Tax Module

Universal Addressing Module with ValidateAddressWithCandidates_ UAM_Loqgate_ EGM_ETM.df
Logate

Enterprise Geocoding Module

Enterprise Tax Module

Universal Addressing Module, Loqate ValidateAddressWithCandidates_Loqate.df
only

Universal Addressing Module, Loqate ValidateAddressWithCandidates_Logate  EGM.df
only
Enterprise Geocoding Module

Enterprise Geocoding Module GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_ EGM.df

Enterprise Tax Module ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_ ETM.df
SAPBatchAssignGeoTAXInfo.df

Note: If errors occur in Management Console or Enterprise Designer, delete the
contents of <WindowsTemporaryDirectory>\glAssemblies, where
<WindowsTemporaryDirectory> is one of these: % TMP%, % TEMP%,
%USERPROFILE%, or the Windows directory. Typically, C: \Documents and
Settings\<USERNAME>\Local Settings\Temp\glAssemblies. Afterdeleting
the contents of this folder, log in again.

3. Import .SAR files.

A .SARfile is a file that contains a third-party add-on package for SAP, such as the Spectrum
Technology Platform SAP Module. The .SAR file is located on the Spectrum Technology Platform
installer in the SAP Objects folder. For information about importing .SAR files into SAP
applications, see your SAP Basis administrator.
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4. Activate the business configuration (BC) sets. The activation options and sequence differs for
ECC and CRM installations.

a) Activate BC sets for ECC and S/4 HANA installations

1. Log on to the client where the settings for the Spectrum Technology Platform SAP Module
is to be configured.

2. Enterthe transaction code SCPR20. This activates BC sets and places the default entries
on the Spectrum Technology Platform customizing tables.

3. Inthe BC Set field, enter keyword *hsgrp1* and find all the BC Sets in this namespace.

4. Activate it with the options Overwrite All Data and Default Mode.

I@Actwatiun Options

iz =

Caution You have started the BC Set activation If you continue, new data ‘fﬁ
-
=

records will be created and/or existing ones ovenaritten.

Activation Information Activation Options
ctivated By:! FSALVADOR Overwite Data
Date/Time: 15082008 / 160605 ® Ovenwrite All Data
SystemiClient: DCE {100 O Default Yalues not Overwtitten
Waorkbench Regst: Mot Reguired
Customizing Regst DCERA001 05 Select Activation Mode
Activation Links: Create Locally @ Default Mode (Reccomend)
() Expert Made
Activation Languages: German
English H
[4]
[
T

5. Select and activate the BC sets with the activation options set to Overwrite All Data
and Expert Mode

Note: Activate these BC sets in the order listed.

/HSGRP1/BCSET_BC_BAS_DES
/HSGRP1/BCSET_BC_BAS_GTX
/HSGRP1/BCSET_BC_BAS_PV
/HSGRP1/BCSET_BUPA_CUSTOM
/HSGRP1/BCSET_DQC_CUSTOM
/HSGRP1/BCSET_VENDOR
/HSGRP1/DD_TCODE
/HSGRP1/FUZZY_SEARCH_INPUT_PARAM
/HSGRP1/MERGE_SETTINGS
/HSGRP1/ONP_PO
/HSGRP1/SPOD_CON_TABLE
/HSGRP1/SPOD_IN_TABLE
/HSGRP1/SPOD_OPT_TABLE
/HSGRP1/SPOD_OUT_TABLE
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/HSGRP1/SPOD_PO

b) Activate BC sets for CRM installations where ICWC isn’t required (IC Web Client)

1. Log on to the client where the settings for the Spectrum Technology Platform SAP Module
is to be configured.

2. Enterthe transaction code sCPR20. This activates BC sets and places the default entries
on the Spectrum Technology Platform customizing tables.

3. Inthe BC Set field, enter keyword *hsgrp1* and find all the BC Sets in this namespace.

4. Activate it with the options Overwrite All Data and Default Mode.

| = Astivation Options

E<!" [

Caution You have started the BC Set activation If you continue, new data ‘”ﬁ
L[
=

records will be created andfor existing ones ovenaritten.

Activation Information Activation Options
Activated By FSALVADOR Overwrite Data
DatefTime: 15.09.2008 / 16:06:05 (@ (warwrite Al Data
SystemiClient: DCE {100 (O Default Yalues not Overwritten
Warkbench Regst: Mot Reguired
Customizing Reqgst: DCEKI00105 Select Activation Mode
Activation Links: Create Locally @ Default Mode (Reccomend)
O Expert Mode
Activation Languages: German
English H
[«]
-]
| I—(K1D

5. Select and activate the BC sets with the activation options set to Overwrite All Data
and Expert Mode

Note: Activate these BC sets in the order listed.

/HSGRP1/BCSET_BC_BAS_DES
/HSGRP1/BCSET_BC_BAS_GTX
/HSGRP1/BCSET_BC_BAS_PV
/HSGRP1/BCSET_BUPA_CUSTOM
/HSGRP1/BCSET_DQC_CUSTOM
/HSGRP1/BCSET_VENDOR
/HSGRP1/DD_TCODE
/HSGRP1/FUZZY_SEARCH_INPUT_PARAM
/HSGRP1/HYBRID_CONFIG
/HSGRP1/MERGE_SETTINGS
/HSGRP1/ONP_PO
/HSGRP1/SPOD_CON_TABLE
/HSGRP1/SPOD_CON_ENTRY
/HSGRP1/SPOD_IN_TABLE
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/HSGRP1/SPOD_OPT TABLE
/HSGRP1/SPOD_OUT_TABLE
/HSGRP1/SPOD_PO

/HSGRP1/SPOD_SSE_ENTRY

5. Set up the RFC destination for Spectrum OnPremise.

b)

Enter transaction code sM59.

Click Create.

In the RFC Destination field, enter a name of your choice.

In the Connection Type field, enter G (HTTP connection to external server).
In the Description 1 field, enter a meaningful description.

Press the Enter key.

Click the Technical Settings tab.

In the Target Host field, enter the computer name or IP Address of the Spectrum Technology
Platform server.

In the Service No field enter 8080.

Click the Special Options tab.

Select No Timeout.

Select HTTP 1.1.

After you save, click Connection Test.

Note: If there is a pop-up window, check the Accept All Further Cookies box and
select YES.

When the test is successful, go to the Response Body tab to view the Spectrum Technology
Platform page.

Note: To setup RFC Destination for Spectrum OnDemand, seelntegration of SAP
with Spectrum on Demand.

6. Set up the Spectrum Technology Platform Logging Object

a)
b)
c)
d)
e)

Enter transaction code ST.GO.

Click New Entries.

In the Object column, enter /HSGRP1 /DQC.

In the Object text column, enter DQC Logging.
Save the change.

7. Configure the BuildGlobalAddress web service in the SAP Visual Admin:

Goto<drive>:/usr./sap/<system id>/DVEBMGS01/j2ee/admin and click go.bat
and enter J2EE_ADMIN as password.

Go to Cluster > Server > Services > JCo RFC Provider and select the Bundles tab.
Enter all the information needed by the application and click Set to save the changes.

Go to Cluster > Server > Services > Web Services Security.

Spectrum Technology Platform 2019.1.0 Installation Guide 151



SAP, SugarCRM, and Microsoft Dynamics

e) Create a proxy in Web Services Client > sap.com > Dynamic WSProxies with the name
PBBIWebServiceConnectorBGA.

f) For the URL, enter:

http://spectrumservername:port/soap/BuildGlobalAddress?wsdl
For example,

http://MySpectrumServer:8080/soap/BuildGlobalAddress?wsdl

g) Restart the application server.

8. If you will be using French address validation, you must install the Data Normalization Module
table cdg-TableLookup-SAP. tba on the Spectrum Technology Platform server. For more
information, see the Spectrum Technology Platform Installation Guide.

9. To configure DPV and RDI options, open T-code/hsgrpl/options, and specify Y (to enable)
or N (to disable), as needed.
* PVPO: For PO Box address validation
* PVST: For street address validation

* PVQU: For batch address validation

Installing Support Files for Read from SAP

The Read from SAP stage reads data from an SAP database as input to a Spectrum Technology
Platform dataflow. In order for the Read from SAP stage to access data in your SAP system you
must make the following changes on your SAP system:

* Install the SAP Java Connector
* Install the SAP Transport Requests that support Read from SAP

Note: You will not be able to use the Read form SAP stage until you perform these steps.

1. Install the SAP Java Connector (SAP JCo).
a) Go to the SAP Marketplace and log in with your SAP Marketplace credentials.
b) Go to SAP JCo Connector > Tools & Services.
c) Download SAP JCo to your system.
d) Unzip the SAP JCo zip file to a temporary location.
e) Stop the Spectrum Technology Platform server.
f) Copy the .jar file to this folder on the Spectrum Technology Platform server:

SpectrumDirectory\server\lib

g) Copy the .dllfile to this folder on the Spectrum Technology Platform server:
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SpectrumDirectory\server\bin\wrapper
h) Start the Spectrum Technology Platform server.
2. Install the SAP Transport Requests that support Read from SAP.

Note: These steps should be performed by your SAP Basis administrator.

a) Inthe Spectrum Technology Platform installer, go to the folder AP Data Integration
Objects\Enterprise System Connectors.

b) Deploy the SAP Transport Requests contained in this folder. See your SAP documentation
for instructions on deploying SAP Transport Requests.

Integrating with SAP Interaction Center WebClient

Before continuing verify these:

* The Interaction Center WebClient user has the CRM_UI_PROFILE parameter ID with IC_AGENT
as the Parameter Value

» The duplicate option is activated in SPRO under ICWC (SPRO > CRM > ICWC > Define Account
Identification Profiles)

To integrate Spectrum Technology Platform with SAP Interaction Center WebClient, you need to
install supporting databases and dataflows on the Spectrum Technology Platform server, then
configure your SAP system to communicate with Spectrum Technology Platform. Once you do this,
users of SAP Interaction Center WebClient will have access to address validation and geocoding
functionality from within SAP Interaction Center WebClient.

Note: The SAP Interaction Center WebClient is supported only for new installations of Data
Quality Connector.

1. On the Spectrum Technology Platform server, install the databases required to perform address
validation, geocoding, and tax jurisdiction assignment and define database resources for each
database.

You must give the database resources the following names.

Database Required Name for Database Resource
Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Enterprise Tax Module Database ETM
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Database Required Name for Database Resource
Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Logate Database Loqate

Universal Addressing Module - U.S. Database UAM_US

2.  When you install the SAP Module, several dataflow files are automatically installed. Other dataflow
files must be manually copied into Spectrum Technology Platform.

a) If you are adding the Enterprise Tax Module or Universal Addressing Module to an existing
installation, open Spectrum Technology Platform Enterprise Designer, select View > Server
Explorer, and delete this dataflow: SAPValidateAddressWithCandidates.

b) Goto: SpectrumDirectory\server\modules\dataflows\sap.
c) Review the following table then copy the applicable dataflow files to:

SpectrumDirectory\server\import

If you are installing this set of Copy these dataflow files to the import folder
modules

Universal Addressing Module ValidateAddresswithCandidates_UAM.df

Enterprise Geocoding Module ) i )
ValidateAddressWithCandidates_ EGM.df

Enterprise Geocoding Module ValidateAddressWithCandidates UAM_EGM.df
Universal Addressing Module

Enterprise Tax Module ValidateAssignGeoTAXInfo.df
Universal Addressing Module SAPBatchAssignGeoTAXInfo.df

SAPValidateAddressAndAssignGeoTAXInfo.df
ValidateAddressWithCandidates_ UAM_ETM .df

Enterprise Geocoding Module
Enterprise Tax Module
Universal Addressing Module
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If you are installing this set of Copy these dataflow files to the import folder
modules

Universal Addressing Module without
Logate SAPValidateAddressWithCandidate_ UAM.df

Universal Addressing Module without ValidateAssignGeoTAXInfo.df

Logate SAPBatchAssignGeoTAXInfo.df

Enterprise Tax Module
SAPValidateAddressAndAssignGeoTAXInfo.df
ValidateAddressWithCandidates.UAM_ETM.df

Universal Addressing Module with ValidateAddressWithCandidates UAM_Loqate.df
Loqate

Universal Addressing Module with ValidateAddressWithCandidates UAM_Logate EGM.df
Loqate
Enterprise Geocoding Module

Universal Addressing Module with ValidateAddressWithCandidates UAM_Logate ETM.df
Loqate
Enterprise Tax Module

Universal Addressing Module with ValidateAddressWithCandidates UAM_Logate EGM_ETM.df
Logate

Enterprise Geocoding Module

Enterprise Tax Module

Universal Addressing Module, Logate ValidateAddressWithCandidates_Loqgate.df
only

Universal Addressing Module, Loqate ValidateAddressWithCandidates_Logate_ EGM.df
only
Enterprise Geocoding Module

Enterprise Geocoding Module GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_ EGM.df
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If you are installing this set of Copy these dataflow files to the import folder
modules

Enterprise Tax Module ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_ETM.df
SAPBatchAssignGeoTAXInfo.df

Note: If errors occur in Management Console or Enterprise Designer, delete the
contents of <WindowsTemporaryDirectory>\glAssemblies, where
<WindowsTemporaryDirectory> is one of these: % TMP%, % TEMP%,
%USERPROFILE%, or the Windows directory. Typically, C: \Documents and
Settings\<USERNAME>\Local Settings\Temp\glAssemblies. Afterdeleting
the contents of this folder, log in again.

3. Import .SAR files.

A .SARfile is a file that contains a third-party add-on package for SAP, such as the Spectrum
Technology Platform SAP Module. The . SAR file is located on the Spectrum Technology Platform
installer in the SAP Objects folder. For information about importing .SAR files into SAP
applications, see your SAP Basis administrator.

4. Activate BC sets for CRM installation where ICWC is required (IC Web Client) - You have
already assigned CRM_UI_Profile parameter to the user with appropriate roles and
authorization.

a. Log on to the client where the settings for the Spectrum Technology Platform SAP Module
is to be configured.

b. Enter the transaction code sSCPR20. This activates BC sets and places the default entries
on the Spectrum Technology Platform customizing tables.

c. Inthe BC Set field, enter keyword *hsgrpl* and find all the BC Sets in this namespace.

d. Activate it with the options Overwrite All Data and Default Mode.
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|II7Activati0n Options
- . . w ==
Caution You have started the BC Set activation If you continue, new data iﬁ
records will be created and/or existing ones ovenaritten. N "3
Activation Information Activation Options
Activated By:: FSALVADOR Overwrite Data
DateiTime: 15.00.2008 / 16:06:05 ® Overwrite Al Data
SystemIClient: DCH {100 O Default Values nat Overwritten
Workhench Regst: Mot Reguired
Customizing Regst DCERKE001 05 Select Activation Mode
Activation Links: Create Locally @ Default Mode (Reccomend)
O Expert Mode
Activation Languages: German
English H
[2]
[
TR

e. Select and activate the BC sets with the activation options set to Overwrite All Data and
Expert Mode

Note: Activate these BC sets in the order listed.

/HSGRP1/BCSET _BC_BAS_DES
/HSGRP1/BCSET_BC_BAS_GTX
/HSGRP1/BCSET_BC_BAS_PV
/HSGRP1/FUZZY_SEARCH_INPUT_PARAM
/HSGRP1/ICWC_SCRN_CFG
/HSGRP1/ICWC_SETTINGS
/HSGRP1/MERGE_SETTINGS
/HSGRP1/ONP_PO_CRM
/HSGRP1/SPOD_CONFIG
/HSGRP1/SPOD_IN_TABLE
/HSGRP1/SPOD_OPT_TABLE
/HSGRP1/SPOD_OUT_TABLE
/HSGRP1/SPOD_PO_CRM
/HSGRP1/SPOD_SSE_ENTRY

Note: Ignore any activation error or warnings with BC Set: /HSGRP1/ICWC SCRN_ CFG

5. Set up the RFC destination for Spectrum OnPremise
a) Enter transaction code sM59.
b) Click Create.
c) Inthe RFC Destination field, enter a name of your choice.
d) Inthe Connection Type field, enter G (HTTP connection to external server).
e) Inthe Description 1 field, enter a meaningful description.
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f) Press the Enter key.
g) Click the Technical Settings tab.

h) Inthe Target Host field, enter the computer name or IP Address of the Spectrum Technology
Platform server.

i) Inthe Service No field enter 8080.
j)  Click the Special Options tab.
k) Select No Timeout.

Note: These steps are not valid for Spectrum OnDemand as it is not supported for
ICWC.

6. Use these steps to import the upload the ICWC configuration file
(CQ7 All Screen Configurations.cfg). The file resides on the Spectrum Technology
Platform installer at this location: SAP Objects\SAP CRM 7.0\data\inst cs7.

a. On the initial screen, go to Tcode 'SE38' and enter ' /HSGRP1/IMPORT SCRN CFG'
b. Click Execute.

= Progam Edit Goto Utiities Environment System  Help

o el eae &6 =0 QW
ABAP Editor: Initial Screen

it /.5:- b ] | 1 O 6D | @rDebuggng @ with varant  [©variants

Execute (F8)

Program [ /sscre1/1MporT_scry_cre | () Create

Subobjects
*)Source Code
Variants
Attributes
“)Documentation
Text elements

iy Display & Change |

c. Locatethe CQ7 All Screen Configurations.cfg file and select it.
d. Grant access as shown in the image below.
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Progam  Edt  Goto  \Rites  Engrenment  Sptem  Helb
L] |« GeE® @ R ew
ABAP Editor: Initial Screen

b ookt [ W DD Gosbupeng  Drweh Vet [Tivarases

Fragram ESGREL/ IMPORT_SCRN_CTG Y Create

= Source Code
Varants
Atirbutes

Documenszcn T —,

T larrar
e The system is trying to access the file
B Duley W oeo D:\Pitney Bowes\Avengrid-Comenitl_HSGRP1_ICOWC_SCRN_CFG.bes

Do you want to grant access to this file?

[romember My Docsion

Ce ) ow | [ e

e. Gototcode SE16.
f. Enter Table Name as BSPC DL XMLSTRX2.
g. Click Table Content icon.

= Table Edit Goto Settings Utiities System  Help

o l«Heae® P 0F
Data Browser: Initial Screen

EoEo

Table Name BSPC_DL_XMLSTRX2

h. Click the Execute icon.
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= progam [Edt Goto Settngs System  Help
/] fl«gd eae 2 B em

Data Browser: Table BSPC_DL_XMLSTRX2: Selection Screen
-ﬁn E: [i] mMumber of Entries

CONTEXT_DD 1 o | =]
COMPONENT [ to | ||
VIEWNAME ' to | ||
ROLE_KEY [ w | | I
COMPONENT_USAGE [ to | || =
OBJECT_TYPE [ to | |53
DBJECT_SUB_TYPE ' to | [[ o=
CHANGED_BY to g
CHANGED_AT to g
CONFIG_TYPE ' to | || =
MASTERLANG ] o | | &
Width of Output Lit ["zs0]

Maximum No. of Hits 200

i. Check these entries:

Dats Srowser: Table BSPC_DIL_XMLSTRXZ Select Emtries 7
@AM rnATELERD

5 TagoRT

e
FTHRITEI I TIRNROMETIS0KA TERRESISECHRITRF | 100N B9 DETAIL
WSV TR GBI TS 47 PR 82

oo B8 SETALL

E4S00E4 100 FRBI P LAE TS FERRTY 42 81 LEMEAY
=

FEFEEEFEEEESEEEERTEERREERER

Note: Ignore errors or warning messages related to missing users, as shown in the image
below.

Report /HSGRP1/IMPORT SCEN_CFG

Config for I1AS4D4FZEFT4558ARISBRO0LSAEFFZTEL0ARASER BE_ADDR STANDARDADDRESS Same as in the file

Config for 26CS058SC4AD601SEBL1OA21BFF2AEDOT4TEATIDD BF_ADDR STANDARDADDRESS Same as in the file

Config for 3Te03FE€2407D25%C02F1DDE4TESRESISECRA2TZE ICCMP BP DETAIL  BUPRDETATLB2R Same as in the file

Config for 3B4CSFF37DFTEBC326€393T1FSEFC201700FB2F6é BP_ADDR  STANDARDADDRESS Same as in the file

Config for 428849E22D36ECFS5518FSCYEI0TEFSCASCCSBETS ICCMP BF_DETAIL BUPADETAILBZE Same a3 in the file

Config for 43CA2B0ER2IDEETSDOFD424TRITTIDBSLEE4S9ET ICCMP_BP_DETAIL  BUPRCRERTE Same as in the file

Config for 461F764BEAALES23419TFES4301D2T89ASAD2CES BE_ADDR STAMDARDADDRESS Same as in the file

Config for 4SDFCEEBFI6TE4FTFEZ45365500C1082A36450070 BP_ADDR STANDARDADDRESS Same a3 in the Ifile

Config for 4ES20REF3L5SSO0BFOC3Z242CAES1BATCCEETSI0CS ICCMP BP DETAIL EBUPADUPLICATECREAIE Same as in the file

E: Cfg for S5B42R1TADBFS5E2CO820RAARFSR2EERADARAA3445442 ICCMP BP _DETATI ~ BUPADUPLICATECREATE  GW_RDMIN was not found

7. Set up the Spectrum Technology Platform Logging Object
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a) Enter transaction code S1.GO.

b) Click New Entries.

c) Inthe Object column, enter /HSGRP1/DQC.

d) Inthe Object text column, enter DQC Logging.
e) Save the change.

8. Enable the Precisely IC WebClient Enhancement Set.
a) Enter the transaction code sM30.
b) In the Table/View field, enter BSPWDV_EHSET ASG.
c) Click Maintain.
d) Click New Entries.
e) Inthe Client field, enter the client number where the enhancement set will take effect.
f) Inthe Enhancement Set field, enter /HSGRP1/ENHANCEMENT SET.

9. Add the IC WebClient Configurations.
a) Enter the transaction code BSP_ WD CMPWB.
b) Inthe Component field, enter ICCMP BP DETAIL.
c) Click the check icon.
d) Inthe Enhancement Set field, enter /HSGRP1/ENHANCEMENT SET.
e) Click Display.
f) Expand the Views folder and select
IHSGRP1/BUPA_CMP_VIEW/BuPaDetailSelectDuplCustomer.

Structure of Component ICCMP_BP_DETAIL - Enhancement Set [HSGRP1/E
[ Test|[& poL mode! |[=] 2| [ wizard Log |6 4P Reference MG | (B Find view Layout

&aBrowser Component Structure yiew Mavigatian Co
S=BOL Model Browser
EaRuntime Repository Editar = EEIIHSGRF‘1IEIUPA_CMP_VIEWIEIuPa

~ [ HEGRP1BUPA_CMP_VIEWIB!
= 02 View Controller

= @5 BuPaDetailSelectDuplC

@ Implementation Clas

[» (] Favarites
= g% Component
<ﬁ Companent Cantraller

<] ]

I B windows
[> % Custorn Controllers () Context
= B views (7 context related Meth

E| JHSGRP1/BUPA_CMP_VIEWIBUPADetallEmptySelect
El /HSGRP1/BURPA_CMP_VIEWIBUP aDetailSelectDuplCustomer:
=]

(3 Toalbar related Meth
(3 controller Initializatic

5
[
> (J Breadcrumbs and M
[
[

g) Click the Configuration tab.
h) On the edit screen select Full Name, Telephone, Street, City and Country context then click
the right arrow button and arrange them in this order:

Full Name
Telephone
Street
City
Country

i) Save the configuration.
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10. If you will be using French address validation, you must install the Data Normalization Module
table cdg-TableLookup-SAP. tba on the Spectrum Technology Platform server. For more
information, see the Spectrum Technology Platform Installation Guide.

Compatibility Matrix

These tables give a list of SAP add-on versions and system kernel levels that are compatible with
the various releases of Spectrum Technology Platform for installation and upgrade of ECC 6.0 and
CRM 7.0.

Table 2: Compatibility Matrix for New Deployment

Spectrum Release SAP Add-on Version SAP System Kernel Level
10.x 10.x 741 and above
11.x 11.x 741 and above
12.x 12.x 741 and above
2018.2.0 2018.2.0 741 and above
2019.1.0 2019.1.0 741 and above

Table 3: Compatibility Matrix for Upgrade

Spectrum Release SAP Add-on Version SAP System Kernel Level
10.x Any to 10.x 741 and above
11.x Any to 11.x 741 and above
12.x 12.x 741 and above
2018.2.0 2018.2.0 741 and above
2019.1.0 2019.1.0 741 and above
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This table gives the compatibility matrix for new deployment of SAP S/4 HANA 1610 for Spectrum

Technology Platform:

Spectrum Release SAP S/4 HANA 1610 Add-on Version

SAP S/4 HANA 1610 System
Component Level

New deployment

12.x 12.x 751 (SAP_BASIS)
75B (SAP_ABA)
2018.2.0 2018.2.0 751 (SAP_BASIS)
75B (SAP_ABA)
2019.1.0 2019.1.0

751 (SAP_BASIS)
75B (SAP_ABA)

Note: Itis recommended that you contact the Precisely representative or coordinator assigned

to you before starting the process.

This table gives the compatibility matrix for new deployment of SAP S/4 HANA 1709 for Spectrum

Technology Platform:

Spectrum Release SAP S/4 HANA 1709 Add-on Version

SAP S/4 HANA 1709 System
Component Level

New deployment

12.x 12.x 752 (SAP_BASIS)
75C (SAP_ABA)
2018.2.0 2018.2.0 752 (SAP_BASIS)
75C (SAP_ABA)
2019.1.0 2019.1.0

752 (SAP_BASIS)
75C (SAP_ABA)
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Note: Itis recommended that you contact the Precisely representative or coordinator assigned
to you before starting the process.

This table gives the compatibility matrix for new deployment of SAP S/4 HANA 1809 for Spectrum
Technology Platform 20719.1.0:

Spectrum Release SAP S/4 HANA 1809 Add-on Version SAP S/4 HANA 1809 System
Component Level

New deployment

2019.1.0 2019.1.0 754 (SAP_BASIS)

75D (SAP_ABA)

The SAP Data Quality Connector is certified for ECC 6.0 EHP 7.0 and CRM 7.0 EHP 3.0 with
HANA database.

Configuring SugarCRM

Integrating with SugarCRM

To integrate Spectrum Technology Platform with SugarCRM, you must install the supporting databases
and dataflows on the Spectrum™ Technology Platform server, and deploy Spectrum on your
SugarCRM. Once you do this, users of SugarCRM will have access to address validation, geocoding,
and duplicate detection functionality from within SugarCRM.

Before you begin:
Entities Supported:
You can validate and geocode the addresses of the entities:

» Accounts

« Contacts

* Leads

Supported SugarCRM Versions

SugarCRM 7.7.1.1
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Browse to the the folder Sugar CRM DQ Objects\sugarcrminthe Spectrum Technology Platform

installation package and copy the file PBSugarCRMConnector. zip to any location on your

SugarCRM server.

1. If you are using Spectrum Technology Platform for address validation or geocoding, install the
databases required to perform address validation and geocoding and define database resources
for each database.

Note: If you are using Spectrum Technology Platform for duplicate detection only, you
can skip this step.

You must give the database resources these names:

Database Required Name for Database Resource
Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Logate Database Loqate

Universal Addressing Module - U.S. Database UAM_US

Note: You must install the Delivery Point Validation (DPV) data and the Residential
Delivery Indicator (RDI) data in order to perform DPV and RDI processing on U.S.
addresses.

2. Import the SugarCRM Module dataflows into your Spectrum Technology Platform server.
a) On the Spectrum Technology Platform server, open this folder:

SpectrumDirectory\server\modules\sugarcrm

Note: This folder is only available if you have installed the SugarCRM Module.

b) As mentioned in the table below, copy the applicable dataflow files to the import folder:

SpectrumDirectory\server\import
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If you have installed this set of Copy these dataflow files to the import folder
modules

Advanced Matching Module
GenerateMatchKey.df

GenerateMatchScore.df
GenerateSearchKey.Consonant.df
GenerateSearchKey.df
GenerateSearchKey.Metaphone.df
GenerateSearchKey.Substring.df

. . ) ValidateAddresswithCandidates UAM.df
Universal Addressing Module without

Loqate

. . ) ValidateAddressWithCandidates UAM_EGM.df
Universal Addressing Module without

Loqate
Enterprise Geocoding Module

. ) . ValidateAddressWithCandidates UAM_Loqate.df
Universal Addressing Module with

Loqate

Universal Addressing Module with SugarCRMValidateAddressAndGenerateMatchKey.df
Loqate

Enterprise Geocoding Module ValidateAddressWithCandidates UAM_Loqgate EGM.df

. . ValidateAddressWithCandidates _Loqate.df
Universal Addressing Module, Logate

only

. . ValidateAddressWithCandidates_Loqgate EGM.df
Universal Addressing Module, Logate

only
Enterprise Geocoding Module

. ) GeocodeUSAddressWithCandidates.df
Enterprise Geocoding Module

3. Import the Pitney Bowes SugarCRM module into your SugarCRM system.
a) Log in to SugarCRM as an administrator.
b) In the profile drop-down menu at the top right corner, click Admin.
c) Inthis Administration screen, in the Developer Tools section, click Module Loader.
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The Module Loader screen opens.

d) If you are integrating your SugarCRM system with Spectrum Technology Platform for the
first time, you must upload the SugarCRM Connector module of your SugarCRM system:

1. Upload the ZIP file PBSugarCRMConnector. zip of Spectrum copied earlier to the
system, using the file uploader field in the centre of the page.

2. Click Upload.

3. Click Confirm. An entry for the Pitney Bowes package now shows in the bottom grid.

e) Once the Pitney Bowes package is uploaded into the system, or if it has been uploaded
previously into your SugarCRM system but is uninstalled:

1. Click Install against the Pitney Bowes package entry in the bottom grid on the Module
Loader screen.

2. On the License screen, select Accept, then click Commit.

f) In the profile drop-down menu at the top right corner, click Admin.

g) Inthis Administration screen, in the System section, click Repair.
The Repair screen opens.

h) Click Quick Repair and Build.
The existing SugarCRM configurations are rebuilt to incorporate the custom Objects and
Object Layouts imported with the SugarCRM Connector module. The logs are displayed.

Spectrum's SugarCRM Connector module is now successfully integrated with your SugarCRM
system.

The menu item Administration > PB Service Configuration is now available.

Creating a Connection to Spectrum

Once the SugarCRMConnector module of Spectrum Technology Platform is uploaded successfully
in your SugarCRM, you can create a connection to the Spectrum server.

1. Log in to your SugarCRM system as an Administrator.
2. Go to Administration > PB Service Configuration.

3. Click Create.
4

In the Name field, enter the desired name for the connection. For example,
PB SpectrumConnection

5. Inthe Server Name field, enter the server name or IP address of the Spectrum Technology
Platform server.

6. Inthe Port field, enter the port used by the Spectrum Technology Platform server for HTTP
communication. By default the portis 8080.

7. Inthe User Name field, enter the Spectrum Technology Platform user name.
8. Inthe Password field, enter the password for the Spectrum Technology Platform user.
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9. Ifyou wish to run the duplicate detection feature provided by the Pithey Bowes Address Validation
bundle:

» Check Duplicate Detection.

* In the Threshold field, enter a value between 0 and 100, both inclusive. If you leave this field
blank, the default threshold value of 30 is used. The Pitney Bowes Address Validation service
fetches those records as duplicate whose match score is equal to or higher than the threshold
match score.

For more information, see Threshold.

10. Before saving the connection, click Test Connection to verify the entered credentials for the
Spectrum server.

11. Once the Spectrum connection details are tested successfully, click Save.

Note: You can either test a connection before clicking Save, or test an existing connection
by first opting to Edit it.

You can now use this connection to validate and geocode the addresses of records in your SugarCRM
system using the Spectrum Technology Platform.

Note: Only one connection to the Spectrum Technology Platform can exist at a time. To
create another connection to Spectrum Technology Platform, you can either delete the existing
connection and create a new one, or edit the existing connection.

Configuring Microsoft Dynamics CRM

Integrating with Microsoft Dynamics CRM

To integrate Spectrum Technology Platform with Microsoft Dynamics CRM , you must install the
supporting databases and dataflows on the Spectrum Technology Platform server, and deploy the
Spectrum Technology Platform solution on your Microsoft Dynamics CRM. Once you do this, users
of Microsoft Dynamics CRM will have access to address validation, geocoding, and duplicate detection
functionality from within Microsoft Dynamics CRM.

Note: End users who use Internet Explorer must use Internet Explorer 10 or 11. Older versions
of Internet Explorer are not supported. All versions of Chrome and Firefox are supported.

Before you begin, confirm that you are using a compatible version of Microsoft Dynamics. These
versions are supported:
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Microsoft Dynamics CRM 2013
Microsoft Dynamics CRM 2013 SP1
Microsoft Dynamics 2015
1. If you are using Spectrum Technology Platform for address validation or geocoding, install the
databases required to perform address validation and geocoding and define database resources
for each database.

Note: If you are using Spectrum Technology Platform for duplicate detection only, you
can skip this step.

You must give the database resources these names:

Database Required Name for Database Resource
Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Logate Database Loqate

Universal Addressing Module - U.S. Database UAM_US

Note: You must install the Delivery Point Validation (DPV) data and the Residential
Delivery Indicator (RDI) data in order to perform DPV and RDI processing on U.S.
addresses.

2. Import the Microsoft Dynamics CRM Module dataflows into your Spectrum Technology Platform
server.
a) On the Spectrum Technology Platform server, open this folder:

SpectrumDirectory\server\modules\dataflows\mscrm

Note: This folder is only available if you have installed the Microsoft Dynamics CRM
Module.

b) As mentioned in the table below, copy the applicable dataflow files to the import folder:

SpectrumDirectory\server\import
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If you have installed this set of Copy these dataflow files to the import folder
modules

Advanced Matching Module
GenerateMatchKey.df

GenerateMatchScore.df
GenerateSearchKey.Consonant.df
GenerateSearchKey.df
GenerateSearchKey.Metaphone.df
GenerateSearchKey.Substring.df

. . ) ValidateAddresswithCandidates UAM.df
Universal Addressing Module without

Loqate

. . ) ValidateAddressWithCandidates UAM_EGM.df
Universal Addressing Module without

Loqate
Enterprise Geocoding Module

. ) . ValidateAddressWithCandidates UAM_Loqate.df
Universal Addressing Module with

Loqate

Universal Addressing Module with SugarCRMValidateAddressAndGenerateMatchKey.df
Loqate

Enterprise Geocoding Module ValidateAddressWithCandidates UAM_Loqgate EGM.df

. . ValidateAddressWithCandidates _Loqate.df
Universal Addressing Module, Logate

only

. . ValidateAddressWithCandidates_Loqgate EGM.df
Universal Addressing Module, Logate

only
Enterprise Geocoding Module

. ) GeocodeUSAddressWithCandidates.df
Enterprise Geocoding Module

3. Import the Microsoft Dynamics CRM Module into your Microsoft Dynamics CRM system.
a) Inthe Spectrum Technology Platform installation package, browse to this folder:

MS CRM Objects\Proxy
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b) Copy the file netProxy.aspx to this folder on your Microsoft Dynamics CRM server:
MicrosoftDynamicsCRMInstallation\CRMWeb

c) Copy the file netProxy.d11 to this folder on your Microsoft Dynamics CRM server:

MicrosoftDynamicsCRMInstallation\CRMWeb\Bin

d) Log in to Microsoft Dynamics CRM as an administrator.

e) Click Microsoft Dynamics CRM then click Settings.

f) Click Solutions.

g) Click Import.

h) Browse to the Spectrum Technology Platform installation package and select the file:

MS CRM Objects\mscrm\PBMSDynamicsCRMConnector 4 0 0 managed.zip

i) Click Next then Publish All Customizations.
j) Restart the Microsoft Dynamics CRM server.

4. Define the connection between Microsoft Dynamics CRM and the Spectrum Technology Platform
server.
a) Log in to Microsoft Dynamics CRM as an administrator.
b) Click Microsoft Dynamics CRM > Settings.

c) Click Settings > Pitney Bowes. You will have to scroll to the right to find the Pitney Bowes
link.

d) Click Administration.

e) Click New.

f) In the Name field, enter PB.

g) Inthe Server Name field, enter the server name or |IP address of the Spectrum Technology
Platform server.

h) Inthe Port field, enter the port used by the Spectrum Technology Platform server for HTTP
communication. By default the port is 8080.

i) Inthe Account ID field, enter the Spectrum Technology Platform user name.

i) Inthe Password field, enter the password for the Spectrum Technology Platform user.

k) Click Save

The Microsoft Dynamics CRM system now has access to address validation and, optionally, geocoding
services on the Spectrum Technology Platform server.
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Support

Support

Technical Support

If you run into an issue, Precisely Technical Support can help guide you to a solution. When you
contact Precisely Technical Support, please provide the following information:

* A description of the task you were performing
» The level or version of your operating system
» The patch level or service pack

» The log file located in your install directory at:
SpectrumDirectory\server\logs\spectrum-server.log

Contact information for Technical Support can be found at:
support.pb.com/spectrum

Note: If you purchased Spectrum Technology Platform through a third-party partner, please
contact the partner for technical support.

Documentation

Product documentation can be found at:

support.pb.com/spectrum
Digital Insights

Digital Insights is an online resource for Precisely leadership to share innovations, goals, and product
news, as well as exchange ideas with visitors. You can access Digital Insights at:

blogs.pb.com/digital-insights/
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Notices




Copyright

® 2019 Precisely. All rights reserved. Maplnfo and Group 1 Software are trademarks of Precisely
Software Inc. All other marks and trademarks are property of their respective holders.

USPS® Notices

Precisely Inc. holds a non-exclusive license to publish and sell ZIP + 4® databases on optical and
magnetic media. These trademarks are owned by the United States Postal Service: CASS, CASS
Certified, DPV, eLOT, FASTforward, First-Class Mail, Intelligent Mail, LACS"™, NCOA-" PAVE,
PLANET Code, Postal Service, POSTNET, Post Office, RDI, Suite""™ , United States Postal Service,
Standard Mail, United States Post Office, USPS, ZIP Code, and ZIP + 4. This list is not exhaustive
of the trademarks belonging to the Postal Service.

Linke

Precisely Inc. is a non-exclusive licensee of USPS® for NCOA processing.

Prices for Precisely products, options, and services are not established, controlled, or approved by
USPS® or United States Government. When utilizing RDI™ data to determine parcel-shipping costs,
the business decision on which parcel delivery company to use is not made by the USPS® or United
States Government.

Data Provider and Related Notices

Data Products contained on this media and used within Precisely Software applications are protected
by various trademarks and by one or more of these copyrights:

© Copyright United States Postal Service. All rights reserved.

© 2014 TomTom. All rights reserved. TomTom and the TomTom logo are registered trademarks of
TomTom N.V.

© 2016 HERE Fuente: INEGI (Instituto Nacional de Estadistica y Geografia) - Based upon electronic
data © National Land Survey Sweden.

© Copyright United States Census Bureau

© Copyright Nova Marketing Group, Inc.

Portions of this program are © Copyright 1993-2019 by Nova Marketing Group Inc. All Rights Reserved
© Copyright Second Decimal, LLC

© Copyright Canada Post Corporation - Data is from a compilation in which Canada Post Corporation
is the copyright owner.

© 2007 Claritas, Inc.

The Geocode Address World data set contains data licensed from the GeoNames Project
(www.geonames.org) provided under the Creative Commons Attribution License ("Attribution
License") located at http://creativecommons.org/licenses/by/3.0/legalcode. Your use of the
GeoNames data (described in the Spectrum Technology Platform User Manual) is governed by the
terms of the Attribution License, and any conflict between your agreement with Precisely and the

Spectrum Technology Platform 2019.1.0 Installation Guide 175


http://www.geonames.org
http://creativecommons.org/licenses/by/3.0/legalcode

Copyright

Attribution License will be resolved in favor of the Attribution License solely as it relates to your use
of the GeoNames data.
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